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Symbols and Conventions 9
About This Manual

This User’s Guide contains everything you need to know to work with this product. 
The first sections introduce the product and help you get started. The remaining 
chapters are organized by subject to help you find detailed information quickly when 
you need it. 

Symbols and Conventions
The following special symbols and conventions are used throughout this guide.

Names of keys on the keyboard are shown in small capital letters such as CTRL, 
ESC, and ENTER. Key combinations are shown as CTRL-C, ALT-F, and so on. 
Remember that keys may not be labeled exactly the same on your keyboard.
Menus and commands in menus are shown in a bold font such as File. 
Notes like the paragraph below provide additional information about the current 
topic. 

NOTE: This is a sample note. You will find notes throughout the manual to draw 
your attention to areas of special interest or concern. Often, a note will 
explain a special behavior that might not seem obvious.
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11
CHAPTER

1 Introduction 

This program understands what makes flow charts special. It understands that a flow chart 
is much more than a drawing. It knows what parts of a flow chart should be easy to change, 
what parts should be kept consistent within the chart, and what parts should be kept 
consistent among other diagrams of the same type. It knows how parts of a flow chart 
should relate to one another, what items should stay connected, what items should line up, 
and what items should remain attached.

Flow charts are organized into a diagram containing figures (shapes) and connectors (lines 
connecting shapes, often with arrowheads). This program remembers how figures are 
connected, combined with text, and arranged. It automatically formats groups of figures to 
keep them properly sized, aligned, or arranged. It also helps you add text anywhere on your 
diagram including within figures. When you edit text in a figure, the figure can grow 
automatically to fit perfectly to the new amount of text. If you move a figure, any lines that 
are connected to that figure can automatically adjust. When these lines move, labels 
connected to the lines can move as well. The program uses its knowledge of flow charts, 
their structure, layout, and conventions to help you in any way it can. It will do many minor 
tasks for you that you will never notice simply because you just expect it. It will seem 
simple, and that is its main goal. It will rarely try to perform a broad modification on your 
flow chart, even though there are times when you may want just that. But this program 
prefers not to take the risk of out-guessing you, or of frustrating you by taking away your 
control of your own diagram.

Flow charts are rather loosely defined. They include many historical attempts at standards, 
and an infinite number of variations that have evolved over time. We have designed this 
tool to be as broad as possible, to include shapes and arrows found in most flow charts that 
we have come across. and to be compatible with the following standards, at least in part:

Classic flowcharting standardized by IBM in the 1960s often represented on green 
plastic templates. At the time of this writing, the web site www.villagesupplies.com 
carried an impressive assortment of these templates.
ANSI R-54
ISO 1028 ANSI X3.5, ISO 9004.4
FIPS Standard 24
You can create your own flow charting template files as well.
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13
CHAPTER

2 Basics 

This chapter lays the foundation for understanding the model and how to work with the 
tool. It introduces some terminology used throughout the program and answers some of the 
most frequently asked introductory questions. It also introduces the different parts of the 
workspace and the different functional modes.

Using The Mouse
A mouse is required You should understand some very basic terminology of mouse usage. 
Here’s a quick review:

Cursor

The cursor, or more accurately the mouse cursor, is a small graphic image that indicates 
where on the screen the mouse is pointing. Different shapes for the mouse cursors indicate 
different actions that result when you click the mouse. The most common mouse cursors 
and their meaning are shown below.Clicking

You click the mouse (press and release a mouse button) to initiate an action, usually related 
to the current location of the cursor. The LEFT mouse button is used for nearly everything. 
We might say Click the mouse button where we mean Click the left mouse button. We’ll be 
explicit if we refer to any other button.

Dragging

You drag by pressing the mouse button, holding it down while moving the mouse, then 
releasing it at a new location. Dragging is a good way to move things and change their size.

Right mouse button (shortcuts)

If you press the right mouse button while in Select mode or Seltext mode (modes are 
explained later in this chapter), a small menu appears near the cursor. You may then choose 

Standard Select Cursor
(selects objects)

Reshape Cursor
(reshapes figures)

Move Cursor
(drag selected objects)

Create Figure Cursor 
(add figure of this shape)

Connect Cursor
(create a connector)

Connect-to Cursor
(attach connector to object)

Text Cursor “Caret”
(edit figure/label text)

Pivot Connector Cursor
(move end of a connecto

Split Cursor 
(split a connector)

Zoom Cursor
(zoom in or to an area)

Resize Cursor
(resize a figure)
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14 Chapter 2: Basics
from a number of frequently used commands that make sense at the time. For example, 
if you click the right mouse button on a figure, the menu contains features that apply to 
that figure.

When you press the right mouse button while in any other mode, it serves as a shortcut 
method to return to Select mode (or Seltext mode if you used that mode last.)

Special Controls
The user interface contains standard Windows controls like buttons, scroll bars, list 
boxes, and pull-down lists. If you are unfamiliar with these term, refer to your 
Windows documentation. There are also has a few unique controls that require some 
additional explanation.

Drop menus

Drop menu buttons are special buttons that cause a menu to pop-up when you press 
them. You can identify a drop menu button by the small black triangle in the lower 
right corner. Drop menus contain a number of selections to choose from. To make a 
selection, move the mouse over your choice and release, or just click on it.

Notice the ellipsis (three dots) at the lower right corner of the menu shown above. 
Some drop menus have this symbol to indicate that there may be additional selections 
that are not shown. By selecting the ellipsis, you can access the complete list of 
selections using a dialog box.

Measurement edit boxes

Some edit boxes have special behaviors. When entering a measurement, you can type 
“3 in.” to mean three inches, but you can also type “3.0 inches”, or just “3”; all are 
equivalent. Your entries are always assumed to be in the current measurement units 
(inches or centimeters). If the field expects inches and you enter “3 ft.” or “3 cm”, it is 
treated as three inches. The same goes for point measurements for text size and line 
thicknesses. If a point measurement is called for, you can enter “2 pts” or “2 points” or 
“2.0”, and so on. 

Point measurements are a bit confusing at first. Just remember that there are 72 points 
in an inch or that most typed text is 10 or 12 points tall.
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Special Controls 15
Standard sizes

It can be challenging to choose sizes for things that look good and print attractively. 
For example, if you are creating a connector with an arrowhead, should you make the 
arrowhead 8 points, 15 points, 6.3 points? Should its line width be 1/2 point of 2 
points? It’s hard to know without spending a lot of time trying different sizes AND 
printing them out. To greatly simplify choosing the sizes of some things, we’ve defined 
a set of standard sizes that you can select very easily. For example, arrowheads can be 
Small, Medium, or Large and line widths can be Fine, Medium, Heavy, or Very Heavy.

Standard sizes also make it possible to use menus as a well as edit boxes to choose 
sizes. As you can see in the following illustration, the border width for a figure can be 
adjusted by selecting a standard size with a menu, selecting a standard size with a drop 
menu, typing any size you want, or using a spin control to make it bigger or smaller.

Different Methods for Selecting Standard Sizes

Select from menu: 

Edit the number here 

Spin to next/previous value 

Select from drop menu: 
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16 Chapter 2: Basics
The Diagram
A diagram is a collection of symbols connected by lines, often including arrowsheads 
to indicate flows, and annotated by text labels. The combination of these simple 
components in nearly unlimited variety leads to a very powerful and flexible model. 
With this model you can build diagrams that show complex procedures, demonstrate 
plans, express ideas, organize thoughts, present proposals, record decisions, and much 
more.

Structurally, a diagram is composed of one or more sheets. Each sheet is a portion of a 
diagram, like a page but of any size that your require. The sheet functions like a virtual 
chalkboard upon which to draw your diagram. For convenience, a sheet might 
correspond to a sheet of paper so that you can print your diagram sheet-by-sheet on 
indiivdual pages of paper. This is the simplest way to begin. But a sheet can also be 
much larger than a printed page in which case each sheet get partitioned into multiple 
pages when printed. 

Diagram Components
The basic components of a flowchart are figures, connectors, labels, and junctions. 

Figures

Figures are the primary components of a flow chart. They often represent steps in a 
process. A figure can have any shape or design such as a circle, square, or any 
illustration. A figure also has stylistic attributes such as color and border width. 
Additionally, a figure can contain one or more text areas in which you can add 
descriptive text.

Connectors

Connectors are lines that connect two figures. They usually represent a path between 
two figures or a “flow” of control. Connectors can be straight, curved, smoothed, 

DATA 

PROCESS 

EVENT 

TEST 

figure 

connector label 

connectors 

figures 
THIS IS A SMALL 
SAMPLE DIAGRAM 

label 

junction 
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Styles and Properties 17
rounded, or arced. Each end of a connector can have an attached shape such as an 
arrowhead.

Junctions

Junctions are the points at which multiple segments of a connector meet. They often 
form a vertex for a line or a control point for a curve. Junctions make it possible for a 
connector to bend around corners, wrap around figures, and connect to other 
connectors.

Labels

Labels are stand-alone text objects that serve as titles, annotations, and paragraphs. 
You can place any number of labels anywhere on a diagram. Some labels serve 
specialized purposes like those below.

Connector Labels

Connector labels are special labels that attach themselves to a connector and remain 
attached when you move the connector. They can be in-line (as shown), or lateral 
(alongside) the connector.

Figure Labels

Figure labels are special labels that attach themselves to a figure and remain attached 
when you move the figure. 

Flow Labels

Flow labels are special labels that attach themselves to a flow point where a connector 
meets a figure. If either the figure or the connector moves, the flow label moves 
accordingly. Flow labels can identify conditional branches (true and false, yes or no) or 
further describe relationships defined by connectors.

Styles and Properties
Styles

Objects start from an object style - a set of default properties and characteristics. Styles 
are a lot like paragraph styles in word processors. Rather than describing paragraphs, 
they describe figures, labels, and connectors. 

One thing to remember about styles is that they are stored in every diagram. Don’t be 
afraid to change them because if you do and you mess up, your changes only affect that 
diagram. To make a style change that will affect future diagrams, you must change a 
template file (see below).

Diagram templates

The purpose of diagram templates is similar to the purpose of word processor template 
files, to group together a collection of styles that form the foundation of a diagram 

LABEL

LABEL 

LABEL

LABEL
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide

Page 17 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



18 Chapter 2: Basics
type. When you create a New diagram, you usually start from a template, such as from 
a template that contains the basic styles of a flow chart.

Figure styles

The purpose of diagram templates is similar to the purpose of word processor template 
files, to group together a collection of styles that form the foundation of a diagram 
type. When you create a New diagram, you usually start from a template, such as from 
a template that contains the basic styles of a flow chart.

Label styles

Label styles are similar to figure styles except they include only those attributes which 
apply to labels.

Connector styles

Connector styles contain information about the thickness of the line, whether it is 
straight or curved, its color, and whether it has arrow heads on either end. They also 
contain a set of rules that define how connectors of the style behave and interact with 
other objects.

Properties

An individual object such as a figure, label, or connector, has its own properties which 
it initially receives from an appropriate object style. 

For example, fill color is a property of a particular figure. The initial color comes from 
the figure style definition used to create the figure. You can change the fill color of this 
figure either by changing the figure style from which it was created (which also affects 
all other figures created from that style), or by changing the fill color property of the 
particular figure alone. 

Remember, each object has properties of its own. A style defines the initial properties, 
of objects of that style.
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The Workspace 19
The Workspace
The following illustration shows key components of the workspace followed by brief 
descriptions.

Title bar Shows the program name and the name of the active diagram.

Menu bar Contains menus of related commands.

Tool bar Contains buttons that provide easy access to frequently used 
commands.

Property bar A second optional toolbar that contain buttons and controls to easily 
change properties of figures, labels, and connectors.

Style bar Contains controls to access label, figure, and connector styles.

Status bar Shows brief help information.

Scroll bars Show your position in a diagram and allow you to move around.

Sheet bar Controls to change the active sheet.

Rulers Show real-life measurements of the diagram.

Title bar 

Scroll bars 

Rulers 

Status bar/help 
Style bar 

Menu bar Tool bar 

Property bar 

Sheet bar
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20 Chapter 2: Basics
The Style Bar
The style bar is the area to the left of the diagram that contains controls to access label, 
figure, and connector styles. The purpose of the style bar is to make it very easy to 
choose a style to create an object.

The style bar contains three main sections, one for labels, one for figures, and one for 
connectors. If the diagram contains no styles of one of these types, the section will not 
appear in the style bar.

Each of these sections contains three types of controls, all of which do the same thing 
in different ways!

Style drop menu

At the top of each section is a Style Drop Menu button. Use this button to choose a 
style from a drop menu, a pop-up menu that contains a graphic representation of every 
style of the type in this section. When pressed, it expands to show the styles:

The graphic representations in the drop menu are only approximations of the styles. 
For example, they do not include line thickness. 

Style combo box

Under the drop menu button is the style combo box. The style combo box displays the 
name of the currently selected style and it also allows you to change the style by 
choosing another style by name. The end result is the same as if you had used the drop 
menu to choose the style.

Style drop menu 
Style combo box 

Style bar buttons 
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The Tool Bar 21
Style bar buttons

Under the style combo box are optional style bar buttons. Each style bar button 
represents a single style. You can choose the style by simply pressing the button.

Though style bar buttons are the easiest way to choose a style, they also take up a lot of 
room. Therefore, they typically represent only the most frequently used styles. The 
representation of the style is only approximate. For example it does not show color.

For each style, you can choose whether or not it has a style bar button. Use the Define 
Styles dialog boxes or the Style selection dialog boxes to add style bar buttons. You 
can also use the Customize screen to add or remove style buttons (see below). 

Customizing the style bar

You can customize the style bar for a particular diagram or template. You can control 
its width, the size and arrangement of buttons of each type, and the styles that are 
available on buttons, plus some additional properties. The customization controls for 
the style bar are located in the Customization screen which is available in the Tools 
menu or by right-clicking on the style bar.

Collapsing the style bar

Some users may prefer to collapse the style bar leaving a less obtrusive method for 
selecting styles while freeing screen space for viewing and editing diagrams. To do so, 
click on the left-most button on the property bar (second tool bar). The style bar will 
disappear and instead three simple style drop menu buttons will appear in the property 
bar which perform the identical function as the drop menu buttons described above.

The Tool Bar

The tool bar provides convenient buttons to perform the most frequently used 
functions. The tool bar is always present. When you move the mouse over one of these 
buttons, a description of its function will appear in a small balloon called a tooltip as 
well as a help message in the status bar.

The Property Bar

The property bar in an optional second toolbar that contains buttons and controls to 
conveniently change object properties such as fonts, text formats, colors, and so on. 
The property bar is optional and can be toggled on and off by checking Show property 
bar from the View tab in the Options dialog box. When you move the mouse over one 
of these buttons, a description of its function will appear in a small balloon called a 
tooltip as well as a help message in the status bar.
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22 Chapter 2: Basics
You use the property bar by selecting one or more objects, then changing their 
properties with the property bar controls. All of these properties can also be changed 
through the object property dialog boxes, for example by selecting a figure and then 
choosing Properties from the Figures menu.

The property bar is also useful when creating objects. After you’ve selected the style 
of object to create, you can use the property bar to change the properties of the objects 
that will be created without changing the style itself. This is explained in more detail 
elsewhere.

Note that the property bar is optional and completely configurable. The descriptions 
above apply only to the default configuration.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 22 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



The Snap Grid 23
The Snap Grid
The snap grid helps you line up nodes in your diagram. The snap grid contains two 
components that you can use together or separately, the visible grid and the snap grid 
itself.

The visible grid

The visible grid is a set of horizontal and vertical grid lines or dots that appear behind 
your diagram. By itself, the visible grid is only a visual aid, it does not have an effect 
on your diagramming.

You can turn the visible grid on and off from within the Grid and Snap section of the 
Diagram Properties screen available from the Tools menu (see  Diagram Properties: 
Grid and Snap on page 223). You can control whether the grid is displayed as lines or 
dots from within the View section of the Options screen also available from the Tools 
menu.

The snap grid

The snap grid is NOT visible. However, when it is enabled it affects the construction of 
your diagrams. The snap grid automatically controls where nodes and paths can be 
placed and how large nodes can be. For example, if you set the snap spacing to a half 
inch, you can place nodes only at exactly one half inch intervals. Therefore, you know 
that if two nodes look lined up, they are lined up. If they look the same size, they are 
the same size. If a line looks straight, it is straight. When you print your diagram you 
won’t have to worry that what looked right on the screen is not right on paper.

You can turn snap on and off by pressing the tool bar button. control the snap spacing 
from within the Grid and Snap section of the Diagram Properties screen available 
from the Tools menu (see Diagram Properties: Grid and Snap on page 193)..

You can use either the visible grid or the snap grid without using both. However, when 
you use both together, you get the greatest benefit. Most often, you will want to choose 
a grid spacing that is larger than your snap spacing, twice as large is the default.

Modes
While you are working on a diagram, you are always in one of several modes. There is 
a mode for selecting and moving objects, a mode for creating figures, a mode for 
creating labels and editing text, a mode for creating connectors, and a mode for 
zooming into a certain area of a diagram. Following is a brief summary of each mode.

Select mode
The default mode is select mode. In this mode you can select objects, move objects, 
size objects, and perform many other functions. You will probably spend most of your 
time in this mode since this is the mode in which most features are available.
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24 Chapter 2: Basics
To enter select mode, click on the select mode button in the tool bar or press ESC. You 
can tell that you are in select mode when the select mode tool bar button is pressed and 
the mouse cursor is the standard Windows cursor .

Text mode
You enter text mode to work with text. In this mode you can create labels, add text to 
figures, and edit figure text.

To enter text mode, click on the text mode button in the tool bar. You can tell you are in 
text mode when the text mode button in the tool bar is pressed and the text 
cursor appears.

You will also enter text mode if you select a label style from the style bar.

Seltext mode
This mode is a special combination of text mode and select mode. It is just like select 
mode except that you can also edit text as if you were in text mode. 

Using this mode rather than select mode will prevent you from having to switch modes 
as often. The trade-off is that both selection and text editing require more precise 
pointing with the mouse.

To enter seltext mode, click on the seltext mode button in the tool bar. You can tell you 
are in seltext mode when the seltext mode button is pressed and the mouse cursor is 
either a text mode cursor or a select mode cursor .

Zoom mode
You enter zoom mode to zoom in to a part of your diagram and view it in greater 
detail.

To enter zoom mode, click on the zoom mode button in the tool bar. You can tell you 
are in zoom mode when the zoom mode button is pressed and the zoom cursor  
appears. Zoom mode is described in more detail elsewhere (see  Zoom on page 44).
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Modes 25
Figure create mode
You enter figure create mode to add figures to your flow chart.

To enter figure create mode, select a figure style from the style bar. There is no button 
on the tool bar because you must indicate the style of figure you want to create. 

You can tell you are in figure create mode when the cursor is in the shape of a figure. If 
the figure style you are creating has a button on the style bar, that button will be 
pressed as well.

Connect mode
You enter connect mode to create connectors in your flow chart.

To enter connect mode, select a connector style from the style bar. There is no button 
on the tool bar because you must indicate the style of connector you want to create.

The connect cursor appears . If the connector style you are creating has a button on 
the style bar, that button will be pressed as well.
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27
CHAPTER

3 General Editing 

This chapter covers fundamental operations that are common to all object types including 
figures, connectors, and labels. Many of these operations are accessible through commands 
in the Edit menu.

Selecting and Deselecting Objects
Most features affect one or more objects, but generally not all objects in a flow chart. 
Before you perform a feature, you can select one or more objects to which the feature will 
apply. This section covers the different methods of selecting and deselecting objects.

When an object is selected, its handles become visible as small red squares along the 
border of the object. Here’s how some common objects appear when selected:

There are several different methods for selecting and deselecting objects.

Lasso select
One way to select objects is to form a lasso around a group of objects. A lasso is a box that 
you form to choose a rectangular area of the diagram.

To lasso select objects
1. In Select mode, move the cursor to an area of the diagram where there are no objects. 

The cursor becomes the standard arrow shape .
2. Press the left mouse button, keep it held, and move the mouse to form a rectangular 

lasso area. The lasso cursor appears. The lasso area displays as a dotted box.
3. Release the mouse button. All objects that are located entirely within the lasso area 

become selected.

DIAGRAM

A selected figure A selected connector A selected label 
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28 Chapter 3: General Editing
Note that holding down the Alt key while performing a lasso selection causes objects 
belonging to both the foreground and background layers to be included in the resulting 
selection.

Click select
While in select mode select individual objects by clicking on the objects with the left 
mouse button. To select a particular object, move the mouse over the figure, connector, 
or label and click.

Select all
Select all the objects in a diagram by choosing Select All from the Edit menu.

Deselect all
To deselect all selected objects, click the left mouse button on the diagram where there 
are no objects, or choose Deselect All from the Edit menu.

Selecting more objects
Normally, if some objects are selected and you attempt to select objects with any of the 
prior methods, the previously selected objects become deselected before the new 
objects become selected. If you’d like the previously selected objects to remain 
selected in addition to the newly selected objects, hold down the SHIFT key while 
selecting objects with any above methods. This process is called extending a selection.

Deselecting Individual Objects
If a number of objects are selected, you can deselect individual objects by holding 
down SHIFT key while clicking on the object.

Moving Objects to the Front or Back
All objects have an order within the flow chart. New objects are in front of previously 
created objects and are drawn on top of them. You can adjust an object’s order in the 
diagram, and choose which objects are in front of or in back of other objects in the 
following ways.

To move one or more selected objects to the front
1. Select one or more objects.
2. Choose Front from the Edit menu. The selected objects move in front of all other 

objects in the diagram.
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Deleting Objects 29
To move one or more selected objects to the back
1. Select one or more objects.
2. Choose Back from the Edit menu. The selected objects moves in back of all other 

objects in the diagram.

You can also move a single object one position toward the front of the diagram or 
towards the back of the diagram, effectively moving it in front or behind a single 
overlapping object.

To move one object in front of the next overlapping object
1. Select the object to move.
2. Choose Front One from the Edit menu. The selected object moves forward by one 

object.

To move one object behind the next overlapping object
1. Select the object to move.
2. Choose Back One from the Edit menu. The selected object moves back by one 

object.

Deleting Objects
Deleting objects is a little different than cutting objects (see the following section) 
because you cannot Paste following Delete. Delete is also slightly faster and does not 
modify the Windows clipboard.

Original order After move to front After move to back 

Original order After move front one After move back one 
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30 Chapter 3: General Editing
Use Delete to remove objects permanently, and use Cut to remove objects from one 
location and Paste them to another location.

To delete objects from a diagram
1. Select one or more objects to delete.
2. Choose Delete from the Edit menu or press the DEL key.
When you delete selected objects, additional objects may be deleted automatically. For 
example, if you delete a connector, not only will all segments of the connector be 
deleted, but all connector labels that were attached to those segments will also be 
deleted whether or not they were selected. 

If you delete a figure to which a connector is attached, that connector is also deleted. If 
you want to delete a figure but not delete an attached connector, detach the connector 
first.

A special exception occurs when you delete a figure that is within a flow (that is it has 
a single connector entering it and another of the same style leaving it). In this case, if 
you delete the figure, the two connectors will join into one.

Cutting Objects
Cutting is another way to remove objects from a flow chart. Unlike delete, a copy of 
the deleted objects is first saved in the Windows clipboard. You can later Paste these 
objects back into the diagram or even into a different flow chart.

Use Delete to remove objects permanently, and use Cut to remove objects from one 
location and Paste them to another location.

To cut objects from a flow chart
1. Select the objects you want to cut.
2. Choose Cut from the Edit menu or press CTRL-X on the keyboard.
Like Delete, when you cut selected objects, additional objects may be cut 
automatically. 

Cut or copied objects remain in the clipboard until you cut or copy more objects, leave 
Windows, turn off your computer, or cut or copy to the clipboard from another 
program.
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Copying Objects 31
Copying Objects
Use the Windows clipboard to copy a selected set of objects within the same diagram 
or to a different diagram.

To copy objects in a flow chart
1. Select one or more objects to copy.
2. Choose Copy from the Edit menu or press CTRL-C on the keyboard.
3. Choose Paste from the Edit menu or press CTRL-V on the keyboard. A copy of the 

objects appear at the center of the screen selected for you.
4. Optionally, move the new objects.
5. You can Paste the same objects over and over again.

To copy objects from one flow chart to another
1. Select one or more objects.
2. Choose Copy from the Edit menu or press CTRL-C on the keyboard.
3. Open a different flow chart. 
4. Choose Paste from the Edit menu or press CTRL-V on the keyboard. A copy of the 

objects appear at the center of the screen selected for you.
5. Optionally, move the new objects.
6. You can Paste the same objects over and over again.

In addition to copying objects within and between flow charts, you can also copy 
objects from diagrams to documents of other programs such as Microsoft Word. 
Diagram objects can be copied to Microsoft Word and similar programs as OLE 
objects or simply as graphics, namely a Windows Metafile. When you a do a copy, both 
types of data are stored to the Windows clipboard and it is up to the program that 
pastes the data to choose the format (Object or Picture in this case). 

To copy objects from a flow chart to a different program
1. Select one or more objects to copy.
2. Choose Copy from the Edit menu or press CTRL-C on the keyboard.
3. Run the target program (MS Word in our example).
4. Choose Paste in the target program.
Cut or copied objects remain in the clipboard until you cut or copy more objects, leave 
Windows, turn off your computer, or cut or copy to the clipboard from another 
program.
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32 Chapter 3: General Editing
Duplicating Objects
Another faster way to copy objects is to duplicate them. Duplicating does not use the 
Windows clipboard and therefore does not work between different diagrams or 
between this program and other Windows applications. You can, however, use this 
procedure to copy objects between one view of a diagram and another view of the 
same diagram (see  Opening an Additional View of a Flow Chart on page 263).

To duplicate objects in the same diagram
1. Enter select mode.
2. Move the mouse over any object or over one in a group of selected objects.
3. While holding down the CONTROL key, drag the objects. A set of duplicate objects 

appears.
4. Position the duplicate objects and release the mouse button.
In addition, you can duplicate objects by right-clicking on them and choosing 
Duplicate from the right click menu or by selecting them and choosing Duplicate 
from the main Edit menu. You can of course select any number of objects and 
duplicate them as a group in the same way.

Pasting Objects
You can paste objects from the clipboard that were previously placed in the clipboard 
by an earlier Cut or Copy operation. Pasting is most often the second half of a Cut-and-
Paste or Copy-and-Paste operation.

To paste objects from the clipboard
1. Choose Paste from the Edit menu. If the Paste feature is grayed in the menu, it 

means that there is no diagram data in the clipboard.
2. A copy of the objects in the clipboard appears at the center of the screen. 
3. Optionally, move the new objects.
Once you paste objects, they remain in the clipboard so you can paste them repeatedly 
to create multiple copies. 

Pasting graphics
You can also Paste graphics that were copied to the clipboard by other programs. After 
copying a graphic from another program, simply use Paste as described above. This 
will work as long as the other program copies its graphics to the clipboard in a format 
that this program knows (WMF, EMF, BMP, DIB).
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Pasting text
Pasting text is special because it can be done in two ways. One way is to enter text 
mode, position the caret in an existing figure or label at the point where you want text 
to appear, then choose Paste from the Edit menu. If you are not in text mode and you 
paste text into your diagram, a new label will automatically be created for you and 
positioned at the center of the screen with the text that was in the clipboard. The style 
of this label will be the last label style you selected.

Paste As
The clipboard can contain the same information in several different formats at once. 
Normally, when you use Paste as described above, the best format (or the one that the 
other program said was best) is chosen automatically. However, there is also a way to 
choose exactly which format to paste.

To paste objects from the clipboard in a particular format
1. Choose Paste As from the Edit menu and select one of the available formats 

“WizFlow Flowcharter Objects”, “Picture”, “Bitmap”, “Formatted Text”, or 
“Text”. If a format is grayed in the menu, it means there is no such data in the 
clipboard.

2. A copy of the objects in the clipboard appears at the center of the screen. 
3. Move the new objects to where you want them.

Copying Object Properties
A subset of the most commonly edited diagram object properties can be copied and 
pasted to other objects of the same kind using the Copy Properties and Paste 
Properties features. These features provide a convenient alternative to the more 
cumbersome and comprehensive properties screens. The properties that can be copied 
this way are those that affect the visual appearance of the objects such as the fill, 
outline, and font.

Each object type (figures, connectors, and labels) has its own properties that can be 
copied only to objects of the same type. For example, if you copy properties of a figure 
and paste properties to a label, the label will not adopt the font of the figure even 
though both figures and labels have fonts. 

There is a separate Copy Properties and Paste Properties command for each type of 
object. However there are also two more convenient universal Copy Properties and 
Paste Properties features. These properties copy from and paste to selected objects 
based on their object types. It’s these generic features that are available by shortcut 
keys and provide the main interface to these features.
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34 Chapter 3: General Editing
To copy object properties to the clipboard
1. Select an object of a particular type (figure, connector, or label) or select a number 

of objects of the type, or select a variety of objects of multiple types. Alternately, 
simply right click on a target object - this is most clear if done with no objects 
selected but is equally valid if clicking on an object in the selection.

2. Choose Copy Properties from the Edit menu or use the shortcut key 
Shift+Ctrl+C to copy the object properties to the clipboard. If multiple objects are 
selected, the properties belonging to the last selected object of each type will be 
copied. 

3. Or, choose Copy Properties from the right-click menu if you right-clicked on a 
particular object to copy its properties. If this case, only the properties of the type 
of object clicked on will be copies to the clipboard.

To paste object properties from the clipboard
1. Select the objects to paste the copied properties to, or right click on a target object.
2. Choose Paste Properties from the Edit menu or use the shortcut key 

Shift+Ctrl+V to paste the object properties from the clipboard. 
3. Or, choose Paste Properties from the right-click menu if you right-clicked on a 

target object. 
Note that not all objects are appropriate for all properties and will not necessarily 
acquire all of the pasted properties. For example, a graphic object will not acquired 
pasted font or fill properties. 

You can selectively control which properties of which objects are subject to these 
features. See Edit category in the Tools Options screen.

Undo
The undo feature lets you undo changes to a flow chart. If you make any changes by 
mistake, you can reverse the effects of the most recent operations by using the undo 
feature. The undo menu command contains a brief description of the operation that can 
be undone. Each corresponds roughly to one operation you performed. For example, 
deleting ten selected objects can be undone in one step just as it was done in one step. 
The last fifty operations can be undone, older ones cannot.

To undo any operation
Choose Undo from the Edit menu. The undo menu item indicates exactly which 
operation will be undone.
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NOTE: Changes you make to styles cannot be undone. It is a good idea to save your 
diagram before making any changes to styles. You can assume that virtually 
all other operations can be undone. In rare cases where operations will not be 
undoable, you will be informed before the changes take place.

Moving Objects
Once you create figures, labels, and connectors in your flow chart, you can use the 
mouse to move and arrange them. There are a couple methods available for moving 
objects.

To move a single object without selecting it first
1. Enter select mode.
2. Move the mouse over an object so that the move cursor appears
3. Press the left mouse button and hold it.
4. Move the object to another location.
5. Release the mouse button.
Objects move in accordance with their properties. If the snap grid is enabled and the 
figure has the snap center to grid property, it will only move to points on the grid.

To move a group of selected objects
1. Enter select mode.
2. Select one or more objects to move.
3. Move the mouse over a selected object so that the move cursor appears.
4. Press the left mouse button and hold it.
5. Move the object to another location.
6. Release the mouse button.
You cannot drag objects from one flow chart to another flow chart in another window. 
Use cut/paste for that purpose. You can, however, drag objects between one view of a 
flow chart and another view of the same flow chart (see  Opening an Additional View 
of a Flow Chart on page 263).

Moving Objects with Precision

To move objects with greater precision
1. Enter select mode.
2. Select one or more objects.
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36 Chapter 3: General Editing
3. Press the up, down, right, or left arrow keys on the keyboard to move the objects a 
small increment in any direction.

The amount the objects move each time you press an arrow key depends on the snap-
to-grid diagram property (the button on the tool bar that resembles a square positioned 
on a grid). With snap enabled, each press of an arrow key moves the objects by a 
distance equal to the snap grid spacing. Otherwise, the objects move by one screen 
pixel.

Finding and Replacing Text
You can use the Find and Replace features to locate figures and labels in the currently 
open flow chart that contain some particular text and to replace that text with 
something else.

To find the figures and labels containing text
1. Change your zoom so that you can read your figure text clearly and still view a 

good portion of the diagram - 100% is good to start.
2. Choose Find from the Edit menu or press the shortcut key Ctrl-F.
3. The Find dialog box will appear. Enter the search text and select the options that 

apply, then press Find Next repeatedly to locate the figures and labels that contain 
the text. As you press Find Next, each occurrence of the text will become selected 
on the screen. If the figure is not already visible, it will move into view.

The Find dialog box looks like this:

Find what:

Type the text you wish to locate here.

Match whole word only

Check this box to locate only text that contains the search text as a complete word. For 
example, if your search text is “the”, it will not find the text within words like “these” 
or “other” only the word “the” by itself.
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Finding and Replacing Text 37
Match case

Check this box to locate only text that exactly matches the case of the search text. For 
example, if your search text is “the”, it will not find “The” or “THE”.

Find Next

Type the text you wish to locate here.

Cancel

Closes the dialog box.

To replace figure and label text
1. Change your zoom so that you can read your figure text clearly and still view a 

good portion of the diagram - 100% is good to start.
2. Choose Replace from the Edit menu or press the shortcut key Ctrl-H.
3. The Replace dialog box will appear. Enter the search text, the replacement text, 

and select the options that apply, then press either Replace All or Find Next/
Replace repeatedly to locate and replace each occurrence of the search text.

The Replace dialog box looks like this:

Find what:

Type the text you wish to locate here.

Replace with:

Type the replacement text here. You can leave this field blank to remove the search 
text.
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38 Chapter 3: General Editing
Match whole word only

Check this box to locate only text that contains the search text as a complete word. For 
example, if your search text is “the”, it will not find the text within words like “these” 
or “other” only the word “the” by itself.

Match case

Check this box to locate only text that exactly matches the case of the search text. For 
example, if your search text is “the”, it will not find “The” or “THE”.

Find Next

Type the text you wish to locate here.

Replace

After pressing Find Next to locate the next occurrence of the search text it will appear 
selected. Press the Replace button to replace the selected text with your replacement 
text. Pressing Find Next then Replace repeatedly lets you determine which 
occurrences of the search text you want to replace.

Replace All

Press this button to replace all occurrences of the search text in the current diagram 
with the replacement text.

Cancel

Closes the dialog box.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 38 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Choosing Colors 39
Choosing Colors
Colors place an important role in diagrams and the program user interface. The usual 
way to select a color is with a color selection menu button which presents a color 
selection drop menu when pressed.

The colors available in the color selection drop menu are those of the current color 
palette, which is simply a collection of colors available for this purpose. You can 
choose from a number of different palettes containing different numbers and varieties 
of colors. Palette selection can be found in the Colors tab found in the Options screen 
(available from the Tools menu).

The color selection drop menu contains some different components:

Palette colors

The colors above the line are the colors of the color palette. They change only if you 
select a new palette as described above.

Custom diagram colors

The colors below the line are the sixteen custom colors that you can set for each 
diagram you create. You can control which colors are shown here and saved in your 
diagram using the standard Windows color dialog box described below.

Transparent color

Under some circumstances, such as when setting a fill color, the color selection drop 
menu contains an entry for transparency rather than a color. This entry appears as a box 
with an “X” in the upper right corner of the drop menu.
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40 Chapter 3: General Editing
Ellipsis (...)

The ellipsis (three dots) is located at the bottom right of the color selection drop menu. 
Click here to access the standard Windows color dialog box to choose a color that may 
not be represented in the drop menu, or to change the custom diagram colors. 

Fill Colors, Transparency, and Tinting

Fill Colors
Nearly any figure in a diagram can be colored with a fill color in addition to a border 
(outline) color and text color. The fill color determines the color of the body of the 
symbol. If the symbol contains text areas, the fill color will also determine the 
background color for its text. For figures that are graphic images, such as imported 
clipart, the fill color controls the tint color of the image (see Tinting below).

Transparency
A figure with no fill color is transparent. You can remove the fill color by selecting the 
“X” from the fill color drop menu. When an ordinary geometric symbol is transparent, 
objects below it will be visible through the symbol. A side effect of a symbol with no 
fill color is that you will need to click on the border or outline of the symbol in order to 
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Fill Colors, Transparency, and Tinting 41
select it. A graphic image uses the fill color as a tint color. For graphic images, no fill 
color means the image will be drawn with its original colors rather than a tint color - no 
transparency is possible (see Tinting below).

Tinting
The fill color for graphic images such as imported clip art is a tinting color. Initially an 
imported graphic will have no tint color which is the same as having a transparent fill 
color. A graphic image with no tint color is drawn with its original colors. If you 
change a graphic's fill color it will change the tint color of the image. For black and 
white images, the black portions of the image will be replaced by the tint color and the 
white portions will remain unchanged. For gray-scale or multi-colored images, each 
color in the image will be replaced by a shade of the tint color. For gray-scale images 
for example, a blue fill color will have the effect of changing the image colors from 
shades of gray to shades of blue.

There are some limitations on the ability to control tinting of graphic images. 
Attempting to control tinting by changing the fill color of certain graphics will have no 
affect on (a) imported metafiles that contain their own embedded color palettes, (b) 
imported metafiles that contain bitmaps embedded within the metafile, and (c) APM 
metafiles. If you cannot control the tinting of an imported graphic by changing the fill 
color, you may need to edit the colors of the original graphic with a paint program and 
import the result.
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CHAPTER

4 Getting Around in a Flow Chart

Limitations of the computer screen present the single greatest obstacle to working on a 
diagram. Typical diagrams extend well beyond the size and degree of detail that you can 
view effectively within a single window. This chapter describes the methods provided to 
overcome this obstacle. With these features, you can control precisely both the portion of 
the diagram and the degree of detail that are shown.

Using the Scroll Bars
You can use scroll bars to move your view of the diagram up-and-down and left-and-right 
without affecting the degree of detail shown.

The scroll bar buttons scroll the diagram by a small amount in the direction of the arrow. 
Clicking in the region of the scroll bar between the slider and a button scrolls by a half 
screen in the direction of the button.

Using the Arrow Keys
You can also use the shifted Up, Down, Left, and Right arrow keys on your keyboard to 
move your view of the diagram. Each key press moves the diagram by one quarter of the 
screen area in the appropriate direction. 

Drag Scrolling
One of the most convenient ways to scroll the screen is to press the middle mouse button or 
mouse wheel button and drag your view in any direction. If you don't have a mouse wheel 
or middle button, you can use the Control key plus the left mouse button, but when doing so 
be sure the mouse is not positioned above any objects because Control-drag is also how you 
duplicate objects.

Autoscroll
When you drag an object past the edge of the screen, the diagram automatically scrolls to 
follow the cursor. Autoscroll is only in effect when the current view is maximized to fill the 
entire workspace. 
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44 Chapter 4: Getting Around in a Flow Chart
Zoom
Zoom features allow you to move quickly between different views of the diagram and 
to increase and decrease the degree of detail displayed in the diagram window. Some 
of these features allow you to zoom-in and zoom-out your view of the diagram. By 
changing the zoom magnification, you can control how much of the diagram is visible 
and how much detail is displayed. Other zoom features let you move instantly to a 
special view of the diagram.

For all zoom features, the absolute limit of the zoom range is from 10% (one tenth 
printed size) to 1000% (ten times printed size) but you will probably notice that more 
narrow limits are determined by your screen resolution and display mode.

Zooming to a special view
The following features move you directly to a special view of the diagram regardless 
of your present location. They are especially useful for returning to a known view 
when you become disoriented. These features are found at the top of the View menu.

To zoom to a view of the entire page area
Choose Whole Page from the View menu or press the toolbar button. 

To zoom to a view of the top of the page area
Choose Page Width from the View menu or press the toolbar button. 

To zoom to a view of all the objects in the diagram
Choose All Objects from the View menu.

To zoom to a view of all selected objects in the diagram
1. Select one or more objects.
2. Choose Selected Objects from the View menu.
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Zoom 45
Zooming in and out
These features increase or decrease the amount of detail in the diagram window.

To zoom the view to any magnification
Using the combo box located on the tool bar, choose a predefined zoom percentage, or 
type in any valid percentage and press enter. The valid zoom range depends on your 
particular configuration but must never be less than 10% or more than 1000%.

To zoom in and out - using the keyboard
Press the PLUS key on the keypad to zoom in or the MINUS key to zoom out. The view 
is magnified or reduced by a small amount so that objects appear larger or smaller. 
Normally, the view remains centered at the same location of the diagram prior to 
zooming in. However, if any objects were selected, the new view is centered on those 
objects.

To zoom to one of the preset zoom intervals
Choose a specific percentage from the View menu. The status bar at the bottom of the 
screen displays the current zoom percentage. At one hundred percent, the size of the 
diagram on the screen exactly matches the printed size - assuming your screen height 
is set accurately.

To zoom in to the next zoom interval
Press the tool bar button that looks like a magnifying glass with a big “+”. The view 
will zoom to the next higher of the fixed zoom intervals. 

To zoom out to the next zoom interval
Press the tool bar button that looks like a magnifying glass with a big “-”. The view 
will zoom to the next lower of the fixed zoom intervals. 

To set custom zoom intervals
1. Choose Set from the View menu.
2. Use the Zoom tab of the Options dialog box to set your own zoom intervals.
3. Press OK to make your changes. The new percentages are sorted and entered into 

the View menu. Choose the new percentage from the View menu to change the 
zoom magnification.

Using zoom mode
Zoom mode provides even greater control to select a view of your diagram. You enter 
zoom mode by clicking on the zoom mode button in the tool bar. You can tell you are 
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46 Chapter 4: Getting Around in a Flow Chart
in zoom mode when the zoom mode button is pressed and the zoom cursor 
appears.

To zoom in incrementally in zoom mode
1. Enter zoom mode.
2. Move the mouse over a part of the diagram that you want to view in greater detail.
3. Click the left mouse button (press and release immediately) to zoom in a little 

closer.
4. Repeat until the view is sufficiently detailed.

To zoom in to a specific location in zoom mode
1. First you might want to zoom out so that the entire area you want to view is visible 

on the screen. Zoom Page is useful for this purpose.
2. Enter zoom mode.
3. Choose the area of the diagram that you want to view in detail. Move the mouse to 

the upper left-hand corner of that area.
4. Press and hold the left mouse button.
5. Drag the mouse to create a rectangular region covering the area of interest.
6. Release the mouse button. The rectangular region will fill the entire window.

Navigating among multiple sheets
Use the Sheet Bar and sheet tabs located in the lower left corner of the view window to 
change the active sheet. The individual sheet bar controls are described in the Sheets 
chapter.
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CHAPTER

5SHEETS

A diagram may contain multiple sheets. A sheet is essentially a page. However we use the 
term sheet instead so not to confuse it with a printed page. It its simplest form each sheet 
will correspond to a printed page such as a letter-sized area. However, you can use Page 
Set-up to define larger sheets of just about any size that may not be printable unless divided 
into multiple printed pages. Therefore a sheet is a continuous rectangular space of any size 
(but most conveniently that of a supported paper size) on which you can lay out a diagram. 
And a diagram may contain multiple sheets to improve organization and modularity.

Each diagram has at least one sheet. You may choose to add sheets as a diagram’s size and 
complexity grows. While a diagram may multiple sheets, it’s important to understand that it 
remains a single diagram and all sheets share the same styles and diagram properties. 

Adding a Sheet
You can add a sheet to a diagram before the first sheet, after the last sheet, or between any 
existing sheets. 

To add a new sheet to a diagram
1. Right click on any tab in the Sheet Bar and select Insert Before or Insert After from 

the pop-up menu to add a new sheet before or after the corresponding sheet.
Or

2. Select the first or last tab of the diagram causing the Previous Sheet or Next Sheet 
button in the Sheet Bar respectively to change from a triangular arrow to “+”. Click the 
button add a new first or last sheet to the diagram.

Deleting a Sheet
You can delete any sheet or sheets within a diagram. Deleting a sheet will delete all 
diagram objects contained within the sheet. Keep in mind that you cannot delete the last 
remaining sheet of a diagram, nor will ou be allowed to delete all sheets at once.
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48 Chapter 5: Sheets
To delete a sheet from a diagram
1. Right click on any tab in the Sheet Bar and select Delete from the pop-up menu to 

delete the corresponding sheet. 
Or

2. Click the Go to Sheet button in the Sheet Bar to invoke the Go to Sheet screen. 
Then select one or more sheets and click the Delete button. This is the only way to 
delete more than one sheet at a time.

Changing the Active Sheet
The currently active sheet is displayed in the active window. It’s the sheet that is 
affected by edits, copies, pastes, exports, searches, and so on. Changing the active 
sheet is like flipping to a different page in your diagram.

To change the active sheet
1. Click on the corresponding sheet tab within the Sheet Bar.

Or

2. Use the Sheet Bar to navigate among multiple sheets in a diagram changing the 
active sheet that is displayed in the active view window. Click on the arrow 
buttons to navigate to the First Sheet, Last Sheet, Previous Sheet, or Next Sheet. 

To go to a specific sheet
1. Click on the Go to Sheet button in the Sheet Bar. It’s the middle button that 

displays the current sheet number and total number of sheets in the form “3 of 5” 
representing the third sheet of five. This invokes the Go to Sheet screen. Select a 
single sheet and click Ok to make it the active sheet, or simply double-click on it.

Assigning a sheet a custom name
You can assign a name to any or all sheets in a diagram. By default the sheets are 
simply named in sequence as “Sheet 1”, “Sheet 2”, “Sheet 3”, and so on. Assigning a 
custom name to sheet is both clearer and more stable. It’s clearer in the obvious sense 
that “Checkout Procedure” is more descriptive than “Sheet 3”. It’s more stable as well 
because a custom name sticks with the particular sheet when other sheets are added or 
removed, whereas “Sheet 3” becomes “Sheet 2” if you delete “Sheet 1”. 

Referring to a sheet by name rather than by number is especially useful when 
exporting or saving as HTML in which case the sheet name is used to construct the 
filename of the output file. A stable custom sheet name results in a more easily 
understood and maintained relationship between a diagram, it’s sheets, and their 
corresponding exported files or HTML pages. The same is true when hyperlinking to a 
particular sheet within a diagram.
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Assigning a sheet a custom name 49
Custom sheet names can be up to 64 characters in length. Each custom sheet name 
within a diagram must be unique. The name must not be blank or end in a space, and it 
must not contain characters not allowed within a Windows file name (“:”, “.”, “/”, “\”, 
“|”, “?”, “<“, “>”).

To assign a custom sheet name
1. Double click on the sheet name on the sheet’s tab in the Sheet Bar.
2. Edit the sheet name complying with the naming rules above.
3. Press Enter or click on another control in the Sheet Bar when complete, or press 

ESC to cancel.

To unassign a custom sheet name
1. Assign a custom name to the sheet as described above, but clear the name (make it 

blank) or assign it to the exact name it would have by default (such as “Sheet 2”). 
Once the custom sheet name is unassigned, the name will change such as from 
“Sheet 2” to “Sheet 3” reflecting its order in the diagram as other sheets get added 
and removed.
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CHAPTER

6 Figures

Figures are the shapes that form the building blocks of flow charts. A figure has a number 
of attributes or properties. The shape of a figure is one of its properties. It also has stylistic 
properties such as color and border thickness. And it has behavioral properties such as 
whether or not it remains aligned with the snap grid. The initial properties of a figure come 
from the figure style used to create it.

This chapter covers the properties, behaviors, and features that are unique to figures. There 
are also many operations not covered in this chapter that affect figures as well as other 
types of objects (see  CHAPTER 3: General Editing,  page 27). This chapter will assume 
you know some of that general information such as how to select objects.

Creating Figures
The most common way to add a figure to your flow chart is to choose a figure style that 
represents the shape and initial properties of the figure object you are creating. This moves 
you into create mode where you drop the figure onto your flow chart and optionally resize 
it.

To choose a figure style and initiate create mode

Perform one of the following:

1. Click on the style bar button of a figure style. If the style does not have a button in the 
style bar, use one of the following methods instead.

Figure style drop menu 
Figure style combo box 
Style bar buttons 
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide

Page 51 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



52 Chapter 6: Figures
or

2. Press and hold the Figures button in the style bar to activate the figure style drop 
menu. Move to the representation of the style, and release the mouse button. Not 

all styles are displayed in this menu so you may have to choose the three dots to 
see all of them (see the next section).

or

3. Choose the figure style by name from the figure style combo box. The combo box 
always contains all styles defined in the diagram.

Method 4: Choosing a figure style from the complete list of styles
A fourth method is available to select a figure style. This method contains all of the 
styles with complete names, pictures, and descriptions and lets you choose which 
styles appear on buttons and in drop menus.
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Creating Figures 53
Select the ellipsis (three dots) from the Figures drop menu to open the Choose a Figure 
Style dialog box.

To choose a figure style 
1. Scroll to preview all of the available styles.
2. Click on the style to select it.
3. Press OK. Alternately, just double-click on the style. 

Category

Use this combo box to show all styles or only styles of a certain category.

Edit

While you’re here you may want to add, change, or delete styles from your diagram. 
This button just provides a convenient shortcut to the Styles dialog box. Also available 
by right-clicking any style in the list.
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54 Chapter 6: Figures
Menu

Check or uncheck this button for each style to control whether the drop menu contains 
a representation of the particular style. Also available by right-clicking any style in the 
list.

Button

Check or uncheck this button for each style to control whether the style is represented 
by a button in the style bar. Reserve buttons only for your most common styles. Also 
available by right-clicking any style in the list.

NOTE: Notice that this screen is resizable. If it is too narrow and cannot include the 
Edit, Button, and Menu controls, they remain available by right-clicking on 
a style.

Once you have selected the figure style to create...

To create a new figure
1. If the figure style has a default size, the cursor becomes an outline of the figure 

when you move the mouse over the diagram.
2. Use the mouse to position the new figure.
3. Press the mouse button.
4. If the figure has a default size and you want to create a figure of this size, release 

the mouse button immediately. Otherwise, while continuing to hold the mouse 
button, resize the figure to the desired size. Before releasing the mouse button, 
you can press ESC to cancel.

5. Release the mouse button
If the figure has default text, the newly created figure will contain the default text.

After selecting the figure style, but before you actually click on the diagram to create 
it, you can use the property bar to change properties of the figure that you are about to 
create such as the colors, font, text alignment and so on. Changes made in this way 
affect only the new figures that you are about to create not the style definition.

Inserting a Symbol
Although the usual way to add figures to your diagram is by creating them from a 
figure style, there are also times that you just want to add a single figure without first 
creating a new style. The Insert Symbol feature provides this capability.
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Changing the Size of Figures 55
To insert a single figure from the Figure Symbol Gallery
1. In select mode, choose Insert Symbol from the Figures menu or from the right 

click menu. Or press the Insert Symbol button on the tool bar.
2. Select any figure symbol from the Figure Symbol Gallery dialog box.
3. A new figure with the selected symbol will appear on the screen. You may want to 

resize it and move it to a better location.

Changing the Size of Figures
A figure can be almost any size from a sixteenth of an inch to a hundred inches in 
height and width. 

To change the size of a figure
1. Select the figure.
2. Move the mouse over one of the eight handles (by default they are little red 

squares). The cursor’s shape indicates how the figure will size with each handle.
3. Press the mouse button.
4. Drag the handle and resize the figure to the desired size. If you decide to cancel at 

this time before releasing the mouse button, press ESC.
5. Release the mouse button.
How the figure resizes depends on several things. If the figure has the Center 
stationary when resizing property, then the figure gets larger or smaller in all directions 
as you drag the handle, but the center stays in the same place. This is useful if you want 
to keep the figure lined up with the center of other figures above or below. If the figure 
does not have this property, it extends only in the direction that you drag the handle. 

If snap is enabled and the figure has the Height and width snap to grid property, the 
height and width can only change such that the edges of the figure are positioned along 
snap grid lines. In effect, this means that the height and width will always be a factor of 
twice the snap spacing. For example, if the snap spacing is a quarter inch, the figure 
width can be a half inch, one inch, one and a half inches and so on.

If the figure contains text, you will not be permitted to resize the figure such that it will 
be too small to contain the text. If the figure has the word-wrap property, the text will 
reformat when you resize the figure, in which case there is no minimum width.

There are also other ways to change the size of a figure. When you type text in a figure, 
the figure can resize automatically. You can change the size of figures by using the 
Make Same Size feature (see  Making Figures the Same Size on page 57). You can also 
set the height and width of figures explicitly in the Figure Properties dialog box (see  
Orthogonal Connectors on page 103).
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Moving Figures
There are several ways to move figures from one place in a diagram to another. When 
you move a figure, all text that is part of the figure, and all connectors that are attached 
to the figure move as well.

To move a single figure without first selecting it
1. Make sure you are in select mode.
2. Move the mouse over the figure. The move cursor appears.
3. Press the mouse button.
4. While holding the mouse button down, drag the figure to the new location.
5. Release the mouse button.
The procedure above works from seltext mode as well as from select mode. However, 
if you are in seltext mode, be sure that the cursor is actually over a figure and not over 
a text area within the figure before attempting to move it this way. You can tell that you 
can move the figure when the move cursor appears.

To move one or more selected figures
1. Move the mouse cursor over any selected figure. The move cursor appears.
2. Press the mouse button.
3. While holding the mouse button down, drag the figures to the new location. 

While dragging the figures, you can cancel by pressing ESC before releasing the 
mouse button.

4. Release the mouse button.

There is also another way to move a group of selected figures with greater control over 
precisely how much they move.

To move selected figures more precisely
1. Enter select mode.
2. Select one or more objects.
3. Hold down the SHIFT key and simultaneously press the up, down, right, or left 

arrow keys on the keyboard to move the objects a small increment in any 
direction.

The amount the objects move each time you press an arrow key depends on the snap-
to-grid diagram property (the button on the tool bar that resembles a rectangle over a 
grid). With snap enabled, each press of an arrow key moves the objects by a distance 
equal to the snap grid spacing. Otherwise, the objects move by one screen pixel.
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Aligning Figures 57
There are also many indirect ways to move figures such as aligning, centering on the 
page, spacing, and so on. You can also set the location of figures explicitly in the 
Figure Properties dialog box (see  Orthogonal Connectors on page 103).

Aligning Figures

To align a group of figures
1. Select the figures.
2. Choose one of the selected figures to be the model figure, the figure with which 

the other selected figures are aligned. By default the last figure selected is the 
model figure. To force a different selected figure to become the model figure, hold 
down the SHIFT key and click on a different figure.

3. Choose one of the alignment methods from the Align submenu under the Figures 
menu.

4. All of the selected figures are aligned with the model figure using the chosen 
method. 

Making Figures the Same Size
There are many aids for creating figures with a uniform size. One way is to use the 
figure style default size property. Another is to use the snap grid. Yet another is the 
Make Same Size feature.

To make a number of figures the same size
1. Select the figures.
2. Choose one of the selected figures to be the model figure, the figure whose size 

indicates the size to make the other selected figures. By default the last figure 
selected is the model figure. To force a different selected figure to become the 
model figure, hold down the SHIFT key and click on a different figure.

3. Choose one of the sizing methods (Height, Width, or Both) from the Make Same 
Size submenu under the Figures menu. 

4. All of the selected figures will become the same size as the model figure.

NOTE: There are cases where a figure cannot be made the exact size as the model 
figure. One example is a figure that has more text than would fit if it were 
made as small as the model figure. In this case, the figure is made as small as 
possible.
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58 Chapter 6: Figures
Sizing Figures to Text
A figure can be no smaller than the text it contains. Occasionally you may want to 
make a figure as small as possible for the current text. You can do this by dragging the 
figure’s sizing handles, or more conveniently by using this feature.

To adjust the size of a figure to the text it contains
1. Select a figure (or group of figures).
2. Choose Size to Text from the Figures menu. 
3. Each selected figure will shrink to the smallest size possible for its text.

NOTE: If the snap grid is enabled and the figure’s properties cause its height and 
width to snap to the grid, the figure’s size may not be as small as possible to 
contain the text. If this is not the effect you want, turn off the snap grid first.

If you want a figure to remain sized to its text automatically when the text changes, 
you can set its Keep sized to text property.

Spacing Figures Evenly
The Space Evenly feature is useful for spacing figures across the diagram or from top 
to bottom at equal intervals. 

To space a group of figures evenly from left to right or top to bottom
1. Select at least three nodes.
2. Choose either Across or Down from the Space Evenly submenu under the 

Figures menu. And choose whether to space the figures evenly based on their 
centers, a particular edge, or based on the spacing between them.

3. The selected figures will be spaced evenly from right to left if you chose Across, 
or top to bottom if you chose Down. 
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Centering Figures on the Page 59
The spacing is determined by the average spacing between the right-most and left-most 
of the selected figures (in the across case), therefore the left-most node does not move. 
The left-to-right or top-to-bottom ordering of the figures does not change.

Centering Figures on the Page
This feature can center a group of figures on the page, length-wise, width-wise or both. 
This feature is available if the Show Page Boundaries option is enabled.

To center figures on the page
1. Select a number of objects (not necessarily only figures).
2. From the Center on Page submenu under the Figures menu, choose one of the 

centering options.
3. All selected objects are centered as a group on the current page.
Note that when you center many objects on the page, they do not all end up overlapped 
at the center of the page. Rather, they are centered as if they were one larger object (as 
a group). This feature is especially useful for final formatting of your diagram. For 
example, when your diagram is complete, you can Select All and then Center on 
Page, neatly centering your entire diagram on the page for printing.

The page referred to here is actually the active sheet which might not be the same as a 
printed page. Any subsequent change to Page Set-up that affects page size or 
orientation may necessitate re-centering your diagram.

Connections
Figures can have connectors attached to them. Connectors and their usage is described 
fully in the following chapter. This section describes the properties of figures that 
affect connections.

Spacing these figures evenly across (centers)... 

Produces this result: 
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60 Chapter 6: Figures
Center Connections
Most all figures support center connections. In a standard center connection, a 
connector attaches to a figure at its center point and remains attached there if the figure 
moves or the orientation of the connector changes. While the connector attaches to the 
center of the figure, it actually terminates at the edge of the figure where its end 
symbol drawn as well.

Connection Points
For added flexibility, figures may have connection points in addition to the center of 
the figure or in its place. A connection point is an alternate point within the shape 
where connectors can attach.You can set connection points for figures and figure styles 
and attach connectors to them. 

Setting Connection Points
You can set connection points for a figure by going to the figure’s properties dialog 
box (double click on the figure or choose Properties from the right click menu) and 
select the Connections tab (see  Figure Properties: Connections on page 77). You can 
set connection point in the same way in a figure style.

Connection Point Tool
An additional method for setting the connection points of a figure is to use the 
connection point tool. The connection point tool is a special mode that lets you add, 
move, and remove connection points right on the figure in your diagram.

To use the connection point tool, click on the icon in the tool bar. The cursor will 
change to a small hand. When you are done editing connection points you can quit 
using the connection point tool and return to another mode by clicking on the select 
mode button or any of the usual alternate modes.

Adding Connection Points with the Connection Point Tool

To add new connection points to a figure using the connection point tool, move the 
mouse over the figure and click (or right-click and choose Add Connection Point 
from the menu). Right click on the new point and choose Connection Point 
Properties to add a name or description for the new point.

Sample uses for connection points
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 60 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Connections 61
Moving Connection Points with the Connection Point Tool

To move a connection point using the connection point tool, position the mouse over 
the connection point so that it is highlighted. Then click and drag the connection point 
to a new location. Use the snap grid to help by clicking on the Snap Grid On/Off 
toolbar button.

Deleting Connection Points with the Connection Point Tool

To delete a connection point using the connection point tool, position the mouse over 
the connection point so that it is highlighted. Then right-click on the connection point 
and choose Delete Connection Point from the menu.

After making changes to the connection points of a figure, you can update the figure 
style to reflect the new connection points. To do so, exit the connect point tool, right 
click on the figure, and choose Update Style From.. This will update the style and all 
other figures of the style.

Connection Point Options
There are several options that let you control the use of connection points in your 
diagram. In addition to the ability to add, move, and delete connection points from 
figures, there are options to control how they are used for connections, how they 
appear on the screen, and how they are indicated on output. Each of these is covered in 
detail elsewhere:

By selecting different attach methods (from the Connector menu), you can 
choose to attach to connection points, or ignore them while creating connectors.
You can control how the connection points appear (on the screen) by turning them 
on or off from the View tab of the Options dialog box, and set their color in the 
Colors tab of the Options dialog box.
You can control whether the point where a connector attaches to a connection 
point is marked with a dot (on screen and output), by setting Dots where 
connectors attach to connection points in the Diagram Properties dialog box.
By choosing different options within the Connections tab of the Figure Properties 
(and Styles) dialog boxes, you can control whether only the connection points are 
attached to (i.e., not the centers of the figure) and whether connections to connect 
points extend all the way to the connect point or terminate at the edge of the 
figure.
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62 Chapter 6: Figures
Reshaping Figures
Certain figures (but not all of them) can be reshaped after you add them to your 
diagram. Reshaping a figure lets you adjust it to more precisely control its appearance.

To reshape a figure
1. Select the figure. If the figure can be reshaped (not all can), it will have one or 

more yellow diamond-shaped reshape handles.
2. Click on and drag the reshape handle to adjust the shape. 

To update the style to the new shape
If you update the style to the same shape as the newly reshaped object, other objects 
that you create using the same style will initially have the same shape. To do so, right 
click on the object after you have reshaped it and choose Update Style From... in the 
right click menu.

Reshape handles are yellow by default. However, you can customize this color from 
the Colors tab in the Options dialog box (see Tools menu).

If a figure has multiple text areas that are reshapable, the text areas adjust 
automatically with the reshaping of the figure (see the following section).

Multiple Text Areas
Some figures contain multiple areas for text. 

Generally, figures that contain multiple text areas are reshapable to allow you to select 
different sizes for each area. When you reshape them (see the shaping section), the text 
areas reshape automatically. If the text area already contains text, reshaping will not be 
permitted if it would result in an area too small to contain the text.

Barry Smith

24 Center St.
555-1223
Age: 44

102 Accounting
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Containers 63
Independent Justification within Text Areas
Text in each area can be justified independently. For example, in one area the text can 
be centered and in another it can be left-justified (as shown in the example above). If 
you are in text mode editing the text within a particular text area and you press one of 
the justification control buttons on the toolbar, the justification for only that area will 
change. If you leave text mode, select the figure, and choose a justification, all text 
areas of the figure will change to the new justification. You can also set justification 
however you prefer by using the Text tab of the Figure Properties dialog box.

Containers
A container is a shape in your flow chart that shows a group of objects, a subset, or 
some other collection or separation. The illustration below shows a portion of a flow 
chart surrounded by a container.

There are three ways to add a container to a flow chart. The first and easiest way is to 
choose a style from the current flow chart template. If the template has a Containers 
category in the Figures drop-down menu in the style bar, simply select it and place it 
on your flow chart as you would any other figure shape.

If the template you are using does not include predefined container styles, the next 
easiest method is to invoke the Insert Symbol feature to insert a predefined container 
symbol from the Figure Symbol Gallery.

A container - a shape added to a 
FIG 1 

FIG 2 

diagram to illustrate a grouping or
collection.
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64 Chapter 6: Figures
To insert a container from the Figure Symbol Gallery
1. Without objects selected, right click on your flow chart and select Insert Symbol. 

Or choose the Insert Symbol feature from the Figures menu. The Figure Symbol 
Gallery dialog box appears.

2. Select the Containers category. The large window displays the pre-defined 

container shapes. Notice that containers are indicated by brackets surrounding 
their names.

3. In the large window, select a container shape and click OK.
4. Size and position the new container in your diagram.
5. Optionally, right click on the new container and toggle Active Container to 

activate the container so that objects within the container are kept together with 
the container (see below).

If you require a container of a shape that is not included in the template or the gallery, 
you can create one of your own based on any existing figure symbol.

To create your own container from any figure symbol
1. Create any shape in one of the usual ways such as by using the Insert Symbol 

feature from the Figures menu. 
2. Enlarge the shape and move it to the back of the flow chart.  

This method has some drawbacks. Most notably, the software will still treat the inside 
of the container as part of a figure making it a nuisance to select and connect objects 
within the container. To complete the construction of a container from any shape, 
adjust the figure properties as follows:

3. Remove the fill color by selecting the shape and choosing the “x” from the fill 
color drop menu. A figure with no fill color is treated as transparent. For example, 
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Containers 65
you will be able to select and manipulate objects that are “beneath” the container. 
A figure that does not have a fill color can only be selected by clicking on its 
border or lassoing the whole object. 

4. Hide the text areas of the container object. Do this by clicking the “Hidden” box in 
the Text tab of the Figure Properties dialog box - repeat for each text area if there 
is more than one in the figure. Hiding the text areas is an important step because 
text areas are selectable even when there is no fill. The result is that non-hidden 
text areas prevent you from selecting objects beneath the container (even if the 
text is blank).

5. Choose stylistic attributes. For example, you will often want a dashed or dotted 
container. Do this from the General tab of the Figure Properties dialog box.

6. Adjust behaviors for greater convenience. Do this from the Figure Properties 
dialog box. We suggest the following settings: 
(a) Horizontal expansion = Expand to right 
(b) Vertical expansion = Expand down 
(c) Center stationary when resizing = unchecked 
(d) Center snaps to grid = unchecked 
(e)(optional) Active container - keep contained objects together = checked

 
The “Active Container“ behavior adds great power and simplicity to containers 
elevating them beyond drawing objects.

Containers with this property automatically keep any objects that are positioned within 
their bounds together for simple operations. If you move the container, all objects 
inside move along. If you copy it, the objects inside appear in the copy as well. If you 
delete it, the objects are removed. You can move individual objects into and out of the 
container simply by dragging them, but drag the container and them stay together.

Note, if the container is filled, only objects on top of the container are kept together. If 
it has no fill, all objects above or below are kept together.

It might seem that this behavior resembles a group (see Groups chapter). For simple 
operations like moving, copying, deleting, and so on, it is much like a group. However, 
it is more limited than a group and therefore more convenient for this purpose. For 
example, unlike a group, you never have to use the Group or Ungroup commands to 
change the contents, plus you always have full access to the included objects without 
having to ungroup first. Unlike a group, resizing a container expands it bounds rather 
than scaling it.

Active Containers - Keeping Objects Together
The last behavior suggested above is recommended when using containers in their 
prescribed manner. The “Active Container“ behavior adds great power and simplicity 
to containers elevating them beyond drawing objects.
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66 Chapter 6: Figures
Containers with this property automatically keep any objects that are positioned within 
their bounds together for simple operations. If you move the container, all objects 
inside move along. If you copy it, the objects inside appear in the copy as well. If you 
delete it, the objects are removed. You can move individual objects into and out of the 
container simply by dragging them, but drag the container and them stay together.

Note, if the container is filled, only objects on top of the container are kept together. If 
it has no fill, all objects above or below are kept together.

It might seem that this behavior resembles a group (see Groups chapter). For simple 
operations like moving, copying, deleting, and so on, it is much like a group. However, 
it is more limited than a group and therefore more convenient for this purpose. For 
example, unlike a group, you never have to use the Group or Ungroup commands to 
change the contents, plus you always have full access to the included objects without 
having to ungroup first. Unlike a group, resizing a container expands it bounds rather 
than scaling it.
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Figures in Flows 67
Figures in Flows
Figures within flows have some special features and behaviors to support this common 
usage. A flow is a sequence of figures connected by connectors such that the connector 
enters a figure, then exits it, enters another, exits that one, and so on. Flows commonly 
represent sequences of operations and hierarchies of relationships. For example, the 
following arrangements of figures and connectors are considered flows:

You do not need to identify a flow. The program will recognize these relationships and 
behave accordingly. For definition purposes, a figure is considered to belong to a flow 
if it has two attached connectors of the same style. Several features make it very easy 
to add a new figure at any point in a flow, remove a figure from a flow, or re-arrange 
the figures of a flow.

Creating a figure in a flow
During the normal process of adding a figure to a flow chart, you can insert it into an 
existing flow by dropping it on a connector.

To create a figure inserted within a flow
1. First verify that the “Snap figures to flow” option is enabled (see the 'Edit' options 

within the Tools Options screen).
2. Begin the creation of a figure in the usual way by choosing a figure style and 

entering in to create mode.
3. Move the figure cursor over an existing connector such that the center point of the 

figure marked by cross hairs is directly over the connector. When you are directly 
over the connector and there is room to insert the figure into the flow the portion 
of the connector beneath the figure cursor will disappear.
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68 Chapter 6: Figures
4. Click to create the figure. The connector will now enter and exit the new figure. 
You can also resize the figure before letting go of the button, just make sure there 
is still enough room to insert the figure.

If the connector is not vertical or horizontal you may need to disable the snap grid in 
order to position the cursor correctly over the connector.

While in create mode, pressing the CTRL key triggers freeform creation. With the 
CTRL key held down, the connector beneath the figure cursor will not be recognized 
and creating a figure will not insert it into the flow even if you click on a connector.

Before you can insert a figure into a flow you must make sure there is room available 
for the new figure. This may mean extending or re-arranging parts of your flow chart. 
For there to be enough room, there has to be ample room on a single segment so that 
no junctions that make up the connector are beneath the new location of the figure.

Attaching a figure to a flow
Another method for inserting a figure into a flow is to drag a figure from elsewhere in 
your flow chart into the flow.

To attach an existing figure to a flow
1. First verify that the “Snap figures into flows” option is enabled (see the 'Edit' 

options within the Tools Options screen).
2. Click on a single figure to begin dragging it (you may select it beforehand or drag 

it without selecting it).
3. Move the figure over an existing connector such that the center point of the figure 

marked by cross hairs is directly over the connector. When you are directly over 
the connector and there is room to insert the figure into the flow the portion of the 
connector beneath the figure cursor will disappear.

4. Drop the figure on the connector. The connector will now enter and exit the figure.
If the connector is not vertical or horizontal you may need to disable the snap grid in 
order to position the figure correctly over the connector.

While dragging, pressing the CTRL key keeps the drag freeform. This means that you 
can drop the figure anywhere, including on a connector, and the figure will not be 
inserted into any flow.

Before you can insert a figure into a flow you must make sure there is room available 
for the new figure. This may mean extending or re-arranging parts of your flow chart. 
For there to be enough room, there has to be ample room on a single segment so that 
no junctions that make up the connector are beneath the new location of the figure.
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Changing Figure Properties 69
Detaching a figure from a flow
Any figure that is in a flow (having two connectors of the same style) can be detached 
from the flow. When you detach a figure from a flow, it will be free to move around 
without the attached connectors. In addition the connectors will join to continue the 
flow without the detached figure.

To detach a figure from a flow
1. Right click on the figure and select Detach from Flow from the menu. 

Note that if the connector was vertical or horizontal, the connectors will merge into a 
single continuous segment. However, if they were not vertical or horizontal, a new 
junction will appear in place of the figure’s old position in the flow. You can delete this 
junction by right-clicking on it and selecting Delete Junction.

Deleting a figure from a flow
Whenever you delete a figure in the usual way, it will be automatically detached from 
its flow first. To delete the figure AND all attached connectors, select the connectors as 
well as the figure when deleting.

Changing Figure Properties
Each figure has a set of properties that define how it looks, what text it contains, how it 
behaves, and more. Most of the initial properties of a figure come from its original 
figure style. This section describes how to change the figure properties of an existing 
figure.

To view and modify the properties of a figure
1. Select the figure.
2. Choose Properties from the Figures menu or from the right mouse button menu.
or

1. Double click on the figure. Note, double clicking on a figure will edit the figure 
properties only if you have chosen Display/edit properties in the 'Edit' options 
within the Tools Options screen.

The Figure Properties dialog box will appear on the screen near the selected figure. 
This dialog box contains several different groupings of properties organized under tabs 
with an appropriate heading. To change to a different grouping of properties and their 
controls, press the corresponding tab. Controls located under each tab are described 
below.
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70 Chapter 6: Figures
Once you’ve set all of the properties of the figure that you want to change, press one of 
the following buttons:

Apply

Applies the property changes to the selected figure or figures without exiting the 
dialog box.

OK

Applies the property changes to the selected figure or figures and exits.

Cancel

Exits the dialog box and discards any changes you made since last pressing the Apply 
button. Once you apply changes, those changes remain in effect even if you press 
Cancel.

Changing properties for multiple figures
You can change a property, or any number of different properties, to a number of 
figures at the same time. To do so, select the figures and use the dialog box as usual. 
Only the properties you actually modify will be applied to the selected objects. For 
example, if you select five figures that all have different heights and widths, and you 
edit their properties and change only the Width field, all five figures will acquire the 
new width and retain their previous height.

NOTE: Several figure properties can also be changed simply by selecting the 
figure(s) and clicking on the buttons and controls on the property bar or 
under the Figure menu. These are simply shortcuts to the same changes in 
the Figure Properties dialog box.
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Changing Figure Properties 71
Figure Properties: General
Use the General tab in the Figure Properties dialog box to view and edit the basic 
properties of the selected figure such as its location, size, appearance, and color.

Based on style

To change the figure’s style, choose a new style from the combo box or the style drop 
menu located to the left. This will change the appearance of the figure and it will 
inherit all the properties from the new style you choose.

For example, use this control if you created a box and later determine that it should 
really be a circle.

Styles

This button is just a drop menu to choose a style graphically for the same purpose as 
Based on style described above.

Left

To change the position of the figure, enter a new location for the left-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the left edge of the page (positive measurements are to the right). 
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72 Chapter 6: Figures
Top

To change the position of the figure, enter a new location for the top-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the top edge of the page (positive measurements are downward).

Width

To change the width of the figure, enter a new width here.

Height

To change the height of the figure, enter a new height here.

Text color

To change the color of the figure’s text, choose a different color from the color 
selection drop menu. 

Border color

To change the color of the figure’s border, choose a different color from the color 
selection drop menu. 

Fill color

To change the color of the interior of the figure, choose a different color from the color 
selection drop menu. 

Bind to style

Check this box to choose whether or not a figure’s properties are bound to the style. If 
a figure’s properties are bound to its style, then anytime the style changes, the figure 
gets the new properties automatically. 

Border width

To change the thickness of the lines that make up the border (outline) of the figure, 
enter a new border width. You can also change the border width by pressing the up and 
down spin buttons to the right. Or you can choose one of the standard border widths by 
pressing the Width drop menu button itself.

Line Pattern

Select a line pattern for drawing borders such as solid, dashed, dotted, and so on. The 
line style is used to draw for the entire outline of the shape, not just the outside edges 
so consider carefully before using a pattern other than solid. Also note that some older 
shapes cannot use this property.

Drop Shadow

Check this box to add a drop shadow to the figure to give it a three-dimensional look. 
You control the size and color from within the Diagram Properties dialog box (see 
page 221).
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Changing Figure Properties 73
Select or change shape
The remainder of the controls in the General tab of the Figure Properties dialog box 
allow you to change the shape of the figure. 

Symbol from Gallery

Press this button to select a shape from the collection of built-in symbols contained in 
the Figure Symbol Gallery. 

Graphic from File

Press this button to select a graphic for the figure from an external graphics image file 
such as a Windows Metafile (.WMF or. EMF) or a Windows bitmap file (.BMP 
or.DIB). 

Graphic from Clipboard

Press this button to select a graphic for the figure from an image that is stored in the 
Windows clipboard. For example, you can create an image in Microsoft Paintbrush 
and do a Copy of it, then return to this program and paste it right into a figure.
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74 Chapter 6: Figures
Figure Properties: Text
Use the Text tab of the Figure Properties dialog box to view and edit the figure’s text 
and the properties of the figure that affect the display and format of the text.

Text box

This area shows a model of the shape of the figure. The dotted rectangles show the 
boundaries of the text region(s) in the figure. If the figure shape contains more than 
one text region, the arrows control which region is selected and marked by a dark gray 
dotted box.

Text

The text control to the right of the model displays the text that is contained in the 
figure in the selected text region. The text here can be edited using the usual Windows 
edit box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
figure itself. Furthermore, if you edit the text here, you will lose all embedded font 
controls. For example, if the text as a whole was not bold but you had bolded one 
word, then if you edit the text through this edit box, that bold word along with the rest 
of the text in the figure will revert back to the figure font attributes shown in this 
dialog box.
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Hidden

When checked, the selected text area is hidden and cannot be edited on-screen. Hiding 
text areas is useful when creating transparent shapes that have outlines but no fill. To 
make a shape completely transparent you need to use a null fill and make the text areas 
hidden, otherwise objects beneath the shape will not be selectable.

Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.

Text color

To change the color of the figure’s text, choose a different color from the color 
selection drop menu. 

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Margin

Select the internal text margin, the spacing between the text and the edges of the shape. 
Note that some shapes do not support fixed margins in which case their margins scale 
with the size of the shape.
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76 Chapter 6: Figures
Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. Controls in this dialog are self-
explanatory.
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Changing Figure Properties 77
Figure Properties: Connections
Use the Connections tab of the Figure Properties dialog box to view and edit the 
figure’s connection points and properties.

Connection points

This area shows the location of any connection points within the figure. One 
connection point is always selected and highlighted. You can use the mouse to drag 
and reposition connection points, select a different point. or right click to delete a 
connection point or add a new one. The arrow buttons cycle through the selected 
connection point. The Add button adds a new point, and the Delete button deletes the 
highlighted point.

Name or Description

Each connection point can have a name or description. Use this control to view and 
edit the name of the selected connection point.

Remove when not in use

When a connection point is added during the creation of a connector using the click 
point attach method, it is temporary by default and will remove itself when all attached 
connectors are deleted. Using this control, you can make such a connection point 
permanent.
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78 Chapter 6: Figures
Snap to center and edges

Check this box to have the mouse snap to the centers and edges of the figure while you 
drag a connection point with the mouse (in this dialog box).

Snap to grid

Check this box to have the mouse snap to the diagram grid while you drag a 
connection point with the mouse (in this dialog box).

Terminate connections to connection points at border

Check this box to cause connections to terminate at the border of the figure rather than 
extending all the way to the connection points. 

Enable standard center connect (terminated at border)

Check this box to enable connectors to attach at the center of the figure. This option is 
useful if you have a figure with connection points. You can choose to allow connectors 
to attach only at the connection points, or to the figure center also.
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Changing Figure Properties 79
Figure Properties: Behaviors
Use the Behaviors tab of Figure Properties dialog box to view and edit the properties 
that affect the way the figure behaves within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the figure. 
If set to Prevent, additional characters are not allowed. If set to Expand, the figure 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the figure 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the figure expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the figure. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a figure of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the figure automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.
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80 Chapter 6: Figures
Vertical expansion

This property controls in which direction the figure expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the figure. 

Horizontal center snaps to grid

Check this property to cause the figure’s horizontal center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for figures that are connected to other figures as it will aid in keeping them 
aligned horizontally.

Vertical center snaps to grid

Check this property to cause the figure’s vertical center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for figures that are connected to other figures as it will aid in keeping them 
aligned vertically.

Width snaps to grid

When this property is checked and the snap grid is enabled, the figure’s width remains 
an even multiple of the snap grid when you resize it. 

NOTE: When the height and width snap to the grid, both sides are aligned with snap 
grid lines which are not necessarily the same as the visible grid lines. In 
effect, the total width or height is always a multiple of twice the snap 
spacing. For example, if the snap spacing is one quarter of an inch and a 
node has the Width snaps to grid property, that figure width can be 1/2 in., 1 
in., 1 1/2 in. and so on, but it cannot be 3/4 in. 

Height snaps to grid

When this property is checked and the snap grid is enabled, the figure’s height remains 
an even multiple of the snap grid when you resize the node. 

Left and right edges snap to grid

When this property is checked and the snap grid is enabled, the figure’s left and right 
edges snap to the grid when you move, create, or resize the node. But not if you move 
or resize it along with a group of selected objects, or if you create it with its default 
size without intentionally resizing it.

If the figure’s width is not an even multiple of the snap grid and you drag the figure, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the figure. In this case, either edge (the one that is closest) is aligned to the 
grid. And if the center is closest to the grid and Horizontal center snaps to grid is also 
enabled, the figure can snap there as well. If the figure’s width is not an even multiple 
of the snap grid and you resize it by dragging a resize handle, only the edge that the 
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Changing Figure Properties 81
handle is on (the one you are dragging) aligns to the grid. To resize it so that both edges 
are aligned to the grid, resize it using both the left handle and the right handle.

This property and Horizontal center snaps to grid are mutually exclusive. Only one 
can be in effect. This property is most useful when Center stationary when resizing 
horizontally is disabled.

Top and bottom edges snap to grid

When this property is checked and the snap grid is enabled, the figure’s top and bottom 
edges snap to the grid when you move, create, or resize it. But not if you move or 
resize it along with a group of selected objects, or if you create it with its default size 
without intentionally resizing it.

If the figure’s height is not an even multiple of the snap grid and you drag the figure, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the figure. In this case, either edge (the one that is closest) is aligned to the 
grid. And if the center is closest to the grid and Vertical center snaps to grid is also 
enabled, the figure can snap there as well. If the figure’s height is not an even multiple 
of the snap grid and you resize it by dragging a resize handle, only the edge that the 
handle is on (the one you are dragging) aligns to the grid. To resize it so that both edges 
are aligned to the grid, resize it using both the top handle and the bottom handle.

This property and Vertical center snaps to grid are mutually exclusive. Only one can 
be in effect. This property is most useful when Center stationary when resizing 
vertically is disabled.

Center stationary when resizing horizontally

Check this property to cause the center of the figure to remain in the same place when 
you resize it horizontally by dragging the handles. 

This property is useful when figures are lined up vertically one on top of the other and 
potentially connected by a single connector from the horizontal center of one figure to 
the horizontal center of another above or below it. With this property, the figure will 
remain aligned with the others if it is resized horizontally. 

Center stationary when resizing vertically

Check this property to cause the center of the figure to remain in the same place when 
you resize it vertically by dragging the handles. 

This property is useful when figures are lined up horizontally one alongside the other 
and potentially connected by a single connector from the vertical center of one figure 
to the vertical center of another to its right or left. With this property, the figure will 
remain aligned with the others if it is resized vertically. 

Keep sized to text

When this property is checked, the figure is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a figure such that the figure has less 
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82 Chapter 6: Figures
text than it had before, the figure will automatically resize itself to shrink down around 
the new text as soon as you complete editing the text.

This property is primarily useful for labels. Used with non-labels, it can cause 
confusion.

Preserve aspect ratio

When this property is checked, the figure retains its current aspect ratio (its height 
compared to its width) when you resize the figure by dragging the corner handles or 
when the figure expands due to typing text. You can still change the aspect ratio of the 
figure by dragging the side handles, setting the size directly in the General tab, or 
using the From Selected button.

Automatic Text Scaling

When this property is checked, the figure text scales automatically when you resize the 
figure. Figures having this property always maintain a fixed aspect ratio (height vs. 
width) over-riding the Preserve Aspect Ratio property.

Do not print or export

When this property is checked, the object will not appear in print-outs or when the 
diagram is copied or exported. This property is useful for hiding objects that exist only 
for visual notation on the screen, and for implementing hyperlinks to other diagrams or 
documents.

Active container - keep contained objects together

When this property is checked, the figure serves as a container object that 
automatically keeps objects contained within its bounds together as a unit. Moving the 
container results in moving along the contents. Copying the container copies the 
contents. Deleting the container deletes the contents, and so on. Note, if the container 
is filled, only objects on top of the container are kept together. If it has no fill, all 
objects above or below are kept together.

This property is usually set along with others for the purpose of creating a container, a 
special type of figure that identifies a subset of your diagram.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 82 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Changing Figure Properties 83
Figure Properties: Fill
Use the Fill tab of the Figure Properties dialog box to view and edit the figure’s fill 
properties.

Linear gradient view.
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84 Chapter 6: Figures
Elliptical gradient view:

Fill method

Select the type of fill. The remainder of controls on this screen depend on which 
method is selected.

Color

A single color control is available when the fill method is 'Solid color'. Use this control 
to select the solid fill color.

From/To

The 'From' and 'To' color selection controls are available when the fill method is 
'Linear gradient' or 'Elliptical gradient'. Use these controls to select the start and end 
colors that are blended across the gradient.

Blend

The 'Blend' control is available when a gradient fill method is selected. Use this 
control to choose how the 'From' color is blended into the 'To' color across the 
gradient. Linear blend means simply that the 'From' color is blended uniformly into the 
'To' color. When 'Bell curve' is selected, the 'From' color blends into the 'From' color 
based on a normal distribution bell curve contributing to a natural 3D shading effect. 
When 'Platform' is selected, the gradient begins with the 'From' color, gradually
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Changing Figure Properties 85
blends to a color midway between 'To' and 'From', remains constant for a certain 
distance, and then blends to the 'To' color.

Angle

The 'Angle' control is available when the linear gradient fill method is selected. Use 
this control to select an angle for the blend. For cylindrical blends, angles of 180 or 
greater cause the swapping of the 'From' and 'To' colors.

Intensity

The 'Intensity' control is available when a gradient fill method is selected. Use this 
control to select how prominent the 'From' color appears in the blend. A value of 100 is 
most intense, while a value of zero makes the 'From' color undetectable. Intensity is 
most useful when used with a white or black 'From' color in order to achieve a gradient 
between two shades of the same color but without having to actually choose two 
shades of the color separately.

Center

The 'Center' control is available only with the linear gradient fill method. Use this 
control to position the midpoint of the gradient from 0 to 100. If the 'Blend' is set to 
'Platform' this control affects the size of center rather than the position.

X Offset, Y Offset

These controls are available only for the elliptical gradient fill method. Choose values 
from 0 to 100 to position the center of the elliptical gradient anywhere on the node. An 
off-center elliptical gradient produces a 3D appearance.

Spread

This control is available only for the elliptical gradient fill method. Choose a value 
from 0 to 100 to increase the size of the center region of the gradient.

Presets

Choose a preset fill as a shorthand for popular combinations of the above options. 
Presets combine all of the fill properties except for the 'To' color which is 
independently controllable.
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86 Chapter 6: Figures
Figure Properties: Tabs
Use the Tabs tab of the Figure Properties dialog box to view and edit the figure’s tab 
stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.
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Changing Figure Properties 87
Clear

Click to remove the highlighted tab stop from the tab stop list.

Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a figure must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.
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88 Chapter 6: Figures
Figure Properties: Memo
Use the Memo tab of the Figure Properties dialog box to view and edit the figure’s 
memo text. Memo text contains any information you would like to attach to the figure. 
It is displayed in a text balloon (tooltip) when you hover the mouse over the figure 
while in select mode.

Memo Text

Enter the memo text. It can contain line breaks, but not formatting such as bold, 
underlines, italics, or different fonts or type sizes.
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89
CHAPTER

7 Connectors

Connectors identify relationships between figures. A typical connector is a line between 
two figures. Each end of a connector can have a symbol or geometric shape (commonly an 
arrowhead). A connector can have multiple straight segments that bend and turn corners, 
and each segment can have an attached label. Connectors can be straight, curved, 
smoothed, arced, or they can have rounded corners. They can be solid lines, or broken lines 
of a number of possible patterns and thicknesses.

A connector has a number of attributes or properties. Like figures, connectors have stylistic 
properties such as color and thickness. The initial properties of a connector come from the 
connector style used to create it.

About connectors...

Any two figures can be connected by a single connector. 
A single figure may have any number of connectors to other figures.
Connectors remain attached to the figures they connect, even when those figures move. 
A connector need not be connected to a figure at either end.

This chapter covers the properties, behaviors, and features that are unique to connectors. 
There are also many operations not covered in this chapter that can affect connectors as 
well as other types of objects (see  CHAPTER 3: General Editing,  page 27). 

FIGURE 1 

FIGURE 2 

A connector connects 
two figures 
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90 Chapter 7: Connectors
Choosing an Attach Method
The attach method controls how connectors connect to figures when you click on the 
figure in connect mode. Select an attach method from the Connectors menu. The 
attach method applies only when you are creating a connector. Once it is created, 
changing the method does not affect whether it remains attached or where it attaches. 
The following attach methods are available:

Freeform (no attach)

With this attach method objects are ignored. The connector begins where you first 
click the mouse and terminates where you double-click, not becoming attached at 
either end. This method is helpful for free drawing such as adding an arrow 
pointing from one part of a diagram to another rather than from one figure to 
another. You will want to set this attach mode only when you are doing a lot of 
freeform connections. Normally, you can use the CTRL key to temporarily switch 
to freeform.

Centers

With this attach method, connectors attach to the centers of figures. The connector 
extends from the center of the first figure that you click on, to the center of the 
second figure you click on. Even though the connectors are attached to the center, 
they still terminate at the border of the figure for drawing purposes. When using 
this attach method, the CTRL key temporarily switches to freeform.

Click Point

With this attach method, connectors attach to figures at the point where you click. 
A temporary connection point appears where you click. (However, “Use 
Connection Points” does not need to be enabled.) When clicking on a figure to 
initiate or terminate a connector, a form of snap gravity is used to snap to the 
center, the horizontal and vertical axes, and the edges. If the snap grid is enabled, 
click points can only occur on the grid or at a gravity point. When using this attach 
method, the SHIFT key temporarily switches to the Centers attach method 
described above.

Use Connection Points

This option affects how connectors attach to figures independent of the attach 
method. Figures can have connection points either in their original definition or 
ones that you add. When this option is enabled, connection points are visible and 
enabled with any of the attach methods other than freeform (which doesn’t attach 
anything). 

NOTE: For most diagramming, Centers attach mode combined with occasional use 
of CTRL is the most useful.
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92 Chapter 7: Connectors
Creating Connectors
The most common way to add a connector to your flow chart is to choose a connector 
style that represents the shape and initial properties of the connector object you are 
creating. This moves you into connect mode where you attach the connector to figures 
in your flow chart.

There are several methods for choosing a connector style. All are located in the 
Connectors area of the style bar. The Connectors style bar area contains three types of 
controls, all of which select a connector style in a different way.

To choose a connector style and initiate connect mode
Perform one of the following:

1. Click on the button in the style bar that represents the connector. If the style you 
want does not have a button, use one of the following methods instead.

or

2. Press and hold the Connectors button in the style bar to activate the connector 
style drop menu. Move to the representation of the style, and release the mouse 
button. Not all styles are displayed in this menu so you may have to choose the 
three dots to see all of them (see the next section).

or

3. Choose the connector style by name from the combo box directly below the 
Connectors button.The combo box always contains all styles defined in the 
diagram.

Connector style drop menu 
Connector style combo box 
Connector bar buttons 
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Creating Connectors 93
Method 4: Choosing a connector style from the complete list of styles
To view all connector styles with names, pictures, and descriptions and to choose 
which styles appear on buttons and in drop menus, select the ellipsis (three dots) from 
the Connectors drop menu to open the Choose a Connector Style dialog box.

To choose a connector style
Scroll to preview all of the available styles and click on the style to select it. Then press 
OK or double-click on the style.

Category

Use this combo box to show all styles or only styles of a certain category.

Edit

While you’re here you may want to add, change, or delete styles from your diagram. 
This button just provides a convenient shortcut to the Styles dialog box. Also available 
by right-clicking any style in the list.
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94 Chapter 7: Connectors
Menu

Check or uncheck this button for each style to control whether the drop menu contains 
a representation of the particular style. Also available by right-clicking any style in the 
list.

Button

Check or uncheck this button for each style to control whether the style is represented 
by a button in the style bar. Reserve buttons only for your most common styles. Also 
available by right-clicking any style in the list.

NOTE: Notice that this screen is resizable. If it is too narrow and cannot include the 
Edit, Button, and Menu controls, they remain available by right-clicking on 
a style.

Once you have selected the connector style to create...
The connect cursor indicates you are in connect mode.

Though will be normally skip ahead to the step below, this is a point where you may 
choose to deviate from the connector style you chose. In connect mode (after selecting 
the connector style) you can use the property bar to change properties of the 
connectors that you are about to create. For example, you may want this particular 
connector to be red. You can select red as the connector color using the connector color 
property bar button. The connector that you next create will be red. Changes at this 
point do not affect the style definition, only the properties of the new connectors.

To connect two figures with a connector
1. Enter connect mode by choosing a connector style from the style bar.
2. Move the connect cursor over a figure. The cursor changes from white arrow to 

black indicating that you are about to connect to a figure.
3. Press the mouse button. You can either release the mouse button immediately or 

keep it pressed until step five.
4. Move the mouse until it is over the second figure. The cursor color (white or 

black) indicates whether you are over the second figure.
5. Click the mouse button again (or release it for the first time). A connector of the 

style you chose now connects the two figures.

NOTE: To create only orthogonal connectors composed of lines that are all vertical 
or horizontal only, hold down the ALT key while creating the connections.
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Segmented Connectors and Junctions 95
To create an unattached connector
1. While in connect mode, move the mouse cursor to a position NOT over a figure. 

(If you select Freeform attach mode, it doesn’t matter whether you are over a 
figure or not.) The white connect cursor indicates that you are not over a 
figure.

2. Press the mouse button. You can either release the mouse button immediately or 
keep it pressed until step four.

3. Move the mouse to the point at which you want the other end to terminate (not 
over a figure).

4. Double click the mouse to force the end of the connector.
When you are creating a connector, you also have the option of attaching either end of 
the connector to the middle of a previously existing connector.

To connect to another connector
Create the connector as described above but click either end on an existing connector. 
The previous connector is split in two and a junction is created with the new connector.

Segmented Connectors and Junctions
A connector can be more than a simple straight line. It can have multiple straight 
segments that meet at junctions where the connector can turn and bend along its path.

To create a multi-segment connector
Create a connector by any of the methods described in the previous section. Instead of 
clicking the end in a figure or connector, click it where it is not above another object 
(do not double click or the connector will terminate.) A junction appears and a new 
segment of the connector forms. Add up to fifty segments this way. Finally, click on a 
figure or double click while not on a figure to terminate the connector.

A connector with three segments and two junctions. 

Fig. 1 Fig. 2 

junctions 
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96 Chapter 7: Connectors
NOTE: Arced connectors are special because they are normally composed of a 
single segment with a control point that defines the path of the arc. When 
creating an arc, you can click to position the control point as if you were 
defining a junction of a segmented connectors. However, the control point 
that you define in this manner is not actually a junction and you cannot click 
multiple times to add more control points. If necessary you can manually 
create arced connectors with more than one segment, but to do so you need 
to first create different type of segmented connector (such as straight), then 
change it to arced and adjust each segment manually.

To select a multi-segment connector
Select a multi-segment connector just like any other object (see  Selecting and 
Deselecting Objects on page 27). If you select any segment of a connector or any 
junction of a connector, the entire connector (all segments) becomes selected. 
However, all junctions do not necessarily become selected. 

The following diagram shows a multi-segment connector that has been selected by 
clicking on the left-most junction. Notice that the entire connector is selected. Also 
notice that the left junction is selected but not the one on the right. Selected junctions 
are indicated by four corners of a small red box.

If we were to choose Cut or Delete after selecting the above connector as shown, the 
entire connector above would be deleted including all segments and all junctions (not 
only those that are selected).

You can always re-arrange the connector by dragging any of its handles. If however, 
you drag a selected junction, all selected junctions and figures move together. The 
following diagram shows what happens when you select the left junction and the left 
figure then drag either.

A connector that has been selected by clicking on the left junction. 

Fig. 1 Fig. 2 

selected
junction 

the entire connector (all segments) 
is selected 

The effect of dragging a selected junction plus a selected figure 

Fig. 1 Fig. 2 

Fig. 1 

Fig. 2 
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Curved Connectors 97
Curved Connectors
The previous section described how you can create connectors that have multiple 
straight segments that can be created to wind around a diagram from one figure to 
another. Multiple-segment connectors can also be curved. Curved connectors can be of 
three types: simple curved, smoothed, rounded, or arced. Each is illustrated below: 

Arcs are special because they typically have only a single segment and they are 
defined by a control point drawn as an open circle rather than by a series of junctions. 
All other curved connectors require at least one junction. If no junctions are included 
to define the path of a curve, the path reduces to a straight line. The different kinds of 
curved connectors and their relation to the junction points are described below.

Curved
Curved connectors are simply connectors that follow a curve starting at one end and 
always curving toward the next junction point but not passing through it. The curve is 
similar to a bezier curve or a b-spline, but it is actually much simplified in a way that 
the relation to the curve’s path is intuitive from the position of the intermediate 
junction points.

Fig. 1 

Fig. 2

Curved Smoothed 

Fig. 1 

Fig. 2 

Fig. 1 

Fig. 2 

(path winds toward junctions) (path passes through junctions) 

Rounded 
(corners rounded at junctions) 

Fig. 1 

Fig. 2 

Arced 
(circular arc through control point) 
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98 Chapter 7: Connectors
Smoothed
Smoothed connectors get the name from the fact that the path of the curve is actually a 
smoothing operation performed on the polyline defined by the intermediate junction 
points. Therefore the resulting path of a smoothed connector is a line that curves 
smoothly through each of it’s junction points on the way to the next. A smoothed curve 
is the most intuitive way to define the path of a curved line from a small number of 
intermediate points.

Rounded
A rounded connector is simply one in which the corners created by the intermediate 
junction points form rounded arcs from one line segment or the next. The radius of the 
arc is a property of the diagram and can be set differently for each diagram through the 
Diagram Properties dialog box.

Arc
An arc connector follows a circular arc through a control point from one endpoint to 
another. Unlike for all other curved connectors, the control point is not a junction.

There are several ways to create a curved connector of any of the types described 
above.

To create a curved connector
1. Use an existing path style that has the desired curvature characteristic to create a 

connector with at least one junction point (vertex). This presumes that you have 
already created a curved connector style or are using a template that contains such 
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Curved Connectors 99
a style. In the case of an arc, click to define the control point just as you would to 
define the first junction of a connector of another type.

or

2. While in connect mode to create a connector, use the menu or the toolbar button to 
alter the curvature of the connector that you are in the process of creating.

or

3. Select the connector and use the menu, the toolbar drop menu, or the Connector 
Properties dialog box to change the curvature.
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100 Chapter 7: Connectors
Splitting Connectors
You can split a single-segment connector into a multi-segment connector and create a 
junction in the process.

To split a connector (method one)

1. While pressing and holding the ALT key, move the mouse over the connector at the 
point you want it split.

2. While still holding the ALT key, press the mouse button. A new junction appears 
where the mouse points. Before releasing the mouse button you can move the new 
junction.

3. Release the mouse button.

To split a connector (method two)
1. You can also split a connector (create a new junction) by right-clicking on the 

connector at the position where you want the split to occur and choosing the Add 
Junction Here command from the menu.

2. Reposition the junction as needed.

Deleting Connector Junctions
In addition to splitting connectors into multiple segments, you can also rejoin 
segments of a connector by deleting junctions. The following diagram shows how this 
is done.

Fig. 1 

Fig. 2 

Fig. 1 

Fig. 2 

Before splitting the connector After splitting the connector and dragging 

Before deleting the selected junction 

Fig. 1 Fig. 2 Fig. 1 Fig. 2 

After deleting the junction 

This junction is being deleted 
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Moving the Ends of Connectors 101
In the above example, if you were to delete both junctions, you would end up with a 
simple arrow connecting directly from figure one to figure two.

To remove a segment of a connector
1. Right-click on a junction and choose the Delete Junction command from the right 

click menu.
OR

1. Select the junction that connects the two segments.
2. Choose Delete Junctions from the Edit menu.
When you delete a junction, two segments join to become one. Either or both of these 
segments could have an attached connector label. If just one of the segments has a 
connector label, the label moves to the final segment. If both original segments have 
attached connector labels, one moves to the final segment, the other is deleted.

Moving the Ends of Connectors
You can move either of the endpoints of a connector. If the endpoint is connected to a 
figure, you can detach it from the figure, or attach it to a different figure. 

To move one end of a connector
1. Select the connector. Red handles appear at both endpoints of the connector and at 

each junction if the connector has more than one segment.
2. Move the mouse cursor over one of the handles at the end of the connector. The 

resize cursor appears.
3. Press the mouse button and hold it.
4. Move the end of the connector.
5. Release the mouse button.
A connector end can be separated from a junction of three or more connectors in this 
way by selecting only the one connector and dragging its endpoint. However, a 
connector segment cannot be divided at a junction of only two. In that case it not 
possible to select only one of the two - they are treated as one continuous connector. To 
divide or cut a connector anywhere along its length (see  Snipping Connectors on page 
102).

When dragging a connector endpoint, you can drop it anywhere you like. If you drop it 
onto another object indicated by a small plus sign in the mouse cursor, it will attach to 
that object. As when creating a new connector, when you drop it onto another 
connector, it will attach at a new junction. If you drop it onto the endpoint of another 
connector, the two will combine into one.
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102 Chapter 7: Connectors
Snipping Connectors
You can snip a connector in two at any point along its length with the Snip Connector 
feature. Snipping a connector is like cutting a string with a scissors. Each half of the 
connector can then be moved independently.

To snip a connector
1. Right click on the connector at any point along its length, even at a junction of two 

segments.
2. Select Snip Connectors from the right click menu.
You can reverse this operation with Undo or by simply dragging one of the new free 
endpoints back over the other.

Flipping Connectors
You can flip connectors so that the ends swap with one another. Flipping works for 
both simple connectors and multi-segment connectors.

To flip one or more connectors
1. Select one or more connectors to flip.
2. Choose Flip from the Connectors menu.

Fig. 1 

Fig. 2 

Fig. 1 

Fig. 2 

After flipping the connector Before flipping the connector 
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Jogs 103
Jogs
Jogs are small loops drawn when two connectors intersect visually but are otherwise 
unrelated. The jog helps to make it clear that the two connectors are independent and 
that one simply crosses the other without any kind of interaction. 

Jogs can be enabled and their size can be adjusted from the Connectors tab of the 
Diagram Properties dialog box. 

Other notes about jogs:

The loop is always drawn on the top or right of the connector regardless of the 
direction of the connector. 
Jogs on one connector must be separated by enough distance to permit some 
spacing between each jog. If a connector overlaps multiple other connectors that 
are spaced too closely together, some jogs may be omitted.

Orthogonal Connectors
Orthogonal connectors contain only horizontal and vertical lines and right angles. 

Jogs on vertical and horizontal connectors

Orthogonal connectors Non-orthogonal connectors 
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104 Chapter 7: Connectors
In some types of diagrams including flow charts, orthogonal connectors are preferred 
and tend to appear much neater than non-orthogonal connectors. There are several 
features that help you create and maintain orthogonal connectors.

One way to assure orthogonal connectors is to make sure that all figures being 
connected are aligned properly, particularly so that their centers are directly in line. 
The figure alignment commands (see  Aligning Figures on page 57) can help you align 
existing figures in this way. 

The snap grid is another tool that is useful for keeping figures aligned. When you have 
a snap grid enabled and you use figure properties that keep the figure center aligned to 
the grid when moved or resized, it is relatively easy to keep your connectors 
orthogonal.

However, in any diagram, not all figures that you connect can be aligned and not all 
connectors are simply a straight line connecting two figures. Therefore, some 
additional connector properties are also required to help create and maintain 
orthogonal connections.

One aid is to hold down the ALT key while creating connections. Doing so will force 
all of the lines you create to be orthogonal when they are created.

There is also a related connector property. The orthogonal property of a connector has 
two possible conditions, manual, and guided. This property can be viewed and 
modified from the General tab in the Connector Properties and Connector Styles 
dialog boxes.

Manual
The manual option simply means that no assistance is provided by the connector 
properties to keep the connector orthogonal. Other then the effects of the snap grid if it 
is enabled, the connector will go exactly where you click. This is useful when 
orthogonal connectors are not important and when you want very precise control over 
the placement of connector junctions.

Guided
The guided option is the most generally useful. It helps you create orthogonal 
connectors when you want but does not limit you to only orthogonal connections. With 
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Flow Symbols 105
this option, the connectors snap to a straight angle when they are nearly straight. This 
behavior is independent of the snap grid. It works even if the snap grid is disabled and 
it overrides the snap grid if the snap grid is enabled. 

One stipulation with guided connectors is that the guiding only occurs when you are 
creating the connector. This is sufficient because there is a universal rule that favors 
straight connectors when you move a junction and the snap grid is enabled. Also notice 
that the guided property has no effect unless the connector point is nearly straight with 
regard to the previous point. Therefore it does not prevent you from creating a diagonal 
segment when you choose. This discretion is what makes this option ideal for most 
every connector.

Flow Symbols
Flow symbols are small shapes that are drawn along the path of a connector at a fixed 
spacing either in addition to a line or in place of a line. You can configure flow 
symbols through the Line tab in the Connector Properties and Connector Styles dialog 
boxes.

Guided connector Non-guided connector 

A B 

C 
D 

A B 

C 
D 

Effect of the guided connector property when you connect two 
figures by clicking at A, B, C, and then D (no snap grid). 

Examples of flow symbols on a connector. 
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106 Chapter 7: Connectors
Changing Connector Properties
Each connector has a set of properties that define how it looks and behaves. Most of 
the initial properties of a connector come from its original connector style. This section 
describes how to change the properties of an existing connector.

To view and modify the properties of a connector
1. Select the connector.
2. Choose Properties from the Connectors menu or from the right mouse button 

menu. (or double click on the connector.) 

The Connector Properties dialog box will appear on the screen near the selected 
connector. This dialog box contains several different groupings of properties organized 
under tabs with an appropriate heading. To change to a different grouping of properties 
and their controls, press the corresponding tab. Controls located under each tab are 
described below.

Once you’ve set all of the properties of the connector that you want to change, press 
one of the following buttons:

Apply

Applies the property changes to the selected connector or connectors without exiting 
the dialog box.

OK

Applies the property changes to the selected connector or connectors and exits.

Cancel

Exits the dialog box and discards any changes you made since last pressing Apply. 
Once you apply changes, those changes remain in effect even if you press Cancel.

Changing properties for multiple connectors
You can change any number of different properties to a number of connectors at the 
same time. To do so, select the connectors and use the dialog box as usual. Only the 
properties you actually modify will be applied to the selected objects. For example, if 
you select five connectors that all have different colors and widths, and you edit their 
properties and change only the color not touching the width, all the figures will acquire 
the new color and retain their previous width.

NOTE: Several properties can also be changed by selecting the connector(s) and 
clicking on the buttons and controls on the property bar or the Connectors 
menu. These are simply shortcuts to the same changes in the connector 
properties dialog box.
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Changing Connector Properties 107
Connector Properties: General
Use the General tab of the Connector Properties dialog box to view and edit the style 
that the connector is based on and some other general properties.

Based on style

To change the connector’s style, choose a new style from the combo box or the style 
drop menu located to the left. This will change the appearance of the connector and it 
will inherit all the properties from the new style you choose.

Styles

This button is a drop menu for the same purpose as Based on style described above.

Bind to style

Check this box to choose whether or not a connector’s properties are bound to the 
style. If a connector’s properties are bound to its style, then anytime the style 
properties change, the connector gets the new properties automatically. 

Orthogonal

This property can provide some assistance in creating and keeping connectors 
orthogonal (all lines vertical or horizontal). Guided provides adequate help for most 
cases. 
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108 Chapter 7: Connectors
Connector Properties: Line
Use the Line tab of the Connector Properties dialog box to view and edit the 
appearance of the line that is drawn along the connector’s path.

Line

A connector line can be one of many line styles such as solid, dashed, dotted, and so 
on. To change the connector’s line style, choose a new line style from the drop menu.

Color

To change the color of the connector, choose a different color from the color selection 
drop menu. 

Width

To change the line width of the connector, enter a width or use the up and down spin 
buttons. You can also choose a standard width by clicking on the drop menu.

Curvature

Select one of the curvature options for the connector. The path of the connector can be 
straight, curved. smoothed, rounded, or arced (see  Curved Connectors on page 97).

Corners

Choose a corner style (also known as a line join style). These options apply to the way 
that thick straight connectors appear when two segments meet. Note that corners will 
appear rounded when imported into other documents.
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Changing Connector Properties 109
Flow symbols along line

Check this box to enable flow symbols to be drawn along the path of the connector.

Kind

Choose the kind of flow symbol from the flow symbol drop menu.

Fill color

Choose a fill color for the flow symbols. 

Border color

Choose a border color for the flow symbols.

Size

Choose the size for the flow symbols.

Spacing

Choose the spacing interval between flow symbols.

Border width

Choose the line width of the borders of the flow symbols.
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110 Chapter 7: Connectors
Connector Properties: Ends
Use the Ends tab of the Connector Properties dialog box to view and edit the 
appearance of the symbols that are drawn at the ends of the connector (such as 
arrowheads).

End 1

To change the originating end of the connector, choose a color, size, and end symbol.

Symbol

Select an end symbol shape from the end symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the End Symbol Gallery.
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Changing Connector Properties 111
Fill color

Choose a fill color for this end symbol.

Symbol size

Choose a size for this end symbol.

End 2

To change the terminating end of the connector, choose a color, size, and end symbol.

Symbol

Select an end symbol shape from the end symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the End Symbol Gallery.

Fill color

Choose a fill color for this end symbol.

Symbol size

Choose a size for this end symbol.

Borders

To change the width of the borders around the connector ends, enter a border width or 
use the up and down spin buttons.
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112 Chapter 7: Connectors
Connector Properties: Behaviors
Use the Behaviors tab of the Connector Properties dialog box to view and edit the 
properties that affect the way the connector behaves within your diagram.

Do not treat as a flow (no drop-ins)

When checked, “flow” properties will be disabled for this connector. For example, you 
will not be able to drop a new or existing figure into the flow of the connector, 
automatically connecting the figure in-line with the connector. This behavior only has 
meaning if the “Snap figures into flows” option is enabled in the Snap Labels section 
under Edit in the Tools Options screen. This property is useful when a connector is 
used as a simple line rather than for connecting figures.

No crossovers (jogs)

When checked, this connector will not use jogs when crossing over other connectors, 
nor will other connectors use jogs when crossing over this connector. This behavior 
only has meaning if jogs are enabled in the diagram properties (see Diagram Properties 
Paths). This property is useful when a connector is used as a simple line rather than for 
connecting figures.

Do not print or export

Self-explanatory.
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113
CHAPTER

8 Labels

Labels are words, phrases, sentences, and paragraphs that you can position anywhere in 
your flow chart. Use labels for titles, notes, descriptions, and to label elements of your flow 
chart. 

A label consists of text and a set of properties such as justification, font, and color. The 
initial properties of a label come from the label style you use to create it.

This chapter covers the properties, behaviors, and features that are unique to labels. There 
are also many operations not covered in this chapter that can affect labels as well as other 
types of objects (see  CHAPTER 3: General Editing,  page 27). 

Types of Labels
There are several types of labels, each with different uses and properties. In addition to 
standard labels, there are specialty labels that retain an attachment to various objects within 
a flow chart 

ok

data

Sample

Figure
Text

Figure
Text

ok
data

Sample

Figure
Text

Figure
Text

A sample portion of a flow chart 
showing different types of labels.

Label movements after the lower box is moved 
to the right. Notice that the standard label is 
unaffected and the specialty labels each move 
to remain near an associated object.

Connector Label

Flow Label

Standard
Label

box 1

box 2

Figure
Labels

box 1

box 2
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114 Chapter 8: Labels
Standard Labels

A standard label is simply text added to a flow chart that is not associated with any 
particular object in the diagram. Standard labels are useful for adding titles, headings, 
and explanations. They add meaning to the diagram or describe a portion of the flow 
chart. Standard labels do not adjust to movements of any other parts of the diagram.

Connector Labels

A connector label labels a connector that connects (usually) one figure to another. A 
connector label is drawn either in-line within the connector, or laterally alongside the 
connector. As the connector is adjusted, the connector label moves along to remain 
within the connector.

Figure Labels

A figure label labels a particular figure and is attached to the figure. When the figure 
moves, all attached figure labels move with it and retain their positions relative to the 
figure. Figure labels are useful for adding notes or comments about a figure. They are 
also useful for figures that cannot contain internal figure text, such as glyphs, icons, or 
imported graphics.

Flow Labels

A flow label labels a flow point, the point at which a connector meets a figure. When 
either the figure or the attached connector moves in any way, the flow label adjusts its 
position to remain near the final location of the flow point. Flow labels are useful for 
labeling connector endpoints in class diagrams. 

All label types are similar and can be manipulated in similar ways. But there are also 
some special properties and behaviors of each of the specialty labels. There are also 
some features to enable the most convenient usage of these labels in their intended 
ways.

The following section describes features common to labels of all types. It covers 
common methods for creating and destroying labels, editing their appearance and 
position, and changing their properties. Later sections describe features and 
characteristics unique to each type of label.

Working with Labels
The following apply to ALL kinds of labels.

Creating Labels
Specialty labels can be created in other ways as well, but any kind of label can be 
created by entering text mode, clicking on the origin point in your diagram, and typing 
the label text, followed by ESC when done.
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Working with Labels 115
Specialty labels can be created in other ways as well, but any kind of label can be 
created by entering text mode, clicking on the origin point in your diagram, and typing 
the label text, followed by ESC when done.

To initiate creation of a label of a defined style
Choose a label style to provide the initial properties of the label, then use that style to 
create a label on the diagram. Locate the “Labels” section of the style bar:

Perform one of the following:

1. Press and hold the Labels button in the style bar to activate the label style drop 
menu. Move to the representation of the style, and release the mouse button. Not 
all styles are displayed in this menu so you may have to choose the three dots to 
see all of them (see below).

or

2. Choose the label style by name from the label style combo box.
or

3. If the label has a style bar button, click that button.

Choosing a label style from the complete list of styles
Another method is available to select a label style. This method contains all of the 
styles with complete names, pictures, and descriptions and lets you choose which 
styles appear on buttons and in drop menus.

Label style drop menu 
Label style combo box 
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116 Chapter 8: Labels
Select the ellipsis (three dots) from the Labels drop menu to open the Choose a Label 
Style dialog box.

To choose a label style
1. Scroll to preview all of the available styles.
2. Click on the style to select it.
3. Press OK. Alternately, double-click on the style. 

Edit / Add / Remove Styles

This button provides a convenient shortcut to the Define Label Styles dialog box just 
like choosing Styles from the Labels menu.

Menu

Check or uncheck this button for each style to control whether the Labels drop menu 
contains a representation of the particular style.

Button

Check or uncheck this button for each style to control whether the style is represented 
by a button in the style bar. Buttons are not usually a good idea for label styles.
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Working with Labels 117
To initiate creation of a label without a defined style
There is no requirement that you go through the steps described above (choosing a 
label style) just to create a simple text label. If you don’t care to use a defined style for 
the label, just click on the text mode button.

Clicking the text mode button places you in text mode without selecting any particular 
label style. The font properties and text color will reflect the last properties you used in 
text mode. 

Once you have entered text mode
Now that you are in text mode, the text mode button will appear depressed and the 
cursor will appear as a caret .

In text mode you can use the property bar to change properties of the label that will be 
created such as the color, font, text size, and justification. If you started by selecting a 
label style, any such change will cancel the label style.

To create a label
1. Use the mouse to position the new label. The text cursor points to the position 

where the bottom left corner of the label will be located (for a left-justified label).
2. Click the mouse button.
3. Type the label text. 
4. When you are done adding or changing the text, you can either press ESC to save 

your changes and remain in text mode, press the right mouse button to save your 
changes and return to select mode, or simply click on the flow chart to create 
another label.

To create a label (automatic method)
1. From text mode or select mode or seltext mode... 
2. Point the mouse at the location where you want to place the label.
3. Start typing text on the keyboard. A label is created automatically containing the 

text you type.

Deleting Labels
Deleting labels is similar to deleting figures or any other object in your diagram.

To delete a label (standard method)
1. Select the label.
2. Choose Delete from the Edit menu, or press the DEL key.
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118 Chapter 8: Labels
To delete a label (automatic method)
1. Edit the text in the label, and delete all the text.
2. Labels that contain no text are deleted automatically.

Moving Labels
Moving labels is just like moving any other objects in your flow chart. However, 
special considerations occur for specialty labels. See the later sections of this chapter 
regarding each of the specialty label types.

Changing Label Properties
Each label has a set of properties that define how it looks, what text it contains, how it 
behaves, and more. Most of the initial properties of a label come from its original label 
style. This section describes how to change the label properties of an existing label.

To view and modify the properties of a label
1. Select the label.
2. Choose Properties from the Labels menu or from the right mouse button menu.
or

1. Double click on the label. Note, double clicking on a label will edit the label 
properties only if you have chosen Display/edit properties in the 'Edit' options 
within the Tools Options screen.

The Label Properties dialog box will appear on the screen near the selected label. This 
dialog box contains several different groupings of properties organized under tabs with 
an appropriate heading. To change to a different grouping of properties and their 
controls, press the corresponding tab. Controls located under each tab are described 
below.

Once you’ve set all of the properties of the label that you want to change, press one of 
the following buttons:

Apply

Applies the property changes to the selected labels without exiting the dialog box.

OK

Applies the property changes to the selected label or labels and exits the dialog box.

Cancel

Exits the dialog box and discards any changes you made since last pressing the Apply 
button. Once you apply changes, those changes remain in effect even if you press 
Cancel.
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Working with Labels 119
Changing properties for multiple labels
You can use the Label Properties dialog box to change a property, or any number of 
different properties, to a number of labels at the same time. To do so, select the labels 
and use the Label Properties dialog box as usual. Only the properties you actually 
modify will be applied to the selected objects. For example, if you select five label that 
all have different heights and widths, and you edit their properties and change only the 
Width field not touching the Height field, all five label will acquire the new width and 
retain their previous height.

NOTE: Several label properties can also be changed simply by selecting the label(s) 
and clicking on the buttons and controls on the property bar. These are 
simply shortcuts to the same changes in the label properties dialog box.

Label Properties: General
Use the General tab of the Label Properties dialog box to view and edit the basic 
properties of the selected label such as its location, size, appearance, and color.
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120 Chapter 8: Labels
Based on style

To change the label’s style, choose a new style from the combo box or the Styles drop 
menu located to the left. This will change the appearance of the label and it will inherit 
all the properties from the new style you choose.

Styles

This is a drop menu for choosing a style for the same purpose as Based on style.

Left

To change the position of the label, enter a new location for the left-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the left edge of the page (positive measurements are to the right). 

Top

To change the position of the label, enter a new location for the top-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the top edge of the page (positive measurements are downward).

Width

To change the width of the label, enter a new width here.

Height

To change the height of the label, enter a new height here.

Text color

To change the color of the label’s text, choose a different color from the color selection 
drop menu. Use of this drop menu is described elsewhere (see page 39). If you select a 
color that cannot be drawn solid, Windows draws the text in the nearest solid color.

Bind to style

Check this box to choose whether or not a label’s properties are bound to the style. If a 
label’s properties are bound to its style, then anytime the style properties change, the 
label gets the new properties automatically.
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Working with Labels 121
Label Properties: Text
Use the Text tab of the Label Properties dialog box to view and edit the label’s text and 
the properties of the label that affect the display and format of the text.

Text

The text control to the right of the model displays the text that is contained in the label 
in the selected text region. The text here can be edited using the usual Windows edit 
box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
label itself. Furthermore, if you edit the text here, you will lose all embedded font 
controls. 

With rotated labels (those whose lettering is top-to-bottom or bottom-to-top instead of 
left-to-right), you will not be able to edit the text directly on screen. Therefore, this will 
be the primary way to edit the text. Because doing so removes embedded font controls, 
for example a single word within the label that is bold or underlined, it is less 
convenient to have rotated text with mixed font attributes. However, it can still be 
done. Just rotate the label back to normal (left-to-right), edit the text attributes on 
screen rather than with this edit box, and rotate the label back.
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122 Chapter 8: Labels
Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.

Text color

To change the color of the label’s text, choose a different color from the color selection 
drop menu. Use of this drop menu is described elsewhere (see page 39). If you select a 
color that cannot be drawn solid, Windows draws the text in the nearest solid color.

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. This method also allows you to 
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Working with Labels 123
preview a sample of the font as you select it Controls in this dialog are self-
explanatory.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide

Page 123 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



124 Chapter 8: Labels
Label Properties: Behaviors
Use the Behaviors tab of the Label Properties dialog box to view and edit the 
properties that affect the way the label behaves within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the label. 
If set to Prevent, additional characters are not allowed. If set to Expand, the label 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the label 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the label expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the label. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a label of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the label automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.
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Working with Labels 125
Vertical expansion

This property controls in which direction the label expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the label. 

Horizontal center snaps to grid

It is generally best to disable this property for labels.

Vertical center snaps to grid

It is generally best to disable this property for labels.

Width snaps to grid

It is generally best to disable this property for labels.

Height snaps to grid

It is generally best to disable this property for labels.

Left and right edges snap to grid

It is generally best to disable this property for labels.

Top and bottom edges snap to grid

It is generally best to disable this property for labels.

Center stationary when resizing horizontally

Check this property to cause the center of the label to remain in the same place when 
you resize it horizontally by dragging the handles. 

Center stationary when resizing vertically

Check this property to cause the center of the label to remain in the same place when 
you resize it vertically by dragging the handles. 

Keep sized to text

When this property is checked, the label is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a label such that the label has less text 
than it had before, the label will automatically resize itself to shrink down around the 
new text as soon as you complete editing the text. You will generally want to set this 
property for labels.

Automatic Text Scaling

When this property is checked, the label text scales automatically when you resize the 
label. Labels having this property always maintain a fixed aspect ratio (height vs. 
width).
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide

Page 125 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



126 Chapter 8: Labels
Label Properties: Tabs
Use the Tabs tab of the Label Properties dialog box to view and edit the label’s tab 
stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.
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Working with Labels 127
Clear

Click to remove the highlighted tab stop from the tab stop list.

Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a label must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.
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128 Chapter 8: Labels
Label Properties: Memo
Use the Memo tab of the Label Properties dialog box to view and edit the label’s 
memo text. Memo text contains any information you would like to attach to the label. 
It is displayed in a text balloon (tooltip) when you hover the mouse over the label 
while in select mode.

Memo Text

Enter the memo text. It can contain line breaks, but not formatting such as bold, 
underlines, italics, or different fonts or type sizes.

Working with Specialty Labels
Connector labels, figure labels, and flow labels are collectively known as specialty 
labels. Unlike ordinary labels, specialty labels serve a specific purpose in a diagram 
and they automatically make adjustments in accordance with their roles. The primary 
adjustment is in position. For example, one type of specialty label is a Connector 
Label. A connector label labels a connector, and accordingly it’s position adjusts to 
remain with the connector as the connector moves. Specific behaviors of the different 
specialty labels are described in the following section. 
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Working with Specialty Labels 129
Creating Specialty Labels
Specialty labels can be created in different ways. Each type has special creation 
method(s) described in one of the following sections.

A common way to create any of the specialty labels is to create a label in the usual way 
but to place it on your diagram so that the software can deduce that it should be a 
specialty label. For example, if you select a label style, then click on a connector to 
create a label, the label will automatically be created as an in-line connector label for 
the connector. 
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130 Chapter 8: Labels
Specialty Label Slots

The locations where specialty labels can be added to your diagram are called slots. Slot 
locations for the different types of specialty labels are described in the sections below

.

Connector Label Slots
Anywhere along a 

connector.

Flow Label Slots
Near the point where a 

connector attaches to a figure, 
on either side of the 

Connector Label Slots (lateral)
Anywhere alongside above or below 

a connector.

Figure Label Slots
Alongside the figure, centered

and at all corners.

Flow Label Slots
Near the point where a connector 

attaches to a figure, on either side of 
the connector.

Connector Label Slots (in-line)
Anywhere along a connector.
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Working with Specialty Labels 131
In order for specialty labels to be created automatically based on placement, the 
corresponding snap-to-slot option must be enabled. These are located in the Snap 
Labels section under Edit in the Tools Options screen. They are as follows:

Snap labels to connector label slots (in-line) - enabled by default

Snap labels to connector label slots (lateral) - enabled by default

Snap labels to figure label slots - disabled by default 
in conjunction with Snap labels to figure label primary position only

Snap labels to flow label slots - enabled by default

Specialty Labels - Freeform

If you disable the above options, labels will instead become standard labels regardless 
of their placement. In other words, the diagram content will be ignored when you place 
the label. If you enable these options, you can coerce this freeform behavior case-by-
case by holding down the CTRL key.

Creating Specialty Labels with Default Text

A special case occurs when you create a specialty label from a style for which default 
text is defined. In this case, the cursor is replaced by a representation of the text for you 
to drop onto your diagram. Position the text where you like. If you want it to become a 
specialty label, position it over the proper slot and drop it there. Use the CTRL key for 
freeform.

Attaching Specialty Labels
Specialty labels can be created from existing standard labels simply by dragging them 
one at a time over a specialty label slot and dropping them into place.

To attach an existing label as a specialty label
1. Make sure the appropriate snap-to-slot options are enabled (see above).
2. Drag a single existing standard label over a specialty label slot. When you are 

properly over a slot, the slot will appear as a dashed or dotted gray line and the 
status bar will reflect this as well.

3. Drop the label onto the slot at the new position. Do not hold down the CTRL key 
unless you want to prevent the label from becoming a specialty label.

In some cases, attaching a label as a specialty label causes some of its properties to 
change. For example, if you start with a left-justified label and drag it to become a 
connector label, it will become center-justified. See the specific specialty label types 
for more details.
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132 Chapter 8: Labels
Detaching Specialty Labels
A specialty label can easily be detached and made a standard label using the Detach 
Label feature.

To detach a specialty label:
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or

1. Right click on the label and choose Detach Label from the right-click menu.
Once detached the label will no longer adjust to the position of other objects. It will be 
converted to a standard label that you can move anywhere.

Connector Labels
Labels can be attached to connectors to form connector labels. Connector labels are 
useful for describing the purpose of a connector or the relationship that the connector 
represents between two figures. The illustration below shows a typical connector label.

Connector Label Slots (in-line)
In-line connector labels can be placed anywhere along a connector. Therefore, the in-
line connector label slots are located anywhere such that the center point is on the 
connector. This is the location where creating a label or dragging a label will result in 
the label becoming an in-line connector label.

A connector label 

FIGURE 1 

FIGURE 2 

DATA 

In-line Connector Label Slots - Anywhere along a connector
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Connector Labels 133
Connector Label Slots (lateral)
Lateral connector labels can be placed anywhere alongside a connector. Therefore, the 
lateral connector label slots are located just above or below (or to the right or left) of 
the connector. This is the location where creating a label or dragging a label will result 
in the label becoming a lateral connector label.

Special properties and behaviors
A connector can have only one connector label. Multi-segment connectors, 
described later in this chapter, can have one label per segment.
The center of an in-line connector label attaches to any point on the connector. 
When the connector is drawn, it breaks around the label rather than going through 
it. Regardless of the label properties, the text in a connector label is always center-
justified and the center always remains stationary when the label is sized. 
The text justification of a lateral connector label is self-determined based on the 
position of the label and the orientation of the connector such that the distance 
from the connector to the text is fixed if the text expands.
When the connector moves, any attached connector label moves as well. The 
connector label remains attached to the same point on the connector at the 
connector’s new location.

Lateral Connector Label Slots - Anywhere alongside a connector
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134 Chapter 8: Labels
Creating Connector Labels
You create a connector label just like an ordinary label except that you attach it to a 
connector.

To create a connector label
1. Enter text mode by pressing the text mode button on the tool bar or by choosing a 

label style from the style bar. Be sure that at least one of Snap labels to connector 
label slots (in-line) or Snap labels to connector label slots (lateral) is enabled in 
Tools Options.

2. Move the mouse over a connector (on a connector label slot). You will notice that 
the connector label slot is highlighted with a dashed gray box and the status bar 
also reflects that you are over a connector.

3. Click the left mouse button to create the connector label.
4. Type in the text for the label. ESC when done.
There is another way to create a connector label that does not require Snap labels to 
connector label slots (in-line) or Snap labels to connector label slots (lateral) to be 
enabled.

To create a connector label (method 2)
1. Go to Select (or SelText) mode.
2. Right click the mouse on the connector to label at the point where you want the 

new label placed. 
3. Choose Add In-line Connector Label Here or Add Lateral Connector Label 

Here from the right click menu. The label will appear with default label text 
“label”.

4. Enter your own text for the label and press ESC when done.

NOTE: A single segment of a connector can have only one in-line connector label or 
one lateral connector label.

Moving Connector Labels
Once you’ve created a connector label, you can adjust its position on the connector, or 
move it to a different connector.

To move a connector label
1. In select mode, move the mouse over the connector label. The move cursor  

appears.
2. Press the left mouse button and hold it down.
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Connector Labels 135
3. Drag the connector label. The label slides across to the point on the connector 
nearest the mouse, or to a point on a different connector.

4. Release the mouse button. If the label does not move to the new location, there is 
something wrong with the location - the connector may already have a label.

Detaching Connector Labels
A connector label can be detached and made a standard label using the Detach Label 
feature.

To detach a connector label
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or

1. Right click on the label and choose Detach Label from the right-click menu.

Deleting Connector Labels
Deleting a connector label is just like deleting an ordinary label with a few minor 
exceptions.

To delete a connector label
1. Select the label.
2. Choose Delete from the Edit menu, or press the DEL key.
or

1. Edit the text in the label, and delete all the text.
2. A connector label, like any other label, is automatically deleted when it contains 

no text.
When you delete the connector to which the label is attached, the label is deleted 
automatically.
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136 Chapter 8: Labels
Figure Labels
Labels can be attached to figures to form 
figure labels. Figure labels are useful for 
describing the purpose of a figure or 
adding some information about the 
figure. This illustration shows a typical 
figure label. The figure label here is 
positioned beneath the figure. If the 
figure is moved, the figure label will 
move along to remain below the figure at 
its new location.

Figure labels form a grouping of the label and the figure so that many operations affect 
them together. They have many applications. Here are a few examples:

Figure Label Slots
Figure label slots are located above, below, to 
the right and left of each figure, and at the 
four corners as illustrated. These are the 
locations where creating a label or dragging a 
label will result in the label becoming a figure 
label.

Each figure label slot is “attached” to the 
figure at a different point so that it can adjust 
properly of the figure is moved or resized. 
Each slot also enforces a text justification 
(and growth directions) of the label so that the 
label can grow as well and remain properly 
positioned relative to the figure.

For example, if you create a figure label in the most popular slot (the center slot 
beneath the figure), that label will be center-justified and top-justified. As you type 
more text into the label it will remain centered beneath the figure, and as you add new 
lines, it will grow downward to maintain the same distance from the figure. Similarly, 
at this particular slot position, the top center of the label is “attached” to the bottom 

A figure label

Customer Data Record

Joe’s PC

Some common uses for figure labels.

RECONFIGURE
APPARATUS

The procedure for 
reconfiguring the apparatus 
varies based on the 
manufacturer of the equipment 
(see user guide).

Employee

Figure Label Slots
Alongside the figure, centered

and at all corners.
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Figure Labels 137
center of the figure so that when the figure resizes, the label remains centered below it 
and at the same distance from the figure. All nine standard slot positions function 
similarly using different attach points and text justifications.

The Snap labels to figure label slots option and the Snap labels to figure label primary 
position only options control which if any of the slots are sensed when dragging or 
creating figure labels. See Tool Options for details.

After you create a figure label in a slot, or 
attach a label to a figure label slot, you can 
move the label as you like to adjust its 
position relative to the figure. When you do 
so, you’ll see a hook-up indicator (a dotted 
line form the label to the figure) which shows 
that the label is a figure label belonging to the 
figure. The hook-up also shows which point 
on the label is bound to which point on the 
figure.

If you use the slots to create a figure label or to attach a figure label, you can later 
adjust the position of the figure label relative to the figure by dragging it, and you can 
change its text justification in the usual way, but you cannot change the hook-up.

If you create the figure label by using the Attach Label to Figure feature rather than 
creating a label on a slot or attaching an existing label to a slot, then the hook-up 
extends from the center of the label to the center of the figure. As a result the label 
position may need to be re-adjusted manually if the figure changes size.

Special properties and behaviors of figure labels
A figure may have any number of figure labels though only one can occupy each 
figure label slot.
Figure labels move along with the figure when the figure position changes.
If the figure changes size, the figure label may adjust automatically. Figure labels 
that occupy standard figure label slots are attached to the figure in a way that 
specifically forces the figure label position to adjust to repositioning or resizing of 
the figure. The text justification of figure labels in slots adjusts as well for this 
purpose. Figure labels that were attached to the figure using the Attach Label to 
Figure feature may need to be adjusted manually if the figure is resized (these 
attach center-to-center).
If a figure is deleted or copied all of its attached figure labels are deleted or copied 
as well. To prevent this, detach each figure label before deleting or copying the 
figure.

Figure Label Hook-up Indicator

Label
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138 Chapter 8: Labels
Creating Figure Labels
The easiest way to create a figure label is to enable the Snap labels to figure label slots 
option and create a label in the usual way but over one of the figure’s unoccupied 
figure label slots, or to drag an existing label onto a figure’s unoccupied figure label 
slot. These methods have been described earlier in this chapter. The sense of the Snap 
labels to figure label primary position only option affects this as well. See Tools 
Options for details.

Another method to create a figure label is to use the Add Figure Label feature. This 
method is only for figure labels and does not require you to enable the Snap labels to 
figure label slots option. 

We have disabled the Snap labels to figure label slots option by default because the 
presence of many figure label slots can be distracting and frustrating until you 
understand figure labels. If you become familiar with figure labels and want the added 
convenience you can enable this option. You can also limit the exposed figure label 
slots to only the one slot designated as the primary position by enabling the Snap 
labels to figure label primary position only option. The Add Figure Label feature and 
the Attach Label to Figure feature DO NOT require this option to be enabled and they 
still provide all of the power you need to work with figure labels.

To add a figure to a figure
1. Right click on the figure and choose Add Figure Label from the right-click menu.
2. Choose a slot from the pop-up submenu (above, below, right, left, and so on). A 

label with default text “label” will be created in the slot you chose.
3. Edit the label text as you like and press ESC when done.

Attaching Figure Labels
The easiest way to attach a label to a figure is to enable the Snap labels to figure label 
slots option and drag the label onto one of the figure’s unoccupied figure label slots. 
This method was described earlier in the chapter. The sense of the Snap labels to figure 
label primary position only option affects this as well. See Tools Options for details.

Another method is to use the Attach Label to Figure feature.

To attach an existing label to a figure
1. Position the label where you want it relative to the figure.
2. Select the label and the figure (and no other objects).
3. Right click and choose Attach Label to Figure from the menu.
The label will become a figure label attached to the figure in its current position, not in 
a figure label slot. The label will move with the figure in the usual way. You can detach 
the label from the figure by right-clicking on it and choosing Detach Label.
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Figure Labels 139
Re-positioning Figure Labels
After you have attached a figure label to a figure in any of the ways described in this 
section you can reposition the label relative to the figure.

To re-position a figure label
1. Drag the label only (make sure the figure is not selected).
2. As you drag the label, the figure that it is attached to will remain stationary and 

you will see a gray dashed line extending from the label to the figure.
The gray line indicates that the label is a figure label, which figure it is attached to, and 
where it is hooked up to on both the label and the figure. When you release the mouse 
button, the figure label will be re-positioned. When the figure is moved the label will 
move as well but will remain in this new relative position.

Detaching Figure Labels
A figure label can be detached from the figure and made a standard label using the 
Detach Label feature.

To detach a figure label
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or

1. Right click on the label and choose Detach Label from the right-click menu.

Figure Labels as Auto-Labels
A label can be added to a created figure automatically through the use of Auto-labels. 
An auto-label is a text label defined for a figure style. When you create a figure of a 
style and the Auto-label option is enabled, a label with the preset text is automatically 
created beneath the new figure. The auto-label is actually an automatically added 
figure label that uses the figure label Primary Position slot (initially directly below the 

figure).

Computer

Example of a figure 
created from a style 
with the auto-label 
text “Computer”. 
The label appears 
centered directly 

An auto-label
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140 Chapter 8: Labels
The auto label is a figure label of new figure. If you move the figure, the auto-label 
will move along. However, if you move just the auto-label, you can re-position it 
relative to the figure.

By default the label style used for auto-labels (including font, size, color and so on) is 
the last label style you used in the diagram. However, you can set the label style used 
for a particular diagram in Diagram Properties. You can also set the Primary Position 
in Diagram Properties. 

Flow Labels
Labels can be attached to the point where a 
connector attaches to a figure (a flow point) to 
form flow labels. Flow labels are useful for 
describing the relationship between figures 
represented by a connector. The most common 
use for flow labels is in labeling branch 
conditions in flow charts. This illustration shows 
a typical flow label. If the figure or the connector 
is moved, the flow label will move along to 
remain near the point where the connector meets 
the figure.

Flow labels have a variety of uses such as these:

Flow Label Slots
Flow labels can be placed only in flow label slots. The flow label slots are located near 
the figure on either side of the point where a connector attaches to a figure. This is the 

Yes

Flow Label Flow Point

Some common uses for flow labels.

YES

NO

To step 12b
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Flow Labels 141
location where creating a label or dragging a label will result in the label becoming a 
flow label.

Special properties and behaviors of flow labels
A figure/connector connection may have a flow label on either side of the 
connection or on both sides. 
Flow labels adjust their position when either the figure or the connector moves.
Flow labels cannot be dragged or re-positioned by themselves.
The flow labels for a figure/connector pair get deleted if either the figure, the 
connector, or both are deleted.
The text justification of a flow label is adjusted automatically to assure that it 
grows in the proper directions.
You can resize a flow label using the resize handles. After resizing it will snap 
back to its proper location.

Creating Flow Labels
The easiest way to create a flow label is to enable the Snap labels to flow label slots 
option and create a label in the usual way but over an unoccupied flow label slot, or to 
drag an existing label onto an unoccupied flow label slot. These methods are described 
earlier in this chapter.

Another method to create a flow label is to use the Add Flow Label feature. This 
method is only for flow labels and does not require you to enable the Snap labels to 
flow label slots option. 

To add a flow label
1. Right click on a flow point and choose Add Flow Label from the right-click menu.
2. Choose which side of the connector to add the flow label from the pop-up 

submenu (above/left or below/right). A label with default text “label” will be 
created in the slot you chose.

3. Edit the label text as you like and press ESC when done.

Flow Label Slots - Near the point where a connector 
attaches to a figure, on either side of the connector.
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142 Chapter 8: Labels
Attaching Flow Labels
The only way to make a standard label into a flow label is to enable the Snap labels to 
flow label slots option and drag the label onto an unoccupied flow label slot. This 
method was described earlier in the chapter.

Detaching Flow Labels
A flow label can be detached using the Detach Label feature. For example, to move 
the flow label to the other side of the connector, detach it, move it, and re-attach it.

To detach a flow label
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or

Right click on the label and choose Detach Label from the right-click menu.
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CHAPTER

9 Text

Text plays a very important role in flow charts. You can use text to add descriptions for 
figures, labels for connectors, titles, comments, annotations, instructions, and so on. You 
can add text just about anywhere quickly and easily.

This chapter describes how to work with text in labels and figures.

The Text Area
Most figures have an outline shape and reserve the majority of the inside of the shape for 
text. The portion of the figure that is reserved for text is called a text area. You cannot see 
the text area on the screen but it is there, and it is the only part of a figure that can contain 
text. The following diagram shows a text area for a common figure shape.

When you are in text mode, moving over an existing text area or over a “slot” for a 
specialty label (see previous chapter) results in a highlighted dashed rectangle outlining the 
text area. This rectangle is simply an indicator of a place where you can add or edit text on 
an object or associated with an object.

A label always has one and only one text area that is the same size as the label. A figure, on 
the other hand, can have no text areas, or as many as you want. If a figure has no text area, 
you cannot add any text to the figure. If it has multiple text areas, you can add text to each 
of the areas independently.

The number of text areas, and their locations within a figure are part of the figure symbol 
definition.

A text area within a figure 
(not shown on screen) A figure with three text areas 
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144 Chapter 9: Text
Adding Text to Figures and Labels
You can add text to a text area of any label or figure (see previous section for a 
discussion of text areas).

To add text to a figure or label
1. Enter text mode.
2. Move the cursor anywhere over a label or over a figure’s text area. The cursor 

changes as shown in the diagram above.
3. Click the mouse button to begin adding text.
Figures can have multiple text areas. You can add text to any of these areas by clicking 
on different parts of the figure.

To add text to a figure (automatic method)
1. Move the cursor over a figure’s text area. 
2. Start typing text on the keyboard. You are automatically placed in text mode 

entering text. If the figure contained any previous text, the typed text replaces it.
See Editing Text below for additional ways to edit the figure text after the figure is 
created.

Adding Text to Labels
Labels are similar to figures except that a label cannot exist if it has no text. 
Consequently, you add text to a label when you create it. If you do not add any text 
when creating a label, or if you later remove all the text, the label is deleted 
automatically.

Rotating Text
Labels can be rotated so that the text is drawn vertically top to bottom or bottom to top.

To rotate a label
1. Select one or more labels.
2. Press the toolbar button that represents the way that you want the text rotated. The 

text rotation toolbar buttons show ABC at different angles.
3. OR, choose one of the commands in the Rotate submenu of the Labels menu.
4. OR, right click and choose a command from the Rotate submenu.
When a label is rotated, you cannot edit the text by clicking on it while in text mode. 
Instead, use the Edit Text command to edit the text through the figure’s property dialog 
box.
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Editing Text 145
Editing Text

To edit figure or label text
1. Enter text mode.
2. Move the cursor anywhere over a label or over a figure’s text area. A dotted box 

appears outlining the text area.
3. Click the mouse button to begin editing the text.
Note, the above procedure cannot be used to edit rotated text. To edit rotated label text, 
use one of the additional methods described below.

Additional methods for editing figure or label text
There are also some other methods available for editing the text of a figure or label. 
Use the method you find most convenient.

1. Select the figure or label and choose Edit Text from the Edit menu.
2. Select the figure or label and choose Edit Text from the right click menu.
3. Select the figure or label and press the F2 key.
4. Double-click on the figure or label. This works to edit text only if you have 

selected Display/edit properties in the 'Edit' options within the Tools Options 
screen.

Selecting Text
To perform operations such as Cut, Copy, and Delete, you need to select a range of 
text.

To select a range of text
1. Enter text mode.
2. Move the cursor anywhere over a label or over a figure’s text area. A dotted box 

appears outlining the text area.
3. Press the left mouse button and hold it down to begin selecting the text.
4. Drag the mouse to select text. The selected text becomes highlighted.

An example of a figure with some 
selected text. The word “SAMPLE” 

FIGURE
A SAMPLE

is selected. 
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146 Chapter 9: Text
To select a word of text
1. Enter text mode.
2. Move the cursor anywhere over a label or over a figure’s text area. 
3. Double-click the left mouse button to select the word beneath the cursor.

To select all text within a label or figure
1. Enter text mode.
2. Move the cursor over a label or a figure’s text area. 
3. Triple-click the left mouse button.

To extend a text selection
While holding down the SHIFT key, click the mouse on additional text to select.
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Using the Keyboard to Edit Text 147
Using the Keyboard to Edit Text
The following table lists the functions available from the keyboard when working with 
text::

You can use any of the keys that move the cursor in combination with the SHIFT key to 
extend the current text selection.

Table 1: Text Editing Keys
KEY FUNCTION
ESC Quit editing text
RIGHT Move the cursor to the right one character
LEFT Move the cursor to the left one character
UP Move the cursor up one line
DOWN Move the cursor down one line
CTRL-RIGHT Move the cursor right one word
CTRL-LEFT Move the cursor left one word
HOME Move the cursor to the beginning of the current line
END Move the cursor to the end of the current line
CTRL-HOME Move the cursor to the beginning of all text
CTRL-END Move the cursor to the end of all text
TAB In a node with multiple text areas, move to next area
SHIFT-TAB In a node with multiple text areas, move to previous area
BACKSPACE If any text is selected, delete the selected text. Otherwise, 

delete the character to the left of the cursor.
DEL If any text is selected, delete the selected text. Otherwise, 

delete the character to the right of the cursor.
ENTER Add a “hard” line break
Invalid Many control keys, and a few obscure punctuation keys are not 

allowed
Valid Standard characters such as letters, numbers. and punctuation 

are valid. As you type valid characters, they are inserted in the 
text at the cursor position. There is no overstrike mode. If any 
text is selected, the typed character replaces the selected text.

CTRL-B Toggle Bold for the current word or text being typed
CTRL-I Toggle Italics for the current word or text being typed
CTRL-U Toggle Underline for the current word or text being typed
CTRL-L Left-justify the text
CTRL-E Center-justify the text
CTRL-R Right-justify the text
CTRL-Z Undo text edit
CTRL-Y Redo text edit
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148 Chapter 9: Text
Some international characters, for example the German umlaut, may not be available 
on all keyboards. To type these characters, use the ALT key with the ANSI character 
code entered from the numeric keypad. For example, the ANSI code for an “ae” 
character is 230. To type this character, while holding down the ALT key, type 0230 on 
the numeric keypad. (Always include the leading zero.)

Cutting, Copying, and Pasting Text
Selected text can be cut to the Windows clipboard, copied to the clipboard, and pasted 
from the clipboard. The combination of these features allows you to move text from 
one figure to another, copy text from one figure to another, or copy text from one 
diagram to another. You can also copy text to and from other programs.

To delete text (without moving it to the clipboard)
1. Select a range of text.
2. Press the DEL key or choose Delete from the Edit menu.

To cut text (and move it to the clipboard)
1. Select a range of text.
2. Choose Cut from the Edit menu.

To copy text to the clipboard
1. Select a range of text.
2. Choose Copy from the Edit menu.

To paste text from the clipboard
1. Position the cursor to the location in the text where you want to add the text from 

the clipboard.
2. Choose Paste from the Edit menu. The text from the clipboard is added at the 

cursor position. If any text was selected, the pasted text replaced the selected text.
When you are not in text mode, you can still paste text from the clipboard. In that case, 
a new label will automatically be created for you and positioned at the center of the 
screen with the text that was in the clipboard. The style of this label will be the last 
label style you selected.

Replacing Text
If any text is selected when you type from the keyboard or Paste, the selected text is 
first deleted before the new text is entered. This is a handy way to replace text.
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Setting Text Attributes 149
To replace a range of text
1. Select the range of text to replace.
2. Type the replacement text from the keyboard or Paste the replacement text from 

the clipboard.
3. The text that was originally selected is deleted before the new text is added.

Setting Text Attributes
Text attributes such as the font, size, color, and styles (bold, italic, and underline) can 
be set for the entire figure or label or for any portion of text within the figure or label. 
If you want all of the text within a figure or label to have the same attributes, you can 
set those attributes in the Text tab of the Figure or Label Properties dialog boxes, or 
you can select the figure or label and use the property bar buttons (for instance the 
Bold button) to change the font attributes of the entire figure or label.

However, you can also change the text attributes of a portion of the text for a single 
figure or label in the following ways:

To set the text attributes of a portion of text within a figure or label
1. In text mode, select the range of text.
2. Use the property bar buttons to change the font, font size, color or styles such as 

bold, italic, and underline for the range of text. Some of these attributes are also 
available through the right-click menu. By default, subscript, superscript, and all-
caps are available only through the right-click menu.

To set the text attributes of an individual word within a figure or label
1. In text mode, select the word of text. There are a couple of ways to do this. The 

obvious way is just to click and drag until the whole word is selected. Another is 
to double click on the word. Another convenient way is to just place the cursor 
within the word after the first letter but before the last without any selection.

2. Use the property bar buttons to change the font, font size, color or styles such as 
bold, italic, and underline for the word. Some of these attributes are also available 
through the right-click menu. By default, subscript, superscript, and all-caps are 
available only through the right-click menu.

 
You can also control the text attributes of the text that you are about to type. Normally, 
text that you type will appear in the base font attributes of the figure or label. In 
addition, if the cursor is located within the text in a place with its own text attributes 
(such as in the middle of a word that is bolded), typed text will naturally appear 
accordingly. However, you can also choose to select different text attributes to appear 
as you type.
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150 Chapter 9: Text
To set the text attributes for text that you are about to type 
1. In text mode, move the cursor to a position that is not within a word. It can be in 

front of or immediately following a word, or at the start or end of all the text.
2. Use the property bar buttons to change the font, font size, color or styles such as 

bold, italic, and underline for the text that you are about to type. Some of these 
attributes are also available through the right-click menu. By default, subscript, 
superscript, and all-caps are available only through the right-click menu.

3. Without moving the cursor, type your text. The attributes of the typed text will 
reflect those you just chose. If you move the cursor, for example by pressing the 
arrow keys, Typed text will return to using the text attributes already at the new 
cursor location.

Text Fields
Text fields are sections of text such as a date or filename that can be added to text 
within a diagram. For example, you can place the text caret within your text and 
instruct that the filename for the current diagram file be added to the text. Once the text 
field is added, its contents are updated automatically when it is displayed or printed.

Text fields include the diagram’s filename, the time and date that the diagram was 
created, and the time and date that the diagram was last saved. Each of these fields can 
be displayed in either a short or long version. Fields that indicate a time can be further 
customized to one of many short or long display formats.

Table 2: Text Fields
FIELD DESCRIPTION EXAMPLE
Filename (Short) Simple filename File.edg
Filename (Long) Full file path c:\Folder\File.edg
Create Time (Short) Short format (programmable) 

time/date file was created
09/07/08

Create Time (Long) Long format (programmable) 
time/date file was created

August 25, 2008 9:54 PM

Save Time (Short) Short format (programmable) 
time/date file was last saved

09/07/08

Save Time (Short) Long format (programmable) 
time/date file was last saved

August 25, 2008 9:54 PM

Sheet Number The sequential sheet number 
(like a page number)

3

Sheet Name Custom sheet name or “Sheet #” 
if none defined.

“Description” or “Sheet 3”
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Special Considerations 151
To insert a field into diagram text
1. Enter text mode using the text tool and clicking on the text area of a diagram 

object or label. (Fields cannot be inserted when editing text from the Text tab of 
the Properties screen.)

2. If the diagram is new, save it to a file before inserting a text field. Text fields 
display information about the current file which is not available if the diagram has 
never been saved.

3. Place the text caret where you want the text field inserted.
4. Select Insert Field from either the main Edit menu or from right-click menu and 

then select one of the fields to insert.
After inserting a text field, you can treat it like typed text. For example, you may want 
to set attributes for the field using Bold, Italics, Underline, or All Caps (the All Caps 
style can be found in the Character Style submenu within the right click menu). The 
main difference between the field text and typed text is that characters within the field 
text cannot be edited individually, and the field text will not break when wrapped, even 
if it contains spaces.

The display formats for the fields that reflects times can be customized using the 
Fields category within the Tools Options screen.

Special Considerations
When typing in a figure or label with word-wrap active, This program remembers 
the difference between hard carriage returns (those you insert by pressing the 
RETURN key), and soft carriage returns that are inserted automatically during word 
wrap. Hard carriage returns remain in effect until you delete them. Soft carriage 
returns get added and deleted automatically every time the text is reformatted, 
such as when you resize the figure.
A single figure or label can contain a maximum of 4095 characters including those 
that are not visible such as carriage returns. This limit applies to the sum of all text 
in all text areas of a figure.
Within a single figure or label, you are limited to a maximum of 20 different text 
colors and 20 different fonts.
Text entry is always insert mode as opposed to overstrike mode. In overstrike 
mode, each new character you type would replace the next character in the 
previous text. Some other programs use the INSERT key to toggle between insert 
and overstrike mode. This program does not.
Undo is not supported for individual operations within text mode, for example, to 
undo the deletion of a single word. You can use Undo to undo all text changes 
since you started editing the figure or label.
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CHAPTER

10 Figure Styles

Like paragraph styles in word processors, styles are the true definitions of objects. In order 
to create any object, a figure, label, or connector, you must start with a predefined style. 
The style defines the initial characteristics and behaviors of the object.

One example of a style is the decision figure style from the flowcharting template. In 
flowcharting, a diamond-shaped figure with centered text marks decision points. The 
shape, the location of the text, the text justification, the initial color, and so on, are all parts 
of the figure style. When you create a figure, you choose one of the predefined styles to 
become the basis for the new figure. 

To work with figure styles choose Styles from the Figures menu. If no styles are defined, 
you will be immediately prompted to create a new style. Otherwise, the Define Figure 
Styles dialog box appears. This dialog box allows you to view and modify attributes of the 
existing styles.
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154 Chapter 10: Figure Styles
Figure Styles: Common Controls
The Define Figure Styles dialog box contains tabs for General, Text, and Behavior 
styles which are described in following sections. This section describes the dialog 
controls that are always visible.

Model

The upper left corner of the dialog box contains a model of the figure style. The model 
is an illustration of how a figure of this style will appear in your diagram. As you 
modify style attributes that affect the appearance of the style, the model helps you to 
visualize the outcome.

Style Selection

Below the model is a list box containing names of all the figure styles presently 
included in your diagram. The style that is selected is the one being shown in the 
model and reflected throughout all the other controls in the dialog box. When you 
make a change, this is the style that is altered.

Above the list box is a button labeled Styles that provides a drop menu for changing 
the selected style.

New

Press this button to create a new style. The New Figure Style dialog box appears to 
prompt for the name of the new style.

Press OK immediately to accept the default name, or enter a more descriptive name of 
your own. The name must not match the name of any existing style. 

We strongly recommend that you enter a descriptive name for the style. This will help 
you remember the style’s purpose. Now is the time to do it, because if you want to 
change the name later, the only way to do it is to copy the style to one of a new name 
and delete the old style. This can be inconvenient because you may have to go back 
and define and existing objects of the old style to the new style (by editing its 
properties).

Immediately after you create a new style, you will need to select a figure shape by 
pressing one of the Select or change shape buttons. 
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Figure Styles: Common Controls 155
Copy

Press this button to create a new style that is a copy of the current style. Enter a 
descriptive name for the style as with New above.

Rename

Press this button to change the name of a style. 

Delete

Press this button to delete the currently selected style. You will be asked to confirm the 
deletion before it takes effect. Be very careful. Deleting a style cannot be undone. If 
you have any doubts, save your diagram before deleting any styles.

When you delete a style, any objects in the diagram that were created with this style 
and bound to it become unbound. 

Close

Press this button to exit the dialog box. If you have made changes to the currently 
selected style that you have not yet applied, you will be asked to do so before exiting.

Apply

Press this button to apply all the changes you have made to the currently selected 
figure style. You should apply your changes before switching to select a different style 
or closing the dialog box. If you forget, you will be asked whether to apply or discard 
the changes before going on.

The selected figure style
The Define Figure Styles dialog box usually displays the attributes of a single selected 
figure style. Each of the tabs groups a different set of attributes belonging to this same 
selected figure style. 

You can tell which style is currently selected because it’s name is highlighted in the list 
box of styles at the left side of the dialog box, and a picture of the style is shown in the 
model area above the list box.

You can select a different style by clicking on its name in the list box located at the left 
of the dialog box or by choosing a new style from the Styles drop menu. As you move 
from style to style changing or viewing attributes of the style, you will see the right 
half of the dialog box change to reflect the new style’s attributes. 

If you attempt to switch styles after making changes to the current style properties but 
before you apply those changes to the style, you will be asked whether you want to 
apply the changes before switching to the new style.

You can also select <All> instead of a single style. Changes you make to <All> will 
affect all styles in your diagram.
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156 Chapter 10: Figure Styles
Figure Styles: General
Use the General tab of the Define Figure Styles dialog box to view and edit the basic 
properties of the selected figure style such as its description, default dimensions, and 
colors.

Description

The description is a short text description of the style. This description is displayed in 
the status bar when the style is selected.

Width

Enter the default width for figures of this style here. Figures that you create of this 
style will begin at this size. Choose zero to indicate no default width.

Height

Enter the default height for figures of this style here. Figures that you create of this 
style will begin at this size. Choose zero to indicate no default height.

From Selected

Rather than typing dimensions for Width and Height, you can select a single figure 
before entering the figure style dialog box, then press this button to use the width and 
height of that figure as the style’s defaults. This button will be grayed unless a single 
figure is selected in your diagram when you invoke the dialog box.
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Figure Styles: General 157
Text color

To change the color of the text for figures of this style, choose a color from the color 
selection drop menu. If you select a color that cannot be drawn solid, Windows draws 
the text in the nearest solid color.

Border color

To change the color of the border for figures of this style, choose a color from the color 
selection drop menu. Borders must be a color that can be drawn solid on your screen. If 
you select a color that cannot be drawn solid, Windows draws the border in the nearest 
solid color.

Fill color

To change the interior fill color for figures of this style, choose a color from the color 
selection drop menu. There are no restrictions on the fill color, it does not have to be 
solid.

Border width

To change the thickness of the lines that make up the border (outline) of figures of this 
style, enter a new border width. You can also change the border width by pressing the 
up and down spin buttons to the right.

Line Pattern

Select a line pattern for drawing borders such as solid, dashed, dotted, and so on. The 
line style is used to draw for the entire outline of the shape, not just the outside edges 
so consider carefully before using a pattern other than solid. Also note that some older 
shapes cannot use this property.

Drop Shadow

Check this box to add a drop shadow to the figure style to give it a three-dimensional 
look. All drop shadows in a diagram are the same size and color. You control the size 
and color from within the Diagram Properties dialog box.

Bind to style

When this property is checked, any object created with this style is automatically 
bound to the style. This means that if the style changes in the future, the object will 
change as well. If an object is not bound to the style, future changes to the style will 
not effect the object.

In drop menu

If this button is checked, the style appears in the figure style drop menus, otherwise it 
does not. This is the same as checking Menu in the Choose a Figure Style dialog box 
(see page 52).
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158 Chapter 10: Figure Styles
Style bar button

If this button is checked, a button with a representation of the style is included in on 
the style bar. Style bar buttons are useful for frequently used styles. Because the 
representation on a style bar button is not exact (contains no color or line thickness), 
they are not useful for every style. This is the same as checking Button in the Choose a 
Figure Style dialog box (see page 52).

Select or change shape
The remainder of the controls in the General tab of the Define Figure Styles dialog box 
help you to set the shape (graphic definition) of the figure style. 

Symbol Gallery

This button shows a graphic representation of the figure symbol. Press this button to 
select a shape for the figure style from the collection of built-in symbols contained in 
the symbol gallery. See the following section for detailed instructions.

Graphic from File

Press this button to select a graphic definition for the figure style from an external 
graphics image file such as a Windows Metafile (.WMF or. EMF) or a Windows 
bitmap file (.BMP or.DIB). See the following section for detailed instructions.

Graphic from Selected

Press this button to copy a shape (symbol or graphic definition) for the figure style 
from a single figure that you selected in your diagram prior to entering this dialog box. 
For example, suppose you have copied and pasted a clipart image into your diagram 
and want to use that image as the shape of a figure style. Select the lone figure that 
appeared when you pasted the image into your diagram. Then open this dialog box, 
select the figure style (or create a new one), and press this button. This button will be 
grayed unless a single figure is selected in your diagram when you invoke the dialog 
box. See the following section for more details.

Graphic from Clipboard

Press this button to select a shape (graphic definition) for the figure style from an 
image that is stored in the Windows clipboard. For example, you can create an image 
in Microsoft Paintbrush and do a Copy of it, then return to this program and paste it 
right into a style definition. See the following section for detailed instructions.
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Figure Styles: Text 159
Figure Styles: Text
Use the Text tab of the Define Figure dialog box to view and edit the style’s text and 
the properties of the style that affect the display and format of the text.

Text box

This area shows a model of the shape of the figure. The dotted rectangles show the 
boundaries of the text region(s) in the figure. If the figure shape contains more than 
one text region, the arrows control which region is selected and marked by a dark gray 
dotted box.

Text

The text control to the right of the model displays the text that is contained in the figure 
in the selected text region. The text here can be edited using the usual Windows edit 
box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
figure itself. 

Hidden

When checked, the selected text area is hidden and cannot be edited on-screen. Hiding 
text areas is useful when creating transparent shapes that have outlines but no fill. To 
make a shape completely transparent you need to use a null fill and make the text areas 
hidden, otherwise objects beneath the shape will not be selectable.
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160 Chapter 10: Figure Styles
Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Margin

Select the internal text margin, the spacing between the text and the edges of the shape. 
Note that some shapes do not support fixed margins in which case their margins scale 
with the size of the shape.

Text color

To change the color of the figure’s text, choose a different color from the color 
selection drop menu. If you select a color that cannot be drawn solid, Windows draws 
the text in the nearest solid color.

Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. This method also allows you to 
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Figure Styles: Text 161
preview a sample of the font as you select it. Controls in this dialog are self-
explanatory.
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162 Chapter 10: Figure Styles
Figure Styles: Connections
Use the Connections tab of the Figure Properties dialog box to view and edit the 
figure’s connection points and properties.

Connection points

This area shows the location of any connection points within the figure. One 
connection point is always selected and highlighted. You can use the mouse to drag 
and reposition connection points, select a different point. or right click to delete a 
connection point or add a new one. The arrow buttons cycle through the selected 
connection point. The Add button adds a new point, and the Delete button deletes the 
highlighted point.

Name or Description

Each connection point can have a name or description. Use this control to view and 
edit the name of the selected connection point.

Snap to center and edges

Check this box to have the mouse snap to the centers and edges of the figure while you 
drag a connection point with the mouse (in this dialog box).

Snap to grid

Check this box to have the mouse snap to the diagram grid while you drag a 
connection point with the mouse (in this dialog box).
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Figure Styles: Behaviors 163
Terminate connections to connection points at border

Check this box to cause connections to terminate at the border of the figure rather than 
extending all the way to the connection points. 

Enable standard center connect (terminated at border)

Check this box to enable connectors to attach at the center of the figure. This option is 
useful if you have a figure with connection points. You can choose to allow connectors 
to attach only at the connection points, or to the figure center also.

Figure Styles: Behaviors
Use the Behaviors tab of the Define Figure Styles dialog box to view and edit the 
properties that affect the way figures of this style behave within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the figure. 
If set to Prevent, additional characters are not allowed. If set to Expand, the figure 
automatically grows wider as you continue typing. The direction of expansion is 
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164 Chapter 10: Figure Styles
controlled by the Horizontal expansion property. If set to Wrap, the width of the figure 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the figure expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the figure. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a figure of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the figure automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.

Vertical expansion

This property controls in which direction the figure expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the figure. 

Horizontal center snaps to grid

Check this property to cause the figure’s horizontal center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for figures that are connected to other figures as it will aid in keeping them 
aligned horizontally.

Vertical center snaps to grid

Check this property to cause the figure’s vertical center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for figures that are connected to other figures as it will aid in keeping them 
aligned vertically.

Width snaps to grid

When this property is checked and the snap grid is enabled, the figure’s width remains 
an even multiple of the snap grid when you resize it. 

NOTE: When the height and width snap to the grid, both sides are aligned with snap 
grid lines which are not necessarily the same as the visible grid lines. In 
effect, the total width or height is always a multiple of twice the snap 
spacing. For example, if the snap spacing is one quarter of an inch and a 
node has the Width snaps to grid property, that figure width can be 1/2 in., 1 
in., 1 1/2 in. and so on, but it cannot be 3/4 in. 
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Figure Styles: Behaviors 165
Height snaps to grid

When this property is checked and the snap grid is enabled, the figure’s height remains 
an even multiple of the snap grid when you resize the node. 

Left and right edges snap to grid

When this property is checked and the snap grid is enabled, the figure’s left and right 
edges snap to the grid when you move, create, or resize the node. But not if you move 
or resize it along with a group of selected objects, or if you create it with its default size 
without intentionally resizing it.

If the figure’s width is not an even multiple of the snap grid and you drag the figure, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the figure. In this case, either edge (the one that is closest) is aligned to the 
grid. And if the center is closest to the grid and Horizontal center snaps to grid is also 
enabled, the figure can snap there as well. If the figure’s width is not an even multiple 
of the snap grid and you resize it by dragging a resize handle, only the edge that the 
handle is on (the one you are dragging) aligns to the grid. To resize it so that both edges 
are aligned to the grid, resize it using both the left handle and the right handle.

This property and Horizontal center snaps to grid are mutually exclusive. Only one 
can be in effect. This property is most useful when Center stationary when resizing 
horizontally is disabled.

Top and bottom edges snap to grid

When this property is checked and the snap grid is enabled, the figure’s top and bottom 
edges snap to the grid when you move, create, or resize it. But not if you move or 
resize it along with a group of selected objects, or if you create it with its default size 
without intentionally resizing it.

If the figure’s height is not an even multiple of the snap grid and you drag the figure, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the figure. In this case, either edge (the one that is closest) is aligned to the 
grid. And if the center is closest to the grid and Vertical center snaps to grid is also 
enabled, the figure can snap there as well. If the figure’s height is not an even multiple 
of the snap grid and you resize it by dragging a resize handle, only the edge that the 
handle is on (the one you are dragging) aligns to the grid. To resize it so that both edges 
are aligned to the grid, resize it using both the top handle and the bottom handle.

This property and Vertical center snaps to grid are mutually exclusive. Only one can 
be in effect. This property is most useful when Center stationary when resizing 
vertically is disabled.

Center stationary when resizing horizontally

Check this property to cause the center of the figure to remain in the same place when 
you resize it horizontally by dragging the handles. 
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166 Chapter 10: Figure Styles
This property is useful when figures are lined up vertically one on top of the other and 
potentially connected by a single connector from the horizontal center of one figure to 
the horizontal center of another above or below it. With this property, the figure will 
remain aligned with the others if it is resized horizontally. 

Center stationary when resizing vertically

Check this property to cause the center of the figure to remain in the same place when 
you resize it vertically by dragging the handles. 

This property is useful when figures are lined up horizontally one alongside the other 
and potentially connected by a single connector from the vertical center of one figure 
to the vertical center of another to its right or left. With this property, the figure will 
remain aligned with the others if it is resized vertically. 

Keep sized to text

When this property is checked, the figure is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a figure such that the figure has less 
text than it had before, the figure will automatically resize itself to shrink down around 
the new text as soon as you complete editing the text.

Preserve aspect ratio

When this property is checked, the figure retains its current aspect ratio (its height 
compared to its width) when you resize the figure by dragging the corner handles or 
when the figure expands due to typing text. You can still change the aspect ratio of the 
figure by dragging the side handles, setting the size directly in the General tab, or 
using the From Selected button.

Automatic Text Scaling

When this property is checked, the figure text scales automatically when you resize the 
figure. Figures having this property always maintain a fixed aspect ratio (height vs. 
width) over-riding the Preserve Aspect Ratio property.

Do not print or export

When this property is checked, the object will not appear in print-outs or when the 
diagram is copied or exported. This property is useful for hiding objects that exist only 
for visual notation on the screen, and for implementing hyperlinks to other diagrams or 
documents.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 166 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Figure Styles: Auto Label 167
Figure Styles: Auto Label
Use the Auto Label tab of the Define Figure Styles dialog box to view and edit the 
style’s auto label.

Automatically label figures created using this style

Check this box to enable auto-label for this style.

Label Text

Enter the text for the auto label.

Active container - keep contained objects together

When this property is checked, the figure serves as a container object that 
automatically keeps objects contained within its bounds together as a unit. Moving the 
container results in moving along the contents. Copying the container copies the 
contents. Deleting the container deletes the contents, and so on. Note, if the container 
is filled, only objects on top of the container are kept together. If it has no fill, all 
objects above or below are kept together.

This property is usually set along with others for the purpose of creating a container, a 
special type of figure that identifies a subset of your diagram.
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168 Chapter 10: Figure Styles
Figure Styles: Fill
Use the Fill tab of the Figure Styles dialog box to view and edit the figure style’s fill 
properties.

Linear gradient view.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 168 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Figure Styles: Fill 169
Elliptical gradient view:

Fill method

Select the type of fill. The remainder of controls on this screen depend on which 
method is selected.

Color

A single color control is available when the fill method is 'Solid color'. Use this control 
to select the solid fill color.

From/To

The 'From' and 'To' color selection controls are available when the fill method is 
'Linear gradient' or 'Elliptical gradient'. Use these controls to select the start and end 
colors that are blended across the gradient.

Blend

The 'Blend' control is available when a gradient fill method is selected. Use this control 
to choose how the 'From' color is blended into the 'To' color across the gradient. Linear 
blend means simply that the 'From' color is blended uniformly into the 'To' color. When 
'Bell curve' is selected, the 'From' color blends into the 'From' color based on a normal 
distribution bell curve contributing to a natural 3D shading effect. When 'Platform' is 
selected, the gradient begins with the 'From' color, gradually blends to a color midway 
between 'To' and 'From', remains constant for a certain distance, and then blends to the 
'To' color.
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170 Chapter 10: Figure Styles
Angle

The 'Angle' control is available when the linear gradient fill method is selected. Use 
this control to select an angle for the blend. For cylindrical blends, angles of 180 or 
greater cause the swapping of the 'From' and 'To' colors.

Intensity

The 'Intensity' control is available when a gradient fill method is selected. Use this 
control to select how prominent the 'From' color appears in the blend. A value of 100 is 
most intense, while a value of zero makes the 'From' color undetectable. Intensity is 
most useful when used with a white or black 'From' color in order to achieve a gradient 
between two shades of the same color but without having to actually choose two 
shades of the color separately.

Center

The 'Center' control is available only with the linear gradient fill method. Use this 
control to position the midpoint of the gradient from 0 to 100. If the 'Blend' is set to 
'Platform' this control affects the size of center rather than the position.

X Offset, Y Offset

These controls are available only for the elliptical gradient fill method. Choose values 
from 0 to 100 to position the center of the elliptical gradient anywhere on the node. An 
off-center elliptical gradient produces a 3D appearance.

Spread

This control is available only for the elliptical gradient fill method. Choose a value 
from 0 to 100 to increase the size of the center region of the gradient.

Presets

Choose a preset fill as a shorthand for popular combinations of the above options. 
Presets combine all of the fill properties except for the 'To' color which is 
independently controllable.
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Figure Styles: Tabs
Use the Tabs tab of the Figure Styles dialog box to view and edit the style’s tab stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.

Clear

Click to remove the highlighted tab stop from the tab stop list.
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172 Chapter 10: Figure Styles
Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a style must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.

Setting Figure Style Symbol or Graphic
The graphic definition can be a predefined symbol or an imported graphic image.

Using a predefined symbol as a figure style graphic
Press the Symbol from Gallery button to access the Figure Symbol Gallery dialog box 
to select a figure symbol. See the following section for instructions.

Using a graphic image as a figure shape
You can define a figure style using a graphic or clipart image imported from a file, 
from a figure in your diagram, or from the Windows clipboard.

Several import formats are supported. A complete discussion of supported formats is 
contained elsewhere.

To import a graphic image from a file to serve as the figure style shape
1. Press the Graphic from File button in the Define Figure Style dialog box.
2. Choose the graphic file type in the List files by type box.
3. Select a graphics file and press OK.

To copy a graphic image or symbol from an existing figure to serve as 
the figure style shape
1. In your diagram, select the single figure that contains the graphic that you want to 

use as your figure style shape. This might be a figure that was created when you 
pasted a clipboard image into your diagram from another program.

2. Enter the Define Figure Styles dialog box by choosing Styles from the Figures 
menu.

3. Press the Graphic from Selected button in the General section of the dialog box.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 172 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



The Figure Symbol Gallery 173
To import a graphic image from the Windows clipboard to serve as the 
figure style shape
1. Copy a graphic image into the Windows clipboard. In another program, this is 

usually as simple as selecting the image and choosing copy.
2. Enter the Define Figure Styles dialog box by choosing Styles from the Figures 

menu.
3. Press the Graphic from Selected button in the General section of the dialog box.

The Figure Symbol Gallery
The Figure Symbol Gallery is a library of the pre-defined symbols available to your 
flow chart. Use the figure symbol gallery to select a symbol when (a) changing a figure 
shape in the Figure Properties dialog box, (b) selecting a figure style shape in the 
Define Figure Styles dialog box, or (c) using the Insert Symbol feature.

The figure symbols
The program comes with an initial collection of figure symbols. These are categorized 
by shape and by diagram type such as flowcharting symbols. You can add new 
symbols to your gallery by obtaining extension packs from the publisher.

Figure symbols are stored in.EDF files (one per category) on your hard disk in the 
program’s Symbols folder. These are ASCII text files.

Using the Figure Symbol Gallery dialog box
Invoke the Figure Symbol Gallery dialog box to find, preview, and select a figure 
symbol.
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174 Chapter 10: Figure Styles
The dialog box displays the installed figure symbols. The highlighted box indicates the 
selected symbol. At the left is a list of categories. Check Show text areas to display the 
text areas within the symbols.

Select a symbol by clicking on it and pressing OK, or by double-clicking on it.

Using a Figure in your Flow Chart to Define a Style
When you create a figure in your flow chart, it will start out as defined by the style you 
chose to base it on. You may then set the properties of that new figure in special ways 
such as giving it a specific color, or a new font size. Once you have altered the figure 
you may then want to update the style it was based on to reflect the changes such that 
all existing objects of that style, and all new objects of that style reflect the properties 
of the figure.

Update Style From
With the Update Style From feature you can use an existing figure to redefine the style 
that it was created from.

To update a style based on an existing figure of the style
1. Right-click on the figure and choose Update Style From.. from the right-click 

menu.
OR

2. Select the figure and choose Update Style From.. from the Figures menu.

New Style From
With the New Style From feature you can use an existing figure to define a new style.

To define a new style based on an existing figure 
1. Right-click on the figure and choose New Style From.. from the right-click menu.

OR

2. Select the figure and choose New Style From.. from the Figures menu.
3. Enter a name for the style when prompted. The style will appear in the style bar on 

the left of the screen by default. If you don’t want it there just right-click on the 
button and choose Hide.
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Reapplying a Figure Style 175
Reapplying a Figure Style
Use the Reapply Style feature to restore a figure to the properties of its initial style. 
This will work for any figure with an associated style. Most figures have an associated 
style because they were created by choosing from a style. Those that do not have an 
associated style are created in other ways, such as by importing graphics or inserting 
symbols directly without specifying a style. You can review and change the associated 
style in the Figure Properties screen. 

To reapply the properties of the original style to one of more figures 
1. Select one or more nodes that have an associated style.
2. Right-click on the figure and choose Reapply Style from the right-click menu.

OR

3. Choose Reapply Style from the Figures menu.

NOTE: Certain properties that are judged to be critical to a specific object will not be 
restored from the style when you reapply. One example is the node text. 
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CHAPTER

11 Label Styles

Label styles are similar to figure styles. Label styles define the initial characteristics and 
behaviors of labels. Labels are essentially specialized figures. Therefore, working with 
label styles is very much like working with figure styles.

To work with label styles, choose Styles from the Labels menu. If no styles are defined, 
you are immediately prompted to create a new style. If any styles are defined, the Define 
Label Styles dialog box appears. This dialog box allows you to view and modify attributes 
of the existing styles.

Label Styles: Common Controls
The Define Label Styles dialog box contains tabs for General, Text, and Behavior styles 
which are described in following sections. This section describes the dialog controls that 
are always visible.
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178 Chapter 11: Label Styles
Model

The upper left corner of the dialog box contains a model of the label style. The model 
is an illustration of how a label of this style will appear in your diagram. As you 
modify style attributes that affect the appearance of the style, the model helps you to 
visualize the outcome.

Style Selection

Below the model is a list box containing names of all the label styles presently 
included in your diagram. The style that is selected is the one being shown in the 
model and reflected throughout all the other controls in the dialog box. When you 
make a change, this is the style that is altered.

Above the list box is a button labeled Styles that provides a drop menu for changing 
the selected style.

New

Press this button to create a new style. The New Label Style dialog box appears to 
prompt for the name of the new style.

Press OK immediately to accept the default name, or enter a more descriptive name of 
your own. The name must not match the name of any existing style.

We strongly recommend that you enter a descriptive name for the style. This will help 
you remember the style’s purpose. Now is the time to do it, because if you want to 
change the name later, the only way to do it is to copy the style to one of a new name 
and delete the old style. This can be inconvenient because you may have to go back 
and define and existing objects of the old style to the new style (by editing its 
properties).

Copy

Press this button to create a new style that is a copy of the current style. Enter a 
descriptive name for the style as with New above.

Rename

Press this button to change the name of a style. 
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Delete

Press this button to delete the currently selected style. You will be asked to confirm the 
deletion before it takes effect. Be very careful. Deleting a style cannot be undone. If 
you have any doubts, save your diagram before deleting any styles.

When you delete a style, any objects in the diagram that were created with this style 
and bound to it become unbound. 

Close

Press this button to exit the dialog box. If you have made changes to the currently 
selected style that you have not yet applied, you will be asked to do so before exiting.

Apply

Press this button to apply all the changes you have made to the currently selected label 
style. You should apply your changes before switching to select a different style or 
closing the dialog box. If you forget, you will be asked whether to apply or discard the 
changes before going on.

The selected label style
The selected label style is similar in function to the selected figure style described in 
the previous chapter.

To view a different style
1. Choose a different style by name from the style list box by clicking on the current 

style name.
or

2. Use the style drop menu button Styles located above the style list box to select a 
different style by its appearance.

When you choose a different style, the controls reflect the properties of the style and 
the style model at the upper left displays a sample of the style with its current 
properties.

If you attempt to switch styles after making changes to the current style properties but 
before you apply those changes to the style, you will be asked whether you want to 
apply the changes before switching to the new style.
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180 Chapter 11: Label Styles
Label Styles: General
Use the General tab of the Define Label Styles dialog box to view and edit the basic 
properties of the selected label style such as its description, default dimensions, and 
colors.

Description

The description is a short text description of the style. This description is displayed in 
the status bar when the style is selected.

Width

Enter the default width for labels of this style here. This field is not particularly 
important for labels because they resize automatically to fit their text.

Height

Enter the default height for labels of this style here. This field is not particularly 
important for labels because they resize automatically to fit their text.

From Selected

Rather than typing dimensions for Width and Height, you can select a single figure or 
label before entering the label style dialog box, then press this button to use the width 
and height of that object as the style’s defaults. This button will be grayed unless a 
single figure is selected in your diagram when you invoke the dialog box.
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Label Styles: General 181
Text color

To change the color of the text for label of this style, choose a color from the color 
selection drop menu. If you select a color that cannot be drawn solid, Windows draws 
the text in the nearest solid color.

Bind to style

When this property is checked, any object created with this style is automatically 
bound to the style. This means that if the style changes in the future, the object will 
change as well. If an object is not bound to the style, future changes to the style will 
not effect the object.

In drop menu

If this button is checked, the style appears in the label style drop menus, otherwise it 
does not. This is the same as checking Menu in the Choose a Label Style dialog box 
(see page 52).

Style bar button

If this button is checked, a button with a representation of the style is included in on the 
style bar. Style bar buttons are useful for frequently used styles. Because the 
representation on a style bar button is not exact (contains no color or line thickness), 
they are not useful for every style. This is the same as checking Button in the Choose a 
Label Style dialog box (see page 52).
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182 Chapter 11: Label Styles
Label Styles: Text
Use the Text tab of the Define Label Styles dialog box to view and edit the style’s text 
and the properties of the style that affect the display and format of the text.

Text

The text control to the right of the model displays the text that is contained in the 
figure in the selected text region. The text here can be edited using the usual Windows 
edit box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
figure itself. 

Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.
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Label Styles: Text 183
Text color

To change the color of the figure’s text, choose a different color from the color 
selection drop menu. If you select a color that cannot be drawn solid, Windows draws 
the text in the nearest solid color.

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. This method also allows you to 
preview a sample of the font as you select it. Controls in this dialog are self-
explanatory.
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184 Chapter 11: Label Styles
Label Styles: Behaviors
Use the Behaviors tab of the Define Label Styles dialog box to view and edit the 
properties that affect the way labels of this style behave within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the figure. 
If set to Prevent, additional characters are not allowed. If set to Expand, the figure 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the figure 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the figure expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the figure. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a figure of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the figure automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.
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Label Styles: Behaviors 185
Vertical expansion

This property controls in which direction the figure expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the figure. 

Horizontal center snaps to grid

It is generally best to disable this property for labels.

Vertical center snaps to grid

It is generally best to disable this property for labels.

Width snaps to grid

It is generally best to disable this property for labels.

Height snaps to grid

It is generally best to disable this property for labels.

Left and right edges snap to grid

It is generally best to disable this property for labels.

Top and bottom edges snap to grid

It is generally best to disable this property for labels.

Center stationary when resizing horizontally

Check this property to cause the center of the label to remain in the same place when 
you resize it horizontally by dragging the handles. 

Center stationary when resizing vertically

Check this property to cause the center of the label to remain in the same place when 
you resize it vertically by dragging the handles. 

Keep sized to text

When this property is checked, the figure is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a figure such that the figure has less 
text than it had before, the figure will automatically resize itself to shrink down around 
the new text as soon as you complete editing the text.

Automatic Text Scaling

When this property is checked, the label text scales automatically when you resize the 
label. Labels having this property always maintain a fixed aspect ratio (height vs. 
width).
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186 Chapter 11: Label Styles
Label Styles: Tabs
Use the Tabs tab of the Label Styles dialog box to view and edit the style’s tab stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.

Clear

Click to remove the highlighted tab stop from the tab stop list.
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Connector Label Styles 187
Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a style must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.

Connector Label Styles
Connector labels are just ordinary labels and do not require a new kind of style. You 
can create a connector label from any label style. A connector label has a few added 
restrictions that a standard label does not have. For instance, a connector label is 
always center-justified vertically and horizontally and always expands when text is 
added and always grows from the center. The corresponding style properties are 
ignored for connector labels.

Using a Label in your Flow Chart to Define a Style
When you create a label in your flow chart, it will start out as defined by the style you 
chose to base it on. You may then set the properties of that new label in special ways 
such as giving it a specific color, or a new font size. Once you have altered the label 
you may then want to update the style it was based on to reflect the changes such that 
all existing objects of that style, and all new objects of that style reflect the properties 
of the label.

Update Style From
With the Update Style From feature you can use an existing label to redefine the style 
that it was created from.

To update a style based on an existing label of the style
1. Right-click on the label and choose Update Style From.. from the right-click 

menu.
OR

2. Select the label and choose Update Style From.. from the Labels menu.

New Style From
With the New Style From feature you can use an existing label to define a new style.
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188 Chapter 11: Label Styles
To define a new style based on an existing label 
1. Right-click on the label and choose New Style From.. from the right-click menu.

OR

2. Select the label and choose New Style From.. from the Labels menu.
3. Enter a name for the style when prompted. 

Reapplying a Label Style
Use the Reapply Style feature to restore a label to the properties of its initial style. This 
will work for any label with an associated style. Only those labels that were created 
from a style have an associated style unless you assign one yourself. When you simply 
click on the Text tool rather than using a test style button to create a label, that label 
will not have an associated style. You can review and change the associated style in the 
Label Properties screen.

To reapply the properties of the original style to one of more labels 
1. Select one or more labels that have an associated style.
2. Right-click on the label and choose Reapply Style from the right-click menu.

OR

3. Choose Reapply Style from the Labels menu.

NOTE: Certain properties that are judged to be critical to a specific object will not 
be restored from the style when you reapply. One example is the node text. 
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CHAPTER

12 Connector Styles 

Connector styles define the initial characteristics and behaviors of connectors. This chapter 
describes how to define, create, modify and delete connector styles.

To work with connector styles choose Styles from the Connectors menu. If no styles are 
defined, you are immediately prompted to create a new style. If any styles are defined, the 
Define Connector Styles dialog box appears.

Connector Styles: Common Controls
The Define Connector Styles dialog box contains tabs for General. Line, and Ends styles 
which are described in following sections. This section describes the dialog controls that 
are always visible.

Model

The upper left corner of the dialog box contains a model of the connector style. The model 
is an illustration of how a connector of this style will appear in your diagram. As you 
modify style attributes that affect the appearance of the style, the model helps you to 
visualize the outcome.
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190 Chapter 12: Connector Styles
Style Selection

Below the model is a list box containing names of all the connector styles presently 
included in your diagram. The style that is selected is the one being shown in the 
model and reflected throughout all the other controls in the dialog box. When you 
make a change, this is the style that is altered.

Above the list box is a button labeled Styles that provides a drop menu for changing 
the selected style.

New

Press this button to create a new style. The New Connector Style dialog box appears to 
prompt for the name of the new style.

Press OK immediately to accept the default name, or enter a more descriptive name of 
your own. The name must not match the name of any existing style.

We strongly recommend that you enter a descriptive name for the style. This will help 
you remember the style’s purpose. Now is the time to do it, because if you want to 
change the name later, the only way to do it is to copy the style to one of a new name 
and delete the old style. This can be inconvenient because you may have to go back 
and define and existing objects of the old style to the new style (by editing its 
properties).

Copy

Press this button to create a new style that is a copy of the current style. Enter a 
descriptive name for the style as with New above.

Rename

Press this button to change the name of a style. 

Delete

Press this button to delete the currently selected style. You will be asked to confirm the 
deletion before it takes effect. Be very careful. Deleting a style cannot be undone. If 
you have any doubts, save your diagram before deleting any styles.

When you delete a style, any objects in the diagram that were created with this style 
and bound to it become unbound. 
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Connector Styles: Common Controls 191
Close

Press this button to exit the dialog box. If you have made changes to the currently 
selected style that you have not yet applied, you will be asked to do so before exiting.

Apply

Press this button to apply all the changes you have made to the currently selected 
connector style. You should apply your changes before switching to select a different 
style or closing the dialog box. If you forget, you will be asked whether to apply or 
discard the changes before going on.

The selected connector style
The selected connector style is similar in function to the selected figure style described 
in a previous chapter.

To view a different style
1. Choose a different style by name from the style list box by clicking on the current 

style name.
or

2. Use the style drop menu button Styles located above the style list box to select a 
different style by its appearance.

When you choose a different style, the controls reflect the properties of the style and 
the style model at the upper left displays a sample of the style with its current 
properties.

If you attempt to switch styles after making changes to the current style properties but 
before you apply those changes to the style, you will be asked whether you want to 
apply the changes before switching to the new style.
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192 Chapter 12: Connector Styles
Connector Styles: General
Use the General tab of the Define Connector Styles dialog box to view and edit the 
basic properties of the selected connector style.

Description

The description is a short text description of the style. This description is displayed in 
the status bar when the style is selected.

Bind to style

Check this box to choose whether or not a connector’s properties are bound to the 
style. If a connector’s properties are bound to its style, then anytime the style 
properties change, the connector gets the new properties automatically. You will 
generally want to set this option for normal connector.

In drop menu

Check this box to have this style appear in the Connectors style drop menu.

Style bar button

Check this box to have the style appear on a button on the style bar.

Orthogonal

This property can provide some assistance in creating and keeping connectors 
orthogonal (all lines vertical or horizontal). Guided provides adequate help for most 
cases. 
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Connector Styles: Line 193
Connector Styles: Line
Use the Line tab of the Define Connector Styles dialog box to view and edit the line of 
the selected connector style.

Line

A connector line can be one of many line styles such as solid, dashed, dotted, and so 
on. To change the connector’s line style, choose a new line style from the drop menu.

Color

To change the color of the connector, choose a different color from the color selection 
drop menu. Use of this drop menu is described elsewhere (see  Choosing Colors on 
page 39).

Width

To change the line width of the connector, enter a width or use the up and down spin 
buttons. You can also choose a standard width by clicking on the drop menu.

Curvature

Select one of the curvature options for the connector. The path of the connector can be 
straight, curved. smoothed, rounded, or arced (see  Curved Connectors on page 97).

Corners

Choose a corner style (also known as a line join style). These options apply to the way 
that thick straight connectors appear when two segments meet. Note that corners will 
appear rounded when imported into other documents.
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194 Chapter 12: Connector Styles
Flow symbols along line

Check this box to enable flow symbols to be drawn along the path of the connector.

Kind

Choose the kind of flow symbol from the flow symbol drop menu.

Fill color

Choose a fill color for the flow symbols. 

Border color

Choose a border color for the flow symbols.

Size

Choose the size for the flow symbols.

Spacing

Choose the spacing interval between flow symbols.

Border width

Choose the line width of the borders of the flow symbols.
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Connector Styles: Ends 195
Connector Styles: Ends
Use the Ends tab of the Define Connector Styles dialog box to view and edit the 
appearance of the symbols that are drawn at the ends of the connector (such as 
arrowheads).

End 1

To change the originating end of the connector, choose a color, size, and end symbol.

Symbol

Select an end symbol shape from the end symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the End Symbol Gallery.

Fill color

Choose a fill color for this end symbol.
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196 Chapter 12: Connector Styles
Symbol size

Choose a size for this end symbol.

End 2

To change the terminating end of the connector, choose a color, size, and end symbol.

Symbol

Select an end symbol shape from the end symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the End Symbol Gallery.

Fill color

Choose a fill color for this end symbol.

Symbol size

Choose a size for this end symbol.

Borders

To change the width of the borders around the connector ends, enter a border width or 
use the up and down spin buttons.
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The End Symbol Gallery 197
The End Symbol Gallery
The End Symbol Gallery is a library of the pre-defined end symbols (arrowheads and 
such) available to your diagram. Use the end symbol gallery to select an end symbol to 
use as the shape of a connector’s arrowhead.

The end symbols
The program comes with an initial collection of end symbols including a number of 
built-in arrows that are always visible in the drop menu. These are categorized by 
shape and by diagram type. You can add new symbols to your gallery by obtaining 
extension packs from the publisher.

End symbols are stored in .EDE files (one per category) on your hard disk in the 
program’s Symbols folder. These are ASCII text files that you can use to create new 
symbols. For a complete reference to creating and editing custom symbols see the 
Formats and Customization Guide available for download on the Pacestar Software 
web page.

Using the End Symbol Gallery dialog box
Invoke the End Symbol Gallery dialog box to find, preview, and select an end symbol.

The dialog box displays the installed end symbols. The highlighted box indicates the 
selected symbol. At the left is a list of categories.

Select a symbol by clicking on it and pressing OK, or just be double-clicking on it.
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Connector Styles: Behaviors
Use the Behaviors tab of the Connector Styles dialog box to view and edit the 
properties that affect the way connectors of this style behave within your diagram.

Do not treat as a flow (no drop-ins)

When checked, “flow” properties will be disabled for connectors of this style. For 
example, you will not be able to drop a new or existing figure into the flow of the 
connector automatically connecting the figure in-line with the connector. This 
behavior only has meaning if the “Snap figures into flows” option is enabled in the 
Snap Labels section under Edit in the Tools Options screen. This property is useful 
when a path is used as a simple line rather than for connecting nodes.

No crossovers (jogs)

When checked, this connector will not use jogs when crossing over other connectors, 
nor will other connectors use jogs when crossing over this connector. This behavior 
only has meaning if jogs are enabled in the diagram properties (see Diagram Properties 
Paths). This property is useful when a connector is used as a simple line rather than for 
connecting figures.
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Connector Styles: Auto-Label 199
Connector Styles: Auto-Label
Use the Auto-Label tab of the Define Connector Styles dialog box to view and edit the 
properties that affect the automatic labeling of connectors created with this style.

Automatically add a default label upon creation

Check this box to cause connectors of this style to be labeled with default text 
automatically when created. The label’s style and hence its size, color, font and so on 
are controlled by the current Connector Label Style defined in the Labels tab of the 
Diagram Properties dialog box.

Label Text

Enter the default text of the auto-label. 

Position

Select whether the automatically created label will appear in-line or alongside the 
connector above or below (or to the right or left of vertical connectors). The label will 
always be centered along the length of the connector and the text will be center-
justified. Also note that if you create the connector with multiple segments, the label 
will appear on the first segment. 
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Connector Styles: Stamp
Use the Stamp tab of the Define Connector Styles dialog box to control how a 
connector of the style gets created. Whereas normally a connector is created by 
clicking one endpoint then the other, it can also be created as a stamp with a 
predetermined length and orientation. Use this dialog box to define these attributes.

Automatically add a default label upon creation

Checking this property allows you to create connectors of this style as a stamp similar 
to how you create figures. In other words, when you select the label style and enter 
connect mode, the cursor will become a representation of a fixed size segment of the 
connector that you can “stamp” onto your diagram rather than clicking twice to define 
the endpoints of the connector. 

Length

A stamp connector requires a fixed (non-zero) length. This is the size of the connector 
that will be created when you stamp it onto your diagram. 

Orientation

A stamp connector requires an orientation. The stamp connector can point in any of the 
directions provided. 

NOTE: Note that the stamp attribute controls only how a connector is created. Once 
it is created it is identical to any other connector and can be adjusted in any 
of the usual ways.
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Using a Connector in your Flow Chart to Define a Style 201
Using a Connector in your Flow Chart to Define a Style
When you create a connector in your flow chart, it will start out as defined by the style 
you chose to base it on. You may then set the properties of that new connector in 
special ways such as giving it a specific color. Once you have altered the connector 
you may then want to update the style it was based on to reflect the changes such that 
all existing objects of that style, and all new objects of that style reflect its properties.

Update Style From
With the Update Style From feature you can use an existing connector to redefine the 
style that it was created from.

To update a style based on an existing connector of the style
1. Right-click on the connector and choose Update Style From.. from the right-click 

menu.
OR

2. Select the connector and choose Update Style From.. from the Connectors 
menu.

New Style From
With the New Style From feature you can use an existing connector to define a new 
style.

To define a new style based on an existing connector 
1. Right-click on the connector and choose New Style From.. from the right-click 

menu.
OR

2. Select the connector and choose New Style From.. from the Connectors menu.
3. Enter a name for the style when prompted. 

Reapplying a Connector Style
Use the Reapply Style feature to restore a connector to the properties of its initial style. 
This will work for any connector with an associated style. Most connectors do have an 
associated style because they were created by choosing from a style. You can review 
and change the associated style in the Connector Properties screen. 
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202 Chapter 12: Connector Styles
To reapply the properties of the original style to one of more connectors 
1. Select one or more connectors that have an associated style.
2. Right-click on a connector and choose Reapply Style from the right-click menu.

OR

3. Choose Reapply Style From.. from the Connectors menu.

NOTE: Certain properties that are judged to be critical to a specific object will not 
be restored from the style when you reapply. One example is the connector’s 
curvature. 
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 202 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



203
CHAPTER

13 Groups

You can combine diagram objects into a group so you can work with them as though they 
were a single object. You can then move, copy, delete, and resize the group as a single unit. 
You can also use groups to apply property changes to all of the included objects without 
being required to select each object separately. Groups are convenient for positioning and 
aligning objects as a set as well, and you can even create groups containing other groups to 
help you construct complex diagrams.

Creating a Group
You can create a group from almost any set of objects from your diagram using the Group 
feature.

To create a group
1. Select a number of objects or existing groups. You can use the lasso selection to select 

objects within a rectangular area and/or use Shift-Click to add other objects to the 
selection. 

2. Choose the Group command from the Grouping submenu of the main Edit menu, or 
from the right click menu, or use the hot key combination Ctrl-G.

3. The newly created group will now appear as a single selectable item. 

When you create a new group, two changes will automatically take place to the set of 
objects making up the group. First, certain objects may be excluded or included despite 
whether they were selected or not; this occurs to preserve other relationships between 
objects. Also, the members of the group become re-ordered with respect to objects outside 
the group such that all objects in the group are immediately in front of, or behind one 
another. The objects within the group will retain their relative ordering so the re-ordering 
will rarely be noticed. 
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204 Chapter 13: Groups
Breaking Apart a Group
You can break a group apart into its original components using the Ungroup and 
Ungroup All commands.

To break a group apart
1. Select the group (or groups).
2. Choose the Ungroup command from the Grouping submenu of the main Edit 

menu, or from the right click menu, or use the hot key combination Ctrl-U.
3. Each selected group will be broken apart leaving the components as individual 

objects once again. If the group was composed of other groups, those groups will 
once again be accessible as individual groups. 

To break a group apart completely
1. Select the group (or groups).
2. Choose the Ungroup All command from the Grouping submenu of the main Edit 

menu, or from the right click menu.
3. Each selected group will be broken apart leaving the components as individual 

objects once again. If the group was composed of other groups, those groups will 
also be broken apart, and so on until the selection contains no more groups just 
individual ungrouped objects.

Ungroup All is the same as doing Ungroup repeatedly until all groups and nested 
groups, and nested groups and so on are broken apart. The only difference is that the 
Regroup feature described below is not available following Ungroup All.

Re-establishing a Group
You can use the Regroup feature to re-establish a single group that you just broke 
apart. You can also accomplish this by immediately undoing the Ungroup command 
but the Regroup feature provides the added capability to re-establish the group after 
performing additional steps. The most common usage of Regroup is to temporarily 
break apart a group for the purpose of editing some components individually 
(changing their size, position, color etc.). The regroup feature makes this common task 
easier and less error prone because you don’t need to remember exactly which objects 
were in the group and then select then afterwards without error to regroup them.

Note that you can only regroup a single group, the last group that you ungrouped 
individually. Therefore, to have the option of regrouping a group, select a single group 
and ungroup it alone, not within a selection containing other groups, and not using the 
Ungroup All.
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Working with Groups 205
To re-establish the more recent group
1. Right click either with nothing selected or on an object that belonged to the group 

and select Regroup from the menu.
2. The original group will be re-established with all of its members. 

You can regroup the last ungrouped group only until you perform a function that 
affects the identify of the group or its members. These include deleting an original 
member of the group, creating any new group, or performing another Ungroup or 
Ungroup All. If Regroup is not available in the menu, you will need to select the 
members of the group again and use the Group feature to re-establish the group.

Working with Groups
With most operations you can treat a group as if it were a normal diagram object. You 
can select it, move, copy, and delete it in all of the usual ways. In most respects, once 
individual objects are placed within a group, their individual properties are no longer 
accessible and you cannot perform operations such as moving, resizing, or editing the 
individual object. Some exceptions exist for added convenience. They are described in 
the following sections as well as some special properties and behaviors of groups.

Selecting Groups
Select groups by clicking on any item that is a member of the group. You can also 
select groups using the lasso select but only groups that are entirely within the lasso 
rectangle become selected.

Aligning, Spacing, and Centering Groups
When aligning, spacing evenly, or centering on page, a group of objects will be treated 
as it if were one object. For example, if you select two groups and left align them, the 
left edge of one group will become aligned with the left edge of the other. The left edge 
is identified by the left most edge of the left most member of the group.To change the 
relative alignment and spacing of members of a group you must ungroup them first.

Changing Properties of Group Members
You can change properties (such as fill color, line widths, and so on) of individual 
group members while they remained grouped. However, you must apply any property 
changes to all members of the group or none. You can select a group and attempt to 
change properties of objects within it by using the toolbar buttons or the Properties 
commands located in the main menus, but the right click menu will not provide access 
to properties in its usual way. When you apply property changes to a group, you will be 
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206 Chapter 13: Groups
asked whether to apply the changes to the group members or not. You may answer how 
you like and you can also choose to make your answer permanent to future questions 
of the same nature by checking the “Don’t ask again” box. If you tell it not to ask 
again, you can later change your mind by unchecking the option “Prompt to apply 
property edits to selected objects” located in the Tools Options dialog box at the 
bottom of the General area.

Individual Operations Allowed for Group Members
Even though objects are placed in a group, there are certain operations still allowed on 
the member objects.

Hyperlinks: If a grouped object contained a hyperlink, you can still follow the link 
by double-clicking on the object. However, you will not be able to right click on it 
and select the Follow Link feature.
Text Editing: You can edit the text of a grouped object using the text tool in the 
usual ways. Methods other than the text tool cannot be used to edit the text of 
grouped objects. Text can however be changed indirectly by using the Find and 
Replace feature. 
Connecting: You can connect to grouped objects in the usual way as if they were 
not in a group. 

Resizing and Scaling Groups
Groups can be resized as if they were one item. To resize a group, drag one of the eight 
red resize handles as you would with an ordinary object. When you resize a group, all 
objects in the group scale including the text, line widths, connectors and so on. 

There are some special considerations to keep in mind when resizing groups:

Unlike most ordinary objects, a can only be resized to keep the same aspect ratio. 
It cannot be stretched more in one direction than another.
When making a group smaller, the minimum size of the group is determined by 
the smallest text (or text attribute) of any member of the group. For example, the 
minimum text size allowed by the program is 4 points. If one of the objects within 
the group contains 8 pt text, the whole group can only be shrunk by 50%.
If you shrink and then expand the size of a group back to its original size, it is 
possible that all aspects of the group may not end up exactly as they began. This is 
especially true of line widths and text sizes which can lose resolution when scaled 
too small.
After resizing a group you may have to manually adjust some lines to make sure 
they are straight. The program will attempt to keep most lines straight through a 
group resize, but some, particularly non-center connections may require manual 
adjustment.
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CHAPTER

14LAYERS

In addition to the foreground layer of a diagram, you may also choose to add a background 
layer. Objects, labels, and graphics contained within the background layer appear behind 
the foreground of the diagram but are unaffected by normal editing. 

Typically a background layer may contain:

A solid colored backdrop
A gradient backdrop for a 3D appearance
A graphic image such as a company logo or watermark
Informational text such as headers or footers 

Using foreground and background layers is simple. Use the View menu to switch the active 
layer between Normal, Foreground, or Background then edit objects normally within the 
active layer. Normal is a special view in which the foreground and background layers are 
both visible, but only objects in the foreground layer can be edited. Typically, you’ll do 
most of your diagram editing in the Normal layer view and switch to the Background layer 
view temporarily to create or edit the background.

Background layer object
(cannot be edited in 

Normal view)

Foreground layer objects
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208 Chapter 14: Layers
NOTE: When a diagram consists of multiple sheets, each sheet has a distinct 
background. There is no common shared background. To implement a 
common background, copy the background of an existing sheet when you 
create a new sheet.

To switch the active layer view
1. Select Normal from the View menu to display both the foreground and 

background layers. Only objects in the foreground layer will be editable. 
2. Select Foreground from the View menu to display only the foreground layer. 

Only objects in the foreground layer will be editable. 
3. Select Background from the View menu to display only the background layer. 

Only objects in the background layer will be editable. 

To move objects between layers
1. Select object(s) in the active view. 
2. Cut or Copy the selected objects.
3. Switch the active layer. 
4. Paste the objects into the active view.

NOTE: The foreground and background layers should not be confused with the 
ordering features such as Front and Back. The ordering features control the 
order of objects within the active layer. If for example, you move an object 
to the Back from within the foreground layer view, it will then appear 
behind all other objects in the foreground layer, but it will still appear in 
front of the background layer and all objects contained within the 
background layer. Consider that the entire background layer is drawn before 
anything in the foreground layer is drawn.

Selecting Objects from Multiple Layers
In Normal layer view and Foreground layer view, most selection operations will only 
select objects belonging to the foreground layer. Likewise in Background layer view, 
most selection operations will only select objects belonging to the background layer.

There are two exceptions that allow the selection of objects from multiple layers 
simultaneously. The Select All feature (available from the Edit menu or by using the 
Ctrl-A shortcut key) selects all objects in diagram including both foreground and 
background objects. And lasso selection from within the Normal layer view can be 
made to select objects from all layers within the selection lasso (including background 
objects) by holding down the Alt key simultaneously to performing the selection.
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Working with Groups 209
Selecting objects from multiple layers can be useful when copying or exporting 
selections in which you prefer to include both foreground and the background objects. 

Copying Objects from Multiple Layers
When a diagram contains foreground and background objects, copy operations require 
special attention. Selecting only foreground objects (not selecting the underlying 
background objects) causes only the foreground objects to be copied. The background 
objects will not appear behind them when you paste the copied selection into another 
document. To include the background objects as well, use the Alt+Lasso Selection 
method described in the previous selection to select both the foreground and 
background objects. The bounds of the entire selection (foreground and background 
objects) will define the size and extent of the copied area.

In the special case where the background objects are larger than the foreground object 
selection, you may prefer to include the background layer only partially, as a backdrop 
to the selection, cropped to the selection rectangle but not necessarily including the 
entire background object extents. In this case, you will need to use the Export feature 
instead of Copy as described in the following section.

Copy or Export
(foreground and background

Copy, Export, Save As
(no objects selected) 

objects selected by using Alt-lasso) 
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210 Chapter 14: Layers
Exporting Objects from Multiple Layers
Exporting objects from multiple layers also requires some special considerations. 
When exporting an entire diagram sheet, with no selection, the result of the export is 
exactly as you would expect. The foreground objects appear on top with the 
background objects beneath, just like the normal view on the screen, and just like 
when printing. However, when exporting a selection, the exported contents will 
normally contain only the selected objects, just as described in the previous section in 
regard to the Copy operation. 

However, exporting a selection allows an additional option that in some cases is more 
in keeping with the true intent of the background layer. When you export a selection 
and the selection contains any unselected background objects behind it, the export 
screen will include a “Background” checkbox which allows you the choice of 
including the background objects cropped to the selection rectangle. Unlike copying, 
where background objects must be selected to be included (thus expanding the copied 
rectangle if the background objects are larger than the foreground selection), this 
option allows the background to appear partially, as a simple backdrop image behind 
the foreground objects, and cropped to the rectangle defined by the export selection 
rather than contributing to it.

Export

Copy or Export
(foreground objects selected) 

background objects not selected, 
(foreground object selected,

“Background” export option checked)
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CHAPTER

15 Hyperlinks

Hyperlinks make it possible to link any figure in your diagram to another diagram, a 
document of a different application, or to a web page. They work a lot like hypertext links 
on the internet except that it’s the figure that contains the link rather than the text.

With hyperlinks you can enhance your diagrams in these ways:

Link a figure to another diagram. When you double click on the figure, the linked 
diagram opens in another window much like how an internet browser works. This is 
especially useful for expanding the detail of a figure (such as a process) into an entirely 
separate diagram.
Link a figure to a document. For example, you can link a figure to a spreadsheet that 
contains data relating to that figure. When you double-click on the figure, the 
document opens in its proper application (Microsoft Excel for example).
Link a figure to a web page (URL). When you double click on the figure, your browser 
is launched at the appropriate web page.

NOTE: Hyperlinks are an extension of this tool and are not part of most standard 
diagramming specifications. In fact some such specifications advise against 
using such features because they make diagrams dependent on specific tools and 
therefore less portable. We recommend that you use hyperlinks to create 
shortcuts and to supplement your diagrams rather than creating a dependency 
upon them. With this in mind, you can quite easily develop diagrams that stand 
on their own without any hyperlinks, and still make full use of hyperlinks to add 
shortcuts for navigation between diagrams, to organize related documents, and to 
reference web pages and internet resources.

The following features permit you to set hyperlinks for figures, open hyperlinks to navigate 
between diagrams and documents, and maintain a rudimentary history of diagram links for 
backtracking.
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212 Chapter 15: Hyperlinks
Setting a Hyperlink
Any figure or label can contain one (and only one) hyperlink to another diagram, 
document, or web page.

To link a figure or label to another diagram or document
1. Select one figure or label.
2. Choose Set Hyperlink from the Figures (or Labels) menu, or right-click the 

figure and choose Set Hyperlink.
3. Use the dialog box to select a file (diagram or document) for the hyperlink or 

replace a previous hyperlink. You can also use the Remove button to eliminate the 
hyperlink.

NOTE: It’s a good practice to keep all diagrams and documents that have links to 
one another in one folder. Doing so will make it much easier to move the set 
of diagrams to another folder. The reason is that links are stored as full path 
names (e.g. “C:\DATA\ABC.EDG”) unless both the diagram that contains 
the link, and the link diagram or document are in the same folder. Whenever 
you move a diagram or set of diagrams, you will have to manually re-adjust 
each link UNLESS all inter-linked diagrams are in the same folder.

Setting a Hyperlink to a Web Page
Setting a hyperlink to a web page is the same as setting a hyperlink to a document. 
Follow the procedure above but instead of specifying a document on your hard disk or 
network, instead specify a web address (URL). 

A hyperlink to a web page requires the full web address including the filename and 
extension. For example, to link to our main web page you will need to specify a 
hyperlink as “http://www.pacestar.com/index.html” rather than simply “http://
www.pacestar.com”. If you do not specify a web page file and extension Windows will 
not know that it should open your browser and send the web address.
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Opening a Hyperlink to a Diagram or Document 213
Opening a Hyperlink to a Diagram or Document
When a figure or label contains a hyperlink to another diagram or to a document, you 
can open or follow that hyperlink to cause the link diagram to be opened in place of the 
current diagram. If the link is to a document other than another diagram, following the 
hyperlink will open that document.

To follow a hyperlink to another diagram or document
1. Make sure you are in Select mode (or Seltext mode)
2. Move the mouse cursor over a figure or label that contains a hyperlink. The figure 

or label can be selected or not selected. The cursor will show a combination hand 
and move cursor and the status bar will indicate the name of the diagram or 
document that will be opened if you double-click.

3. Double click the mouse on the figure or label. If the hyperlink is to another 
diagram, the current diagram will be saved automatically if it has been modified 
and the linked diagram will be opened in its place. If the hyperlink is to a 
document, that document will be opened.

alternately

1. Select the figure or label
2. Choose Open Hyperlink from the Figures (or Labels) menu 

Following hyperlinks to documents other than diagrams makes use of Windows file 
associations. The extension of the link file must be known to Windows as being 
associated to a program. Once the program is identified, Windows will launch it with 
an “open” action on the specified document. In order for this to work, you must have 
the file association set-up in advance. To set a file association, choose “View” and 
“Folder Options” under My Computer. Refer to your Windows documentation for 
further details.

NOTE: If the current diagram is maximized and you follow a hyperlink to another 
diagram, the new diagram will replace the current diagram which will be 
saved automatically and closed. If the current diagram is not maximized, the 
new diagram will be opened in another window and the current diagram will 
not be affected.
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214 Chapter 15: Hyperlinks
Returning to the Parent of a Diagram
When you open a hyperlink to a diagram for the first time, the original diagram 
becomes the parent of the diagram.

To return to the parent of a diagram 
Click on the Go To Parent button in the toolbar - it looks like an upward pointing 
arrow.

alternately

Choose Open Parent Hyperlink from the Tools menu.

To manually set the parent of a diagram
1. Choose Set Parent Hyperlink from the Tools menu
2. Select a diagram to be the new parent of a diagram or press Remove to eliminate 

the parent hyperlink.

Moving Back and Forward Among Previous Diagrams
When you move between diagrams by opening hyperlinks, you can use the Back and 
Forward features to return to diagrams that you previously visited.

To go back to the previously visited diagram, choose Back Hyperlink from the Tools 
menu, or press the Back Hyperlink button on the toolbar - it is a small link symbol with 
a blue arrow pointing left.

To go forward to the diagram that you left with Back, choose Forward Hyperlink from 
the Tools menu, or press the Forward Hyperlink button on the toolbar - it is a small 
link symbol with a blue arrow pointing right.
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CHAPTER

16 Tools 

The Tools menu contains a variety of tools for manipulating diagrams and controlling 
program options.

Scale
Choose Scale from the Tools menu to access the diagram scaling feature.This feature 
allows you to scale the entire diagram or any part of it to any desired size. Scaling the 
diagram will actually make the objects larger or smaller when printed, unlike zoom which 
affects only how the objects appear on the screen.

To scale the diagram or any part of the diagram
1. Select the objects you want to scale if you want to scale only a portion of the diagram. 

If no objects are selected, all objects in your diagram will be scaled.
2. Choose Scale from the Tools menu.
3. The Scale Diagram dialog box will appear. Choose the proper options and press OK to 

scale the diagram.

Scale

Enter the percentage to scale the diagram or use the spin buttons to increase or decrease the 
percentage. A percentage of 50% makes the diagram objects half as big while a percentage 
of 200% makes them twice as big.
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216 Chapter 16: Tools
To page

Click this box to force the diagram to be scaled so that it fills the center of the currently 
defined page (or all the poster pages). 

Include

Choose the parts of the diagram that will be scaled in addition to the figures. You can 
choose to scale figure border widths, connector widths, figure and label text size, drop 
shadows (for the entire diagram).

Scale Styles

If checked the diagram’s styles will be scaled as well as the objects in the diagram so 
that objects created will reflect the new scale as well. Scaling styles is not undoable so 
you may want to save a copy of your diagram before using this option.

NOTE: Scaling the diagram is also useful for producing scaled printer output. Save 
the diagram, scale it how you like, print the result, then restore the original.

Importing Graphics
This program supports several methods of importing graphics such as images and clip 
art from other programs and from disk. The simplest method, that of simply cutting 
and pasting a graphic picture from another program into a diagram, has been covered 
in another section (see  Pasting Objects on page 32). This section describes how to 
import graphic files directly from disk without necessarily using another program.

Supported graphics file types
There are many different file types that may contain graphics or clip art. Each graphics 
file type is considered either raster (bitmap) or vector (scalable). Either type can be 
resized, but when you resize bitmaps, they tend to distort and become unattractive. 
Scalable vector graphics are popular because they scale smoothly. 

This program can import several popular bitmap graphics formats including:

Windows Bitmaps (.BMP)
Windows Device-Independent Bitmaps (.DIB)
JPEG Bitmaps (.JPG). 
Graphic Interchange Format Bitmaps (.GIF)
Portable Network Graphics Bitmaps (.PNG)
PaintBrush Bitmaps (.PCX)

This program can also import scalable vector graphics formats including:

Windows Metafiles (.WMF)
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Importing Graphics 217
Windows Enhanced Metafiles (.EMF). 
There are other graphics file types which you might come across that cannot be 
imported directly. For example, there are Encapsulated Postscript (*.EPS) files, 
Computer Graphics Metafiles (*.CGM), and so on. Even though you cannot import 
these directly, you can still use them fairly easily. One way of importing such files is to 
load them into another program, copy them to the clipboard, then paste them into a 
diagram. There are also many programs that will let you import all different graphics 
types and then export as one of the supported import formats.

Inserting graphics
You can import supported graphics files directly from disk by using the Insert Graphic 
feature in the Figures menu or equivalently with the Import Graphic feature in the 
Tools menu. The Import Graphic Dialog box looks like this:

To insert a graphic into your diagram
1. Choose Insert Graphic from the Figures menu or the right click menu.
2. Select the file that you wish to insert and choose the Graphics Importation 

Options that work best for the particular file (see below). 
3. Click the Import button. A new figure containing the imported graphic will appear 

in the active view.
Once you have inserted the graphic, you can manipulate it just like any other figure, 
moving, resizing, connecting, and so on.
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218 Chapter 16: Tools
Graphics Importation Options
The following options are available in the Insert Graphic dialog box and can be used to 
control how a particular graphic appears and behaves after it is imported. They are 
remembered once the dialog box is closed and remain in effect when drag-and-
dropping graphics into the diagram, and when pasting them from the clipboard.

Fitted Bounds (Recommended ON in most cases)

Checking this option causes the creation of a bounding polygon shown in flashing red 
that serves as an approximation of the boundaries of the graphic. The outlined area is 
used for two purposes neither of which affects how the image appears. The first is 
define a Hot Zone, an irregularly shaped area that delineates the edges of the image 
that are sensitive to clicking by the mouse. The second purpose of the fitted bounds is 
to provide a border where attached connectors terminate. Without the fitted bounds the 
edges of the image will reflect the simple bounding rectangle. When importing clip-art 
to use as diagram elements, we recommend enabling this feature. However, when 
importing large images for the purposes of a background, turning off this option will 
decrease the time it takes to import. 

Transparent Edges (Recommended ON in most cases)

Some graphics such as GIF files can have included transparency information which 
improves how the image will appear against a background or near other diagram 
elements. This option simulates this effect for graphics that do not have built-in 
transparency. When checked, the white space around the edges of the graphic become 
transparent. This allows you to import an image in any format and have an alternative 
to a basic rectangular image. For a good result, this feature requires that the image 
have a white background color and that the edges be fairly sharp. However, the Clean 
Background option described below may help to improve the result as well. Note that 
transparency affects only how the imported image appears, whereas the fitted bounds 
above affects only how it behaves. Often an imported image will appear and behave 
slightly differently.

Clean Background (Recommended ON in most cases)

This option supplements the Transparent Edges option above.Some clipart images 
have white backgrounds and surrounding edges, but due to the methods that produced 
the image, the background is not a single color of pure white. This condition is very 
common for images that use data compression such as JPEG files. To achieve 
acceptable results when using the Transparent Edges option, a range of near-white 
colors must be treated as pure white.When this option is checked, every color in the 
image that appears white is converted to a true white greatly improving the sharpness 
of the transparency border. In some cases, you may prefer to uncheck this option 
because it can cause white parts of the image to become transparent inadvertently.
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Exporting Graphics 219
Inserting a graphic with drag and drop
Another convenient way to insert graphics is to drag-and-drop them into your diagram.

To insert a graphic file into your diagram with Drag and Drop
1. Open a diagram. If you have more than one diagram open, make sure the one you 

want to import into is active.
2. Go to the Windows Explorer. Locate and select the graphics files that you want to 

insert into your diagram. You can use the shift key to select more than one.
3. Drag the selected files over the program and drop them (let go of the mouse 

button). The graphics will be inserted and appear as new figures in the active view. 
Note that the last Graphic Importation Options you set will affect how the 
dropped graphics appear and behave.

More about graphics
Figures that contain imported graphics will retain their shape (aspect ratio) when you 
resize them using the corner handles.

Inserted graphics are actually imported copies of images NOT links. If you cause a 
change to the graphics file, that change will not appear in your diagram unless you re-
import the file.

The fill color for imported graphic images serves as a tinting color. Initially there is no 
tint color (fill color) for the imported graphic and all of the colors are unaffected. If 
you change the tint color by selecting a fill color, the colors will appear as shades of 
the tint color.

Exporting Graphics
You can export a diagram to a disk file in a standard graphic format so that you can 
later import the diagram into a different program. Note that exporting objects does not 
remove them from your diagram.

For example, if you export a diagram to a file as a Windows Metafile, you can then use 
Microsoft Word’s Insert Picture feature to add the diagram to a Microsoft Word 
document. Or you can export a diagram as a JPG or GIF file for use on a web page.

To export the objects from your diagram to a graphics file 
1. Select all the objects that you want to be exported. If you do not select any objects, 

ALL objects in your diagram will be exported. If your diagram contains multiple 
sheets, only objects in the active sheet will be exported.

2. Choose Export Graphics from the Tools menu.
3. Select a file name and a file format and press the Save button. 
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220 Chapter 16: Tools
You can transfer diagrams and portions of diagrams to other programs more 
conveniently through the Windows clipboard by using Cut and Copy. However, there 
are a few advantages to using Export instead. Once you export a diagram to a file, you 
can easily store and transport that file. You can also use other commercially available 
programs to convert the file to other graphics formats that this program does not 
support. 

Once you export a diagram to a file, you cannot reload that file into as a diagram. The 
exported file is essentially a snapshot of the image of the diagram and does not contain 
the actual diagram definition.

Graphic Export Options
When exporting to a bitmapped graphics format, you are given an opportunity to 
specify the size of the resulting output graphic using the Graphic Export Options 
dialog box. 

Width, Height

You can choose a specific dimension in pixels by entering a desired Height and Width.

Scale

Use this control to select an image size as a percentage of “true” size. The true size is 
the size that is shown by the rulers within your diagram. For example, if you have a 
box that is one inch square as shown by the rulers in your diagram and you export it 
scaled by 200%, the resulting bitmap will be two inches by two inches when displayed 
on your monitor. Note that the size of bitmaps vary based on the device on which they 
are displayed. 
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Diagram Properties 221
Quality

Use this control to select a quality level for JPEG images. The quality can range from 
10 (lowest) to 100 (highest). Highest quality images best represent the original but they 
are also require the largest file size. The default is 85% which produces a reasonable 
file size but a very good image.

Background

Select a background color for the image. Don’t confuse this color with the page color 
(set in Tools Options) that controls the appearance of your diagram workspace.

Anti-alias (smooth)

Check this option to apply anti-aliasing (smoothing) to an exported bitmap. Anti-
aliasing removes the jagged lines and drop-outs that result from rendering a diagram 
on a low resolution bitmap. It is especially superior when scaling down the diagram 
under 100% and when creating bitmaps for display on the screen, such as web page 
graphics. Anti-aliasing is available only when exporting to a full color bitmap format 
rather than a scalable vector format. Also, anti-aliasing is not available when exporting 
as a transparent bitmap.

Diagram Properties
Each flow chart has properties that are saved with the diagram. To view and modify the 
properties of the diagram, choose Diagram Properties from the Tools menu.

The Diagram Properties dialog box contains groupings of properties organized under 
tabs with an appropriate heading. To change to a different grouping and their controls, 
press the corresponding tab. Controls located under each tab are described below.
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222 Chapter 16: Tools
Diagram Properties: General
Use the General tab in the Diagram Properties dialog box to set the diagram properties.

Disable text margin limits for decision (diamond) symbols

Check this box to use the whole rectangular bounds of diamond-shaped symbols for 
text. With the limits disabled you can fit more text into the diamond but you will have 
to manage the placement manually and keep it from overlapping the edges.
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Diagram Properties 223
Diagram Properties: Grid and Snap
Use the Grid and Snap tab in the Diagram Properties dialog box to set the visible grid 
and the snap grid for your diagram.

Show grid

Check this box to display a grid over your diagram. This box controls only the 
appearance of the grid as a visual guide, not whether objects snap to the grid. The grid 
is displayed either as dots or lines based on options set in the Options dialog box.

You can also turn the grid on and off with the grid button on the tool bar.

Spacing (for visible grid)

Choose the spacing between the drawing of grid lines in your diagram.

Snap to grid

Check this box to have your diagram objects snap to the underlying snap grid. you will 
usually want this to be the same as the visible grid and use them together. Take note 
that figures and label have a property that tells them whether that particular figure or 
label snaps to the grid. Therefore, for any particular object to snap to the grid, it must 
have it’s Snap center to grid property set and the Snap to grid diagram property must 
be set.

You can also turn snap on and off with the snap button on the tool bar.
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224 Chapter 16: Tools
Spacing (for snap grid)

Choose the spacing for snap alignment. A snap spacing that is smaller than the visible 
grid spacing works well. For instance, try a snap spacing of an eighth inch and a grid 
spacing of a quarter inch. 

Diagram Properties: Labels
Use the Labels tab in the Diagram Properties dialog box to set properties of your 
diagram relating to labels.

Connector Label Style

Select the label style to use when labeling connectors. The default is the last label style 
you used, or the first label style if none have been used.

Flow Label Style

Use the control to choose an existing label style for all flow labels or choose <none> to 
use the usual toolbar text settings. When you set any of the above to a label style and 
apply, you will be asked whether or not to apply the change to all existing labels of the 
kind. Also note that if you are placing a label of a specific style that contains default 
text, that style will prevail even if a style is defined here.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 224 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Diagram Properties 225
Figure Label Style

Use the control to choose an existing label style for all figure labels or choose <none> 
to use the usual toolbar text settings.

Primary position

The Primary Position for figure labels identifies one of the nine standard slots as the 
one to use for (a) all Auto-labels and (b) the single slot to snap to if the Snap labels to 
figure label primary position only option is enabled.

Spacing from objects

Choose the spacing between labels and the objects they label attached figures and 
connectors.

Diagram Properties: Connectors
Set diagram properties that affect the appearance of connectors and their intersections.

Rounded connectors - Corner radius

Enter the corner radius for this diagram. This is the amount of rounding that occurs for 
all corners of rounded connected (see  Rounded on page 98).
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226 Chapter 16: Tools
Jogs - Enable / Loop radius

Choose whether to enable jogs (small loops drawn when connectors intersect but do 
not interact). Also set their radius in this diagram.

Draw dots where three or more connectors meet

Check this box to cause small dots to be drawn at the point where three or more 
connectors attach to one another. These are opposite in function to jogs. These dots 
DO appear when printing.

Check this box to cause small dots to be drawn at the point where a connector attaches 
to a figure at a connection point. These dots DO appear when printing.

Draw dots where connectors attach to connection points

Check this box to cause small dots to be drawn at the point where a connector attaches 
to a figure at a connection point. These dots DO appear when printing. 
(available only if product supports connection points)

Diagram Properties: Text
Set diagram properties that affect how text is displayed and formatted.
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Diagram Properties 227
Line Spacing

Enter a value for line spacing. Single spaced is the default. Spacing applies to all text 
including labels. To set the line spacing for a single object or for a single style, use the 
Line Spacing field in the object properties Text screen or the style Text screen instead.

Margin

Text margins are the spaces between figure text and the edge of the figure. Changes 
made here will apply to all existing figure in your diagram and all figure styles and will 
not be undoable! To set the margins for a single figure or for a single style, use the 
Margin field in the figure properties Text screen or the style Text screen instead. Note 
that not all shapes support fixed margins, some require the internal margins to scale 
with the shape rather than remain constant.

Diagram Properties: Shadows
Use the Shadows tab in the Diagram Properties dialog box to change the appearance of 
drop shadows throughout your diagram.

Diffusion

Set the diffusion to a higher value to add more blurring to the shadows. Shadows 
become larger as the diffusion increases. 

Transparency

Set the transparency to a higher value to make the entire shadow appear more or less 
faded.
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228 Chapter 16: Tools
Offset

Set the offset so that drop shadows are drawn a different distance from the object. The 
offset is always positive and equidistant below and to the right. Setting the offset to 
zero with non-zero diffusion creates a halo effect around the object.

Color

To change the color of drop shadows in your diagram, choose a different color from 
the color selection drop menu. 

Customize
Toolbars are highly flexible. While most features are available by other means such as 
through menus and hot keys, toolbars offer the most convenient access to common 
features and styles. This is particularly true when you customize the toolbars to contain 
the controls you find most useful and arrange them to your personal liking.

To customize toolbars including the style bar, choose Customize from the Tools 
menu, or right click on any toolbar and choose Customize from the drop menu. The 
Customize dialog box will appear.

The Customize dialog box contains groupings of options organized under tabs with an 
appropriate heading. To change to a different grouping and their controls, press the 
corresponding tab. Unlike other similar screens, you do not need to click on OK for the 
changes you make to take effect. All changes occur immediately.

Using the Customize Dialog Box
The Customize dialog box helps you choose which toolbars are visible, select which 
buttons and controls are available, and arrange them to your preference. You can 
perform the following operations from the Customize dialog box. The operations 
described below apply regardless of which tab you are viewing unless indicated 
otherwise.

To remove a button or control from a toolbar (including the Style Bar)
Click on the button or control and drag it off the toolbar until the cursor is no longer 
over any toolbar and shows an 'x'. Then release the mouse button to remove the 
control.

To add a button or control to a toolbar
Use the Commands tab to select commands and add them to toolbars. Or use the Styles 
tab to select object styles and add them to the appropriate section of the Style Bar (see 
below).
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Customize 229
To move a button or control on a toolbar (including the Style Bar)
Click on the button or control, drag it to a new location indicated by the cursor, and 
release the mouse button. The control will be removed from its previous location and 
reposition where it was dropped.

To add spacing between buttons or controls
Click on the button or control to the right of the location where you want the space 
inserted. Drag the button to the right but not past the next control. Release the mouse 
button and the new space will appear to the left of the button. You can add only one 
space between controls. You cannot add spaces to the Style Bar.

To remove a space between buttons or controls
Click on the button or control to the right of the space that you want to remove. Drag 
the button to the left but not past the next control. Release the mouse button and the 
space will be eliminated. This does not apply to the Style Bar.
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230 Chapter 16: Tools
Using Customize Dialog Box Tabs
The previous page listed operations that are available in the Customize dialog box 
regardless of the tab selection. In addition, each tab contains some specific controls for 
further customizing toolbars. The contents of each of these tabs is described below.

Customize: Toolbar
Use the Toolbar tab to hide or show toolbars or to reset toolbars to their default layout.

Toolbars

Use the check boxes to select which toolbars are visible. The illustration to the right 
shows the location of the selected toolbar when it is visible.

Reset To Default

Select a toolbar and click the Reset to Default button to return the layout of the toolbar 
to its initial configuration. For the Style Bar, the default configuration is how the 
particular diagram or template was originally designed.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 230 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Customize 231
Customize: Commands
Use the Commands tab to add buttons and controls to toolbars. The controls and 
commands shown here can only be added to simple toolbars and NOT to the style bar.

To add a command to a control bar
Locate the command in the command list box. Select a category on the left side and 
locate the command on the right side. Then simply drag the command to the location 
on the toolbar where you want it to be positioned.

Notice that any button or control can only be located on one toolbar. If you add a 
control that is already on a toolbar, the control will be moved from the old position to 
the new position rather than being duplicated. If the command is already located on a 
toolbar it will become highlighted as you drag it.
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232 Chapter 16: Tools
Customize: Style bar
Use the Style Bar tab to customize the layout of the Style Bar including the size of 
buttons and the number of columns of each type.

Columns

Select the number of columns of buttons for each style type. You can also adjust the 
width of the entire Style Bar for complete control of the button widths (see below).

Height

Select the height of the style buttons for each type of style. Choose a height that 
permits proper display of the styles but also displays as many as possible on the screen.

Drop down lists

The drop down lists are useful for displaying style names as well as for selecting styles 
that may not be available on a button or even some that may not be available form a 
drop menu. However, the drop down lists can be hidden to add more room for style 
buttons. Use this check box to show/hide the drop down lists for all style types.

Width of Style Bar

You can adjust the width of the entire style bar by simply dragging the right hand edge 
with the mouse.
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Customize: Styles
Use the Styles tab to add styles to the Style Bar.

To add a style button to the Style Bar
Locate the style in the Styles list box. Select a category on the left side and locate the 
style on the right side. You can choose form all styles of a major style category, of if 
subcategories exist you can focus on styles of the subcategory.

Then simply drag the style to the location on the Style Bar where you want it to be 
positioned.

Notice that a style button cannot be duplicated on the style bar and style buttons of a 
type can only be positioned within the appropriate section of the Style Bar. For 
example, you can only place a label style button in the Labels section and only once.

If you add a style that is already on the Style Bar, the button will be moved from the 
old position to the new position rather than being duplicated. If the style button is 
already located on the Style Bar it will become highlighted as you drag it.
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234 Chapter 16: Tools
Customize: Options
Use the Options tab x to select options related to customizing toolbars. 

Add style selection controls to right of Collapse/Expand Style Bar button when style 
bar is not visible

When you collapse the Style Bar and this option is checked, three controls will be 
added to the toolbar to replace the capability of the Style Bar. These three controls are 
the style drop-down menu buttons for the three types of diagram objects. The controls 
will appear immediately to the right of the Collapse/Expand button. When the style bar 
is restored, these controls will be removed. With this option, you can use the Collapse/
Expand Style Bar button to switch between the standard user interface and a more 
compact user interface that is still fully capable.

Toolbar Icons

Adjust the size of the toolbar icons. Small icons are standard Windows 16x16 icons as 
appear in Vista menus. Medium icons are 24x24 (default and recommended). Large 
icons are 32x32 for greater visibility.
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Options
To view and modify program options, choose Options from the Tools menu. Options 
are organized by categories as described below.

Options: Start-up
The Start-up category includes options controlling the initial state of the program.

Open most recent file on start-up

When this option is checked. The most recently edited diagram will be opened 
automatically when you start the program.

Do not display splash screen on start-up

When this option is checked, the introductory splash screen will no longer be displayed 
each time you start the program.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide

Page 235 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



236 Chapter 16: Tools
Options: Locality
The Locality category contains options related to your country or culture.

Measurements

Choose either English (inches) or Metrics (centimeters) as your measurement units. 
All measurements are displayed in these units.

Measurements such as line widths and font sizes are measured in points (abbreviated 
pts). There are 72 points to the inch. 
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Options: Workspace
The Workspace category contains options related to the program appearance and 
operation. Some miscellaneous workspace options are located in this category while 
others are organized into subcategories.

Limit workspace to page area

When this option is checked (the default), the off-page area surrounding the white page 
area of the diagram is decreased to simplify scrolling and navigating. The scrollable 
workspace extends if necessary to include any objects located outside the page area.

Display the full path in window captions

When this option is checked, window captions show the full path of the diagram rather 
than simply the diagram name. This option is useful when editing files with the same 
name but located in different folders or on different machines. If your path names are 
too long to be displayed you may need to uncheck this option.
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Options: View
The View category contains options to enable or disable certain optional user interface 
elements like toolbars and status bars. 

Show status bar

Check this box to display the status bar, also known as a message bar, at the bottom of 
the screen. The status bar displays brief help and status information.

Show standard toolbar

Check this box to display the standard (top) toolbar. The toolbar contains important 
controls. We recommend it remain enabled.

Show property bar

Check this box to display the property bar. The property bar is located directly beneath 
the tool bar - it is the second button bar. The property bar is very useful for changing 
certain figure, label, and connector properties conveniently.

Show style bar

Check this box to display the style bar. The style bar is located on the left edge of the 
screen. It contains controls for selecting a new style for creating on object in your 
diagram. When you disable the style bar to free up screen space for viewing your 
diagram, three new compact controls (drop down menu buttons) appear in the property 
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bar to perform the function of selecting a style for creating the three types of diagram 
objects.

Show rulers

Check this box to display rulers on the top and left of the diagram views. Rulers help 
you lay out your diagram as it will appear on the printed page. They are also useful for 
providing an indication of the view’s location within your diagram and the current 
amount of magnification.

Show page boundaries

Check this box to turn on the display of page boundaries and margins. Page boundaries 
are determined by your print settings which you can adjust with print set-up. They 
reflect the current paper size, printer selection, page orientation, and so on. We 
recommend that you display page boundaries in most cases. They are required in order 
to perform certain features such as (obviously) Center on page. The time when they 
are not necessary or even particularly useful is when you are editing an embedded 
OLE diagram that really belongs to another document and therefore has no page layout 
information of its own.

Margins displayed are hard margins. They reflect the outer limit that you can print to 
on your selected printer - as opposed to spacing margins that you can set.

Show connection point indicators

Check this box to display small dots where connection points are located within a 
figure. 

Show connection guide lines when connecting

Check this box to display guide lines horizontal and vertical to the cursor when 
creating connectors. 
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Options: Tooltips
The Tooltips category contains options to enable or disable the display of tooltips (hint 
balloons.

Tooltips on style bar buttons

When checked, tooltip text balloons will appear when you hover over a style selection 
button on the style bar.

Tooltips on drop menu items

When checked, tooltip text balloons will appear when you hover over an item within 
certain drop menus. Tooltip information is included for style selection menus and color 
palette menus.

Tooltips on tool bars

When checked, helpful tooltip text balloons will appear when you hover over a toolbar 
button.
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Options: Grid
The Grid category contains options that affect the display and operation of the snap 
grid. Note that another set of grid options are saved for each diagram and therefore are 
controlled from the Diagram Properties screen instead.

Grid

Choose whether the visible grid appears as lines or dots. This is how the grid will 
appear if it is displayed. However, each diagram may choose to have a grid shown or 
not shown. See the Grid tab on the Diagram Properties screen.
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Options: Edit
The Edit category contains options related to editing diagrams. Some miscellaneous 
editing options are located here while others are organized into subcategories.

Create one figure at a time

When you create a figure and this option is checked, the new figure automatically 
becomes selected and the mode changes back to select mode as soon as one figure is 
created. To create another figure, you have to press the figure style button again and 
repeat the process. Without this option checked, you remain in create mode until you 
change modes yourself.

Create one connector at a time

When you create a connector and this option is checked, the new connector 
automatically becomes selected and the mode changes back to select mode as soon as 
one connector is created. To create another connector, you have to press the connector 
style button again and repeat the process. Without this option checked, you remain in 
connect mode until you change modes yourself.

Double-click edits label/figure text

When this option is checked, double-clicking the mouse on a figure in your diagram 
initiates text editing for that figure. Otherwise double-clicking will pop up the figure 
properties for that figure.
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Snap figures into flows

When this option is checked you can create and drag figures onto a flow (a connector) 
and it will become part of the flow (the connector will enter and exit the figure). 

Prompt to apply property edits to selected groups

When this option is checked (the default) and you apply a property change to a 
selection that includes a group, you will be asked whether the change should apply to 
grouped objects.If you answer and check the “Don’t ask again” box, it will remember 
your response until you return to uncheck this option.

Undoable navigation (scroll/pan/)

When this option is checked you can undo movement within your diagram such as 
scrolling and zooming in addition to edits. Otherwise, only actions that change the 
diagram will be undoable.

Remove connectors when one or both ends deleted

When this option is checked (the default), connectors are automatically deleted if you 
delete a figure that either end is attached to.

Edit text automatically when creating a figure

When this option is checked, each time you create a figure in your diagram you are 
automatically entered into text mode to edit the text of the figure.

Auto-label (label figures as they are created)

When this option is checked and you create a new figure AND that figure’s style has 
auto-label text configured, a figure label containing the auto-label text is automatically 
created below the new figure.
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Options: Import
The Import category contains options affecting the import of graphic images into 
diagams.

Calculate fitted bounds for imported graphics

When this option is checked and you import (or drag-and-drop) a graphic image into 
your diagram, a bounding shape is fitted in the shape of the content of the graphic 
rather than simply a rectangle of the same size as the graphic. The fitted shape is used 
to determine the clickable select area of the figure and to attach line ends right up to 
the image on all sides. 

We recommend this option be enabled. However, for some complex or detailed 
images, the approximation of the bounding shape may not be appropriate. In such 
cases you might want to uncheck this option while importing the graphic.

Non-fitted bounds Fitted bounds
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 244 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Options 245
Scale imported graphics by

You can choose to scale all graphics that you import or drag-and-drop into your 
diagram. For example, if you set this to 200%, graphic images will be imported at 
twice their original size.

Options: Snap labels
The Snap labels category contains options affecting whether different types of text 
labels snap automatically into place, attaching to other objects when dragged or 
created near the “slot” areas of each type of label.

Snap labels to flow label slots

When this option is checked you can create and drag labels onto flow label slot areas 
and they will become flow labels. Flow label slot areas are located on either side of the 
point where a connector attaches to a figure. If this option is not checked, then the only 
way to create a flow label is to right click on the flow point and use the Add Flow 
Label feature.

Snap labels to in-line connector label slots

When this option is checked you can create and drag labels onto in-line connector label 
slot areas and they will become in-line connector labels. In-line connector label slot 
areas are anywhere in which the center of the label lies on the connector. If this option 
is not checked, then the only way to create an in-line connector label is to right click on 
the connector and use the Add In-line Connector Label Here feature.
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Snap labels to connector label slots (lateral)

When this option is checked you can create and drag labels onto lateral connector label 
slot areas and they will become lateral connector labels. Lateral connector label slot 
areas lie along the length of a connector slightly above or below the connector. If this 
option is not checked, then the only way to create a lateral connector label is to right 
click on the connector and use the Add Lateral Connector Label Here feature.

Snap labels to figure label slots

When this option is checked you can create and drag labels onto figure label slot areas 
and they will become figure labels. Figure label slot areas are located in nine positions 
surrounding a figure. If this option is not checked, then you can create a figure label by 
selecting a figure and a label and using the Attach Label to Figure feature, or by using 
the auto-label style property.

Snap labels to figure label primary position only

This option matters only when the Snap labels to figure label slots option is set. If this 
option is set as well, labels will only snap to the single figure label slot defined as the 
Primary Position in the Diagram Properties dialog box (Labels tab).

Options: Arcs
The Fields category contains options controlling the editing of arcs.
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Stretch method 

Select a method for stretching arcs, such as when dragging one end. The method 
controls how the arc shape changes as the end is moved. One method is to keep the 
original shape, another is to keep the original height, and another is to keep the original 
line length. Keep shape has the disadvantage that some arcs, especially those 
exceeding a half circle, can grow unmanageably large very easily. Keep length has the 
disadvantage that when stretching an arc it can quickly stretch into a straight line and 
will then require further adjustments. Keep height is the default because it provides a 
good compromise. Stretching to open or close a full circle loop is a special case 
compatible with any stretch method.

Options: Copy figure properties
The copy figure properties category allows you to select which properties are included 
when using the Copy Properties feature between nodes.
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248 Chapter 16: Tools
Options: Copy label properties
The copy label properties category allows you to select which properties are included 
when using the Copy Properties feature between labels.
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 248 of 278

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\common.fm



Options 249
Options: Copy connector properties
The copy connector properties category allows you to select which properties are 
included when using the Copy Properties feature between labels.
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Options: Fields
The Fields category contains options controlling the format of text fields.

Short time format

Select a format to be used for displaying times represented by short versions of text 
fields. Create Date (Short) or Save Date (Short) text fields use this format to display 
the corresponding date and time. 

Long time format 

Select a format to be used for displaying times represented by short versions of text 
fields. Create Date (Long) or Save Date (Long) text fields use this format to display 
the corresponding date and time. 
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Options: Zoom
The Zoom category contains options controlling the zoom features.

Set intervals

Although you can always to any magnification you choose, you can also set up six 
preferred magnifications for convenient use. These are the percentages that appear in 
the main menu and are used as stopping points when you press the plus and minus 
buttons on the tool bar or when you press the plus or minus keys on the keypad.

Enter any intervals you prefer. The valid range is from 10% to 300% though the upper 
range may vary based on your display. 

Screen size 

Provide the exact measurement (use a ruler) of the actual picture on your monitor from 
the top to the bottom. The default is set for a standard fourteen inch monitor.

The program needs to know this measurement so that it knows what 100% means. If 
you have this value set correctly and is set to 100%, you can actually measure the 
object on the screen and it will match its true size. This only affects the display, printed 
size is always correct.

Zoom step 

Set the step interval when zooming in or out using the Zoom-in key (keypad plus), 
Zoom-out key (keypad minus) or mouse wheel (with Ctrl pressed).
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Options: Colors
The Colors category contains options that affect the color of the display and the color 
palette used to select colors for diagram elements 

Page

The page color is the color of the background area of your diagram that falls within the 
boundaries of the page. You can choose any color you like. Because most paper is 
white, choosing white will most accurately represent the printed result.

Off page

The off page color is the color of the background area of your diagram that falls 
outside the boundaries of the page. You will usually want to avoid this area when you 
create your diagram.

Margins

Choose a color for the margins that is visible on top of the page color. The margins are 
drawn as dashed lines surrounding the edges of the page. If you select a color that 
cannot be drawn solid, Windows draws the margins in the nearest solid color.

Grid

Choose a color for the grid that is visible on top of the page color and the off page 
color. The grid color only applies if the grid is drawn as lines. If it is drawn as dots, the 
dots are always black. If you select a color that cannot be drawn solid, Windows draws 
the grid in the nearest solid color.
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Handles

The handles are the small squares that appear on the corners and edges of objects that 
you select. The color you choose is purely a personal preference. 

Reshape

Choose the color for reshape handles. 

Connection Points

Connection point indicators are small circles drawn only on the screen to identify the 
location of connection points within figures. The color you choose is purely a personal 
preference. 

Restore Defaults

Press the Restore Defaults button to return all of the colors to their preset values.

Palette

Select from any of the pre-defined color palettes. The color palette provides a choice of 
colors available in color selection drop menus, in addition to the sixteen user-defined 
colors saved with every diagram. Selecting a different palette will not immediately 
affect any colors in your diagram.

Options: Save
The Save category contains options for auto-save and auto-backup.
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Create backup file (.BAK) of previous revision whenever you save a diagram

When this box is checked, every time you save a diagram, the previous revision of the 
diagram is saved as a.BAK file in the same folder as the diagram file. For example, if 
you open the diagram MYCHART.EDG, edit it and save it, MYCHART.EDG will 
contain the latest changes you made and MYCHART.BAK will contain 
MYCHART.EDG as it was before you made any changes. If you later decide that you 
want to revert to the previous version, just open the .BAK file and Save As the original 
file name (such as MYCHART.EDG). Remember that each time you intentionally save 
your diagram, the.BAK file is updated. This includes any time that you save your 
diagram except for Autosaves (see below).

Autosave all open diagrams periodically

When this box is checked, the program will automatically save your diagrams every so 
often based on the value of “minutes between autosaves” which can be from 2 to 60. 
This feature is useful to minimize loss of data from power outages, computer crashes, 
or program bugs.

Autosave saves your diagram to disk as if you performed the Save All feature, that is 
to say that the file is written back to the same .EDG file that was opened. You don’t 
need to do anything special to regain your most recent diagram after a system failure. 
We recommend that if you use the Autosave feature you also use the backup feature so 
that if the Autosave feature accidentally saves changes that you didn’t like you can 
always go back to the version you last saved intentionally.
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CHAPTER

17 Managing Files and Windows

A number of features are available from the File menu to perform file-level or system 
operations. These features allow you to load files (flow charts), save files, print files, and so 
on. This chapter describes each of these features and the features that manage the windows 
in which files are displayed.

Multiple Document Interface
This program supports the Microsoft Windows Multiple Document Interface standard also 
known by the abbreviation MDI. As a multiple document interface, this program allows 
you to open a number of different documents (in our case diagrams) simultaneously in 
different windows and to open multiple windows that view different parts of the same 
document. The MDI model is very powerful for working with several diagrams at once or 
for managing large or complex diagrams.

Whenever you create a new diagram or open an existing diagram as described in this 
chapter, a new window is created from which to view the diagram. You can have several 
such windows at a time. You can also create additional views of loaded diagrams and use 
the window arrangement commands to minimize, maximize, cascade, and tile all of the 
windows.

Managing Windows
You can use the following commands found in the Window menu to manage the 
arrangement of diagram windows. 

Cascade

Choose this command to arrange all of the non-minimized diagram windows so that they 
overlap one another and are offset slightly by the upper-right corners.

Tile

Choose this command to arrange all of the non-minimized diagram windows so that they 
are side-by-side filling the entire program area.

Arrange icons

Choose this command to automatically arrange the icons of all minimized windows.
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256 Chapter 17: Managing Files and Windows
Creating a New Flow Chart
When you create a new flowchart, you begin from one of the existing diagram 
templates that contain predefined figure, connector, and label styles. You can use one 
of the templates provided with the software or you can choose on that you saved 
yourself. When you choose NEW from the FILE menu, the following dialog box 
appears. To create a new flow chart from a diagram template

1. Choose New from the File menu.
2. Select a diagram template file (in the Template folder) from the Choose a Diagram 

Template dialog box. 
3. To conveniently set some initial options like object size and fonts, check the box 

indicating that wish to use the New Diagram Wizard to configure the diagram.
4. Click Open to create a diagram from the selected template.
5. If you chose to use the Wizard to configure the file, the New Diagram Wizard will 

appear (see the following section).
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New Diagram Wizard 257
New Diagram Wizard
The final step when creating a new diagram is using the New Diagram Wizard to 
conveniently select options for the diagram. The wizard appears after you have chosen 
the template for your new diagram. Use the wizard to select options from those that are 
available for the template you have chosen. Possible options include color scheme, 
diagram size, font, font size, and so on. 

Template Variants
The first options that the wizard presents are known as variants, predefined template 
variations that provide choices of color schemes, diagram sizes, and so on. When you 
are viewing variants, a preview will help display your choice. Variants are carefully 
crafted by diagram designers to provide functional and attractive diagrams. They are 
available for many of the common diagram types.

Color Scheme

Choose a predefined initial color scheme (if available) and click Next. The colors are 
chosen to be attractive and clear when printed. The colors visible on your monitor can 
be darker or lighter than those that are printed, so it is possible for some color schemes 
to be less than ideal for the screen. Lighter color schemes are usually the best all 
around. The color scheme you choose will be remembered when you create future 
diagrams using the same template.
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Diagram Size

Choose a predefined diagram size to control how large or small the objects in your 
diagram appear. The predefined sizes are designed to be clearest when printed. The 
smallest size is just large enough to read comfortably. Larger sizes are easier to read 
but limit the amount of information you can fit on a page. It is possible to adjust sizes 
later, but setting sizes later for each style is far more difficult. The size you choose will 
be remembered when you create future diagrams using the same template.

Effects
An additional screen of the New Diagram Wizard permits you to add some optional 
shadow and fill effects to the new diagram. Choose from among the presets available 
for drop shadows and gradient fills. 
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New Diagram Wizard 259
Template Overrides
Additional wizard options are available for all diagram templates. These options 
appear on the final page of the diagram wizard and currently control text appearance 
and formatting.

Font

You may choose to select a special font for your diagram. If you leave this “<As Is>” it 
will use the fonts as they are defined in the diagram template. Templates are defined 
with a common font that can be assumed to be present on every computer, usually 
Arial or Times. You can choose a custom font here with one step. If you choose to 
change the diagram font using the wizard, the new font will be used everywhere in the 
diagram unless you change it later for particular styles or objects. For example, if you 
saved a custom template using many different fonts but select a font from the wizard 
rather than “<As Is>”, the wizard-selected font will be substituted for all of your 
custom fonts in the new diagram.

Font Size

You may choose slightly larger or smaller font sizes in your diagram than are defined 
in the diagram template. If you leave this field “<As Is>” the font sizes used are those 
chosen to be optimal by the designer of the template. However, if you have a diagram 
that requires especially large or small text you can adjust it here. Note that small 
increments (a point size or two) are usually enough. Also note that if you choose a font 
size increment other than “<As Is>”, ALL font sizes in the new diagram will adjust 
accordingly.
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Line Spacing

By default text lines are single spaced. However, you may choose to space lines closer 
together to squeeze more text per shape, or further apart for easier reading. Several 
options are available. These can easily be changed later from within the Diagram 
Properties dialog box.

Wrap

Most diagram templates are defined such that shapes automatically expand when you 
type more text than can fit on a line within the confines of the shape. If you prefer to 
use automatic word wrap, check this box.
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Creating Custom Templates
When you create a new flow chart, you start from a diagram template that contains an 
initial set of styles and diagram properties. In addition to the templates that come with 
the program, you can create custom templates to save diagram types you design.

Templates are similar to saved diagram files. The only difference is that when you 
open them as a template (the New command) any actual objects saved in the diagram 
are ignored. When you create a new diagram by choosing New from the File menu, 
you can choose any diagram template located in the Template folder. Therefore, all you 
have to do to create your own diagram template is to copy a diagram to this folder. In 
fact, you can open any existing diagram using the New command and it will be used as 
a template to create a blank copy of a new untitled diagram.

However, to further simplify the process of saving the diagram you are working on as a 
template for future diagrams, the program has a Save Template feature.

Save Template

The Save Template feature saves the open diagram as a template for use as the starting 
point for new diagrams. Once you save a diagram as a template, it will be available as 
a new diagram type the next time you use the New command.

To create a custom diagram template
1. Create a custom diagram with all of your own styles and diagram properties.
2. Choose Save Template from the File menu.
3. Select a file name for your template. We recommend that you save templates with 

your own name rather than updating the original templates. This will insure that 
they don’t get over-written the next time you upgrade.

4. If you do update an existing template, you will be asked whether to keep the 
existing preview from the old file. This is often a good idea. The alternative is to 
include diagram objects in your file so that a new preview will be generated.

5. The next time you create a new diagram, you can choose your custom template as 
the starting point.
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Opening an Existing Flow Chart
All of the following methods open an existing file and create a new window to view 
the diagram. The Open File dialog box looks like this:

To open a flow chart that was previously saved
1. Choose Open from the File menu. 
2. Select the file that contains the flow chart. You can select multiple files to open 

simultaneously by holding down the shift and control keys and clicking on 
additional files.

If the file is one of the four that you most recently used, you can open it more 
conveniently.

To open a recently used flow chart
Choose the flow chart by file name from the File menu.

To open a file by dragging and dropping from the File Manager or 
Explorer
In the Windows File Manager or Explorer, select a single diagram file or a number of 
files and drag them on top of the program icon or the running program. Release the 
mouse button and the flow charts will be opened and ready for editing.
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Opening an Additional View of a Flow Chart 263
Opening an Additional View of a Flow Chart

To open a new window for an open flow chart
1. If you have multiple flow charts open, make sure the one that you want another 

view of is active.
2. From the Window menu, choose New Window.
A new window will be created with an identical view of the flow chart. You can now 
scroll, zoom, and edit the same diagram through two independent views. You can even 
drag objects from one view of the diagram to another, something that you cannot do 
between views of different diagrams.

Saving a Flow Chart

To save changes to a flow chart
If the diagram already has a file name and you want to save your changes back to the 
same file, simply choose Save from the File menu.

To save changes to all open flow charts
You can choose Save All from the File menu to save all your open files to disk with 
one command.

To save a flow chart to a file
If the diagram is new and has never been saved to a file, or to save a diagram to a 
different file, choose Save As from the File menu and select the file name.

NOTE: Autosave and autobackup also affect how files are saved, backed up, and 
recovered.

Reverting to the Last Saved Version
At any time while editing a diagram you can choose to revert back to the last saved 
version of the file. Doing so will abandon all of the changes you have made since 
opening the file, or the last time you saved it. You will be prompted to confirm that you 
really do want to revert the file.

NOTE: Use this feature with caution. It cannot be undone! Be especially careful if 
you have multiple open files, that you revert the right one. If you have any 
hesitancy, we suggest you avoid using this feature altogether.
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264 Chapter 17: Managing Files and Windows
To revert to the last saved version of a diagram
1. Choose Revert from the File menu. There is no shortcut key intentionally.
2. Read the warning carefully to be sure you are reverting the correct diagram and 

click OK to confirm.
Once reverted, the changes you made since the last save are permanently lost and there 
is no way to recover them. A safer alternative is to Save As to a different filename, 
then re-open the original file using File Open. You will then have the option of 
recovering your changes by simply re-opening the Save As file.

Saving as an HTML Web Page

To save a diagram as a simple web page in HTML
Choose Save HTML from the File menu. Use the Save HTML dialog box to select 
options:

Folder

Select a folder where generated files should be stored. Multiple files will be generated 
in this folder so it is best to select a new folder or an existing empty folder. The files 
that are generated are named for the diagram file for which they correspond. For 
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Saving as an HTML Web Page 265
example, if you open MYFILE.EDG and save it as HTML, the generated files might 
be MYFILE.HTM for the web page and MYFILE.JPG for the image.

Template

Select a template file to define the format of the resulting HTML page. The template 
file is required. You can use either the Default.htm supplied with the software or a file 
of your own creation (see  Creating an HTML Template on page 266). 

Scale

Use this control to select image size as a percentage of “true” size. The true size is the 
size that is shown by the rulers within your diagram. 

Format

Use this control to select a graphic image format. Select from JPG (JPEG) or GIF 
(Graphics Interchange Format). GIF is limited to 256 colors so your diagram colors 
may be altered when reduced. JPG, on the other hand, handles 24-bit color and is more 
highly compressed. The amount of compression of a JPG image is controlled by the 
'Quality' setting below. When JPG output is highly compressed (low quality), the 
image will become increasingly blurred. This is especially true around the edged of 
text. For truest color and the least distortion, use JPG at 100% quality.

Quality

This option is available only for JPEG images. Use this control to select a quality level 
for JPEG images. The quality can range from 10 (lowest) to 100 (highest). Highest 
quality images best represent the original but they are also require the largest file size. 
The default is 85% which produces a reasonable file size but a very good image.

Background

Select a background color for the image. Don’t confuse this color with the page color 
(set in Tools Options) that controls the appearance of your diagram workspace.

Include links - Diagrams (as web pages)

Check this option to include links from the image to hyperlinked diagrams (as an 
HTML image map), and to generate the linked diagrams as web pages. For example, if 
your diagram contains hyperlinks from symbols to other diagrams and this option is 
not checked, only one web page and one image will be created. However, if you check 
this option, the hyperlinks will be included in the original page as HTML links. Also 
the hyperlinked diagram will be saved as a web page in this same folder, as well as all 
other diagrams that it is linked to and so on. By checking this option, you can save a 
hierarchy of hyperlinked diagrams as an equivalent hierarchy of linked web pages.

Include links - Web URLS

Check this option to include links to web URL hyperlinks in your diagram as HTML 
links in the saved web page (as an HTML image map). A web URL hyperlink is one 
that you have linked to a external web page or other resources on the internet. 
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Include links - Documents

Check this option to include links to documents in your diagram as HTML links in the 
saved web page (as an HTML image map). A hyperlink is considered a document if it 
is linked to anything other than another diagram or a web URL. Normally a document 
is a file located on your computer such as a spreadsheet that you want to open when a 
user clicks on a symbol in a diagram. When you check this option and your diagram 
contains document links, a copy of the document is added to the save folder to later be 
uploaded to your server with the rest of the web page files.

File Extension

Select a file extension for the web page (HTML) files. The default is “htm”.

The web page will consist of (at least) two files, an HTML file and an image file 

referenced from within the HTML file. Upload all the files that were created to the 
same folder on your web server or adjust them as needed. Click on View Web Page to 
inspect the result by opening the main HTML page in your browser. Note the your web 
page will not be visible to others until you upload the files to a web server.

Creating an HTML Template
When saving your diagram as an HTML web page from the Save HTML screen, a 
template file is required that defines how the HTML page will be composed. A default 
file named Default.htm located in the HTML folder is provided for simple cases. 
However you can also create your own custom HTML template to control exactly how 
your exported HTML pages appear.

It's best not to simply edit the Default.htm file because then you will lose your changes 
next time you upgrade the software. Instead, you can create your own template file, 
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Saving as an HTML Web Page 267
perhaps by simply copying Default.htm and editing it with an ordinary text editor. You 
may locate your custom templates in the HTML folder where Default.htm is located.

Substitution Macros
You can include substitution macros in your template file and they will be replaced by 
values determined by the software as the HTML gets created. For example, you can 
designate exactly where in your template the diagram content should be inserted, or 
you can choose to insert the date and time, or you could use the name of the file

as the title. Macros are simply short text strings beginning with a macro delimiter 
(dollar sign). Following is a list of supported macros. See Default.htm for example 
usage.

$PATHNAME
Substitute the full path of the diagram file such as "c:\folder\filename.edg".

$FILENAME
Substitute the full file name of the diagram file such as "filename.edg".

$FILENAMENOEXT
Substitute the file name of the diagram file excluding the file extension such as 
"filename".

$DATELONG
Substitute the long format date such as "January 14, 2007".

$DATESHORT
Substitute the short format date such as "01/14/07".

$DATEABBREV
Substitute the abbreviated date such as "14-JAN-07".

$TIMESTAMP
Substitute a time/date time stamp in a format suited to the locale such as "01/14/07 
12:34:09AM".

$TIME
Substitute the time of day such as "12:15 PM".

$GENERATOR
Substitute the program name and version number (of this program) that is generating 
the HTML code such as "EDGE Diagrammer v5.08.1830".
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$CONTENT
Substitute the diagram content. This macro is the only one that MUST be included in 
the template. It should located within the <body> block and on a line of its own. It will 
be replaced by an <img> block in the case of a simple diagram without any included 
internal links, or by a combination of an <img> and a <map> block in the case of a 
more complex diagram.

Style Class
You cannot customize the composition of the content (<img> and optional <map> 
blocks) that are substituted for $CONTENT. However, the <img> block will contain a 
CSS (Cascading Style Sheet) class designator in the form class="pacestardiagram". 
You can therefore include a style definition such as "img.pacestardiagram" either in 
the head of the template or in an externally included css file. This will allow you to use 
the template file to more precisely control the appearance of the diagram image. For 
example, you could add a border around the image. See Default.htm for a very simple 
example.
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Saving as an HTML Web Page
You can save a diagram as an HTML web page. The HTML source consists of a 
number of files within a destination folder that you upload to your web server to make 
your diagram visible (and optionally navigable) to anyone with a web browser. If your 
diagram contains multiple sheets, only the active sheet is exported.

To save a diagram as a simple web page in HTML
Choose Save HTML from the File menu. Use the Save HTML dialog box to select 
options:

Folder

Select a folder where generated files should be stored. Multiple files will be generated 
in this folder so it is best to select a new folder or an existing empty folder. The files 
that are generated are named for the diagram file for which they correspond. For 
example, if you open MYFILE.EDG and save it as HTML, the generated files might 
be MYFILE.HTM for the web page and MYFILE.JPG for the image.

Scale

Use this control to select image size as a percentage of “true” size. The true size is the 
size that is shown by the rulers within your diagram. 
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Format

Use this control to select a graphic image format. Currently JPG (JPEG) is the only 
option.

Quality

Use this control to select a quality level for JPEG images. The quality can range from 
10 (lowest) to 100 (highest). Highest quality images best represent the original but 
they are also require the largest file size. The default is 85% which produces a 
reasonable file size but a very good image.

Background

Select a background color for the image. Don’t confuse this color with the page color 
(set in Tools Options) that controls the appearance of your diagram workspace.

Include links - Diagrams (as web pages)

Check this option to include links from the image to hyperlinked diagrams (as an 
HTML image map), and to generate the linked diagrams as web pages. For example, if 
your diagram contains hyperlinks from symbols to other diagrams and this option is 
not checked, only one web page and one image will be created. However, if you check 
this option, the hyperlinks will be included in the original page as HTML links. Also 
the hyperlinked diagram will be saved as a web page in this same folder, as well as all 
other diagrams that it is linked to and so on. By checking this option, you can save a 
hierarchy of hyperlinked diagrams as an equivalent hierarchy of linked web pages.

Include links - Web URLS

Check this option to include links to web URL hyperlinks in your diagram as HTML 
links in the saved web page (as an HTML image map). A web URL hyperlink is one 
that you have linked to a external web page or other resources on the internet. 

Include links - Documents

Check this option to include links to documents in your diagram as HTML links in the 
saved web page (as an HTML image map). A hyperlink is considered a document if it 
is linked to anything other than another diagram or a web URL. Normally a document 
is a file located on your computer such as a spreadsheet that you want to open when a 
user clicks on a symbol in a diagram. When you check this option and your diagram 
contains document links, a copy of the document is added to the save folder to later be 
uploaded to your server with the rest of the web page files.

File Extension

Select a file extension for the web page (HTML) files. The default is “htm”.
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The web page will consist of (at least) two files, an HTML file and an image file 

referenced from within the HTML file. Upload all the files that were created to the 
same folder on your web server or adjust them as needed. Click on View Web Page to 
inspect the result by opening the main HTML page in your browser. Note the your web 
page will not be visible to others until you upload the files to a web server.
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272 Chapter 17: Managing Files and Windows
Page Setup
The page setup area helps you layout your flowchart for printing and display. You can 
control paper size, page orientation, and postering. You can change the page layout at 
any point. However, to minimize the amount of re-organizing of your flowchart, it’s 
usually best to setup the page layout before constructing your diagram.

Poster layouts
An important concept to understand when setting up your page layout is postering. 
When the page defined for a diagram is larger than the paper size set for your printer, 
the diagram will be divided into multiple pages for the purpose of printing. Therefore 
you can choose a larger page size than can be printed on your printer simply by 
increasing the page height and width and leaving the poster grid (rows and columns) 
set to one. The division into multiple pages is highly dependent on the printer, even if 
the paper size is unchanged. Therefore the use of a large page size with rows and 
columns set to one is best for diagrams that are not designed with the locations of page 
divisions in mind. For example, this would be best for laying out a large continuous 
complex diagram such as the one shown below on the left.

You may also choose to layout your diagram as an actual poster. To do so, choose a 
standard paper size that will be available on any printer to which the diagram will be 
printed in the future (such as letter size), and then increase rows and/or columns as 
necessary to create a grid of such pages to comprise your poster layout. The page size 
you choose when rows and columns are larger than one must fit onto the paper size 
you print to! Use this technique when the layout of your diagram is specifically 
divided into multiple pages and the position of the page divisions within your diagram 
must be maintained when printing. For example, if you design a complex diagram with 
multiple pages in mind, such as shown below on the right, use a standard paper size 
and increase rows and columns as needed to add pages. This will assure that the page 
divisions shown in the diagramming screen will accurately reflect paper boundaries 
when printed on different printers (if at all possible).
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Page Setup 273
Choose Page Setup from the File menu. Use the Page Setup dialog box to change the 
page layout::

Paper Size

Select a page size from the standard page sizes available. The sizes listed are not 
necessarily all available on your current printer. If you intend to use poster layout 
(more than one row or column), be sure to choose a page size that matches a paper size 
available on your printer and on any printer you anticipate printing on in the future.

Width and Height

The height and width boxes display the exact size of the paper you have selected. 
These are for display purpose only.

Poster

If your diagram is too large to fit on one sheet of paper that your printer can print, you 
may choose to use postering to spread your design onto a grid of pages. Choose the 
number of rows and columns of pages for your diagram. (the maximum number is 
limited to a total of about 62 inches by 62 inches depending on the paper size). Select 
“Print crop marks” to print guides in the corners of each printed page indicating where 
they should be cut in order to be joined into a continuous poster. Crop marks are not 
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274 Chapter 17: Managing Files and Windows
printed on corners shared by the outer edges of the poster which are generally not cut 
because such edges are included in margin spacing. 

Margins

Margins are displayed to show the extents of the printable portion of the page. The 
margins are for display purposes only. Use the margins to guide where on the page you 
place objects. Objects placed outside the margins will be truncated or not print at all.

Minimum (stitching margin)

Use this control to set the minimum size of margins. This is also the margin width used 
for stitching together multiple pages when the diagram cannot be printed on a single 
page. 

Choose the minimum margin carefully. The value should be at least as large as the 
smallest margin supported by any printer you anticipate using. If you select too small a 
minimum, you run the risk when printing a multi-page diagram, that the page break 
locations and possibly the combined page size will be different for each printer. In that 
case, changing the printer set-up may cause your diagram’s page layout to change and 
possibly require manual adjustment of the contents. A diagram’s page layout will 
remain consistent unless it is required to be adjusted for a printer setting that cannot 
support the minimum margin. Note that for diagrams that span multiple printed pages, 
a layout change may be necessary based on the value of the minimum margin alone 
even if the four margins you set are all valid for the printer.

Portrait and Landscape

Use the portrait and landscape controls to choose page orientation. There’s no need to 
rotate objects to print width-wise or “landscape” on a page - this is done automatically 
when the page is printed.

The printed page 

Crop marks at each corner. 
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Sheets
All of the above pertains to a single sheet in a diagram. A diagram may have multiple 
sheets each set up identically as described above. 
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276 Chapter 17: Managing Files and Windows
Printing
Printing flow charts is similar to printing in any other Windows program. 

To print a diagram
1. Use Print Setup to make sure that your printer is set up properly with the correct 

paper and so on. You do not need to set-up your printer each time you print.
2. Choose Print from the File menu.
3. Choose the options you want in the Print dialog box then press OK.
When you print a diagram that has more than one page, you can select a range of pages 
to print rather than printing the whole diagram. Page numbering is from left to right 
and top to bottom. The following illustration shows page numbering for a two row by 
three column poster.

A diagram can also have multiple sheets. Each sheet may be divided as above. Page 
numbering continues as shown, repeating for each sheet. The Print screen also 
contains an option to print only the current sheet.

To print all open diagrams
You can choose Print All from the File menu to print all your open diagrams with one 
command.

Object Linking and Embedding (OLE)
This program supports Microsoft’s Object Linking and Embedding specification 
version 2.0. OLE (oh-lay) as it is commonly called, makes it simple and convenient to 
insert or embed diagrams within documents created by other applications which can 
serve as OLE containers. 

Microsoft Word™ is one example of a very popular application that exploits the ability 
to be an OLE container. Throughout this section, we’ll refer to Word as a typical OLE 
container application. But don’t forget that there are MANY such applications on the 
market and all will work more or less the same with this program’s OLE features. 

Using OLE, you can embed diagrams directly inside Word documents such that they 
become a part of the document, are saved within the document file, and nevertheless 
can later still be edited. In addition, you can choose to store only a reference called a 

1 2 3

4 5 6
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Object Linking and Embedding (OLE) 277
link to a diagram file within Word. With a link, you can simply edit the diagram file 
and the changes will automatically appear in the Word document. Linking and 
embedding together provide the capability to use diagrams anywhere that a diagram 
would be convenient without the hassle of having to store and maintain the diagram 
elsewhere at the same time.

This program acts as an OLE Server, not as a container like Word. It is a full server as 
opposed to a mini-server because it can also run stand-alone as a normal application.

OLE embedding diagrams
A diagram can be embedded into a document created by an application like Microsoft 
Word™. When a diagram is embedded in a document, it becomes part of the document 
but remains a complete diagram that can later be edited and updated. 

To insert a new diagram into a Word (or similar) document
1. From Microsoft Word, choose Object from the Insert menu.
2. Choose the Create New tab.
3. From the types list, choose EDGE Diagram.
4. Follow the procedure to create a new diagram (see  Creating a New Flow Chart on 

page 256).
5. When the diagram is complete, choose Exit & Return to Document from the File 

menu.
6. Resize the resulting diagram if you like.

To insert a copy of an existing diagram into a Word (or similar) document
1. From Microsoft Word, choose Object from the Insert menu.
2. Choose the Create From File tab.
3. Select the name of the diagram file.
4. Resize the resulting diagram if you choose.

To embed a portion of a diagram into a Word document
1. Open any diagram file.
2. Select the portion of the diagram that you’d like to embed in the Word document 

(see  Selecting and Deselecting Objects on page 27).
3. Choose Copy or Cut from the Edit menu.
4. In Word, choose Paste from the Edit menu.
5. Resize the resulting diagram if you like.
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OLE linking to diagrams
A diagram can be linked to a document created by an application like Microsoft 
Word™. When a diagram is linked in a document, it remains a separate diagram file 
and a reference or link is saved in the document. If you later make changes to the 
diagram, those changes will be reflected automatically in the document that contains 
the link.

To insert a link to a diagram into a Word document
1. Create a diagram in the usual way (see  Creating a New Flow Chart on page 256).
2. Save the diagram to a file.
3. In Word, choose Object from the Insert menu.
4. Choose the Create from File tab.
5. Check the Link to File box.
6. Select the name of the diagram file.
7. Resize the resulting diagram if you choose.
When an OLE document contains links to diagrams or other OLE objects, those 
objects must remain in place when the document is used. If you delete a diagram that is 
referenced from an OLE document, the reference will not know where to find the 
diagram. Likewise, if you copy the document that contains the link, you should also 
copy the linked diagrams so that the links remain valid.

Exiting 

To exit 
1. Choose Exit from the File menu.

Other standard Windows methods of exiting programs work also, such as pressing 
ALT-F4 or choosing Close from the System menu.

2. If your diagram contains changes that have not been saved, you will be prompted 
to save them before exiting.
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Index

A
active container 82, 167
active containers 65
add connector label here 134
add figure label

figure labels
add figure label 138

add flow label 141
adding a page 47
adding a sheet 47
aligning figures 57
antialias 221
arc 98
arc stretch method 246, 247, 248, 249
arcs 246, 247, 248, 249
aspect ratio 82, 125, 166
attach label to figure 138
attach method 90

centers 90
click point 90
freeform 90

attaching
connector labels 134
figure labels 138
figures to flows 68
flow labels 142
specialty labels 131

auto backup 233
auto save 233
auto-label 139
auto-label (connectors) 199
Autosave 254
autoscroll 43
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B
back 28
back hyperlink 214
back one 29
background 207
background color

exported bitmaps 221
backspace 147, 150
backups 233
BAK files 254
basics 13
beginning of line 147, 150
beginning of text 147, 150
beveled 108
bind to style 72, 120, 157, 181
blend 83, 168
block diagrams 11
border (figure property) 157
border color 72, 157
borders (of connectors) 111, 196

C
categories 53, 93
center on grid when snap 80, 125, 164, 185
center on page 59
center stationary when resizing horizontally 81, 125, 165, 185
center stationary when resizing vertically 81, 125, 166, 185
centers (attach method) 90
centimeters 235
changing figure size 55
changing the active page 48
changing the active sheet 48
clear 29
click point (attach method) 90
click select 28
clicking 13
clipboard 30, 32, 33, 34
close 276, 278
color palette 253
color scheme 257
colors

custom 39
fill color 40
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for tinting graphics 41, 219
for transparency 40

combo box 20
commands (notation) 9
common style properties 154, 156
connect cursor 13
connect mode 25, 92
connect to another connector 95
connect two figures 94
connection points

temporary 90
use connection points option 90

connector labels 114, 132
add connector label here 134
attaching 134
copying 31
creating 134
cutting 30
definition 17
deleting 29, 135
detaching 135
dragging 134
editing text 145
illustration 17
inline 132
lateral 133
moving 134
slots 132, 133
text 143

connector styles 18, 189
connectors

borders 111, 196
color 108, 193
common behaviors 89
connect to connectors 95
copying 31
corners 108
creating 92
curved 97
cutting 30
definition 16, 89
deleting 29
ends 110
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flipping 102
guided orthogonal 104
illustration 16, 89
joins 108
manual orthogonal 104
moving 35
moving an end 101
orthogonal 103
pasting 32
rounded 97
segments 95
smoothed 97
splitting 102
unattached 95

connector-to-connector 95
containers 82, 166, 167

active 65, 82, 167
keep objects together 65, 82, 167

context menu 13
copy properties 33, 247, 248, 249
copy-and-paste 32, 33
copying 31, 32
copying styles 215
copying text 148
corner radius 225
corners (of connector) 108
create an unattached connector 95
create mode 51
create one connector at a time 242
create one figure at a time 242
creating

connector labels 134
connectors 92
figure in flows 67
figure labels 138
figures 51
flow labels 141
labels 113
specialty labels 129

creating a new diagram 256
creating figures 51
crossovers 112, 198
CTRL key
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creating figures in flows 68
dragging a figure 68
freeform specialty labels 131

cursor
definition 13
shapes 13

curvature (of connector) 108
curved connectors 97
curves 97
custom diagram colors 39
custom template 261
custom zoom intervals 45
customize 228

style bar 228
toolbars 228

cut 277
cut-and-paste 32, 33
cutting objects 30
cutting text 148

D
date and time 150
decimal tab stops 86, 126, 171, 186
default tabs 87, 127, 172, 187
Default.htm 266
define figure styles dialog box 153, 189
define label styles dialog box 177
delete 29
delete key 147, 150
delete style 155, 179, 190
deleting

connector labels 135
figures from flows 69

deleting a page 48
deleting a sheet 48
deleting connector junctions 100
deleting objects 29
deleting text 148
description (of style) 156, 180, 192
deselect all 28
deselecting 27
detach label 135
detaching
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connector labels 135
figure labels 139
figures from flows 69
flow labels 142
labels 132
specialty labels 132

diagram
common questions 14
definition 14

diagram components 16
diagram objects 16
diagram properties 221
diagram template 17, 256, 261
distributing evenly 58
document linking 211
dotted grid 241
drag scrolling 43
dragging 13, 35
drop menu 20, 51, 52, 92
drop menus 14
drop shadow 72, 157
drop shadows 227
duplicating objects 32

E
edges snap to grid 80, 81, 125, 165, 185
edit boxes 14
edit operations 27
editing text 145
elliptical gradient 83, 168
embedding diagrams 277
EMF 216
end of line 147, 150
end of text 147, 150
end symbol gallery 197
ends (of connectors) 110
english 235
Enhanced metafiles 216
entire page (zoom) 44
ESC 147, 150
exiting 276, 278
expand figure 79, 124, 163, 164, 167, 184
extending a text selection 146
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extending selection 28

F
fields 150, 250
figure

inserting from gallery 54
figure create mode 25
figure labels 114, 136

as auto-labels 139
attaching 138
creating 138
definition 17
detaching 139
hook-ups 137
illustration 17
re-positioning 139
slots 136

figure properties dialog box 69
figure style combo box 51
figure style drop menu 51
figure styles 18, 153
figure symbol gallery 54, 73
figures 51

3-D 72, 157
adding text 144
aligning 57
centering on page 59
copying 31
creating 51
cutting 30
definition 16, 51
deleting 29
dragging 35, 56
duplicating 32
editing text 145
flows 67
illustration 16
making same size 57
moving 35, 56
moving precisely 35, 56
pasting 32
selecting text 145
size 55
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sizing 57
sizing to text 58
spacing evenly 58
styles 153
text 143

file menu 255
file operations 255
fill 83, 168
fill color 40, 72, 157
find 36
find dialog box 36
find text 36
flipping connectors 102
flow 112, 198
flow labels 114, 140

add flow label 141
attaching 142
creating 141
definition 17
detaching 142
illustration 17
slots 140

flow point 17, 114, 140
flow symbols 105, 109, 194
flows 67

attaching figures within 68
creating figure within 67
deleting figures 69
detaching figures 69

follow hyperlink 213
foreground 207
Formats and Customization Guide 197
forward hyperlink 214
freeform 131

attach method 90
creating figures in flows 68
dragging a figure 68
specialty labels 131

front 28
front one 29
full server (OLE) 277
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G
gallery 54, 73

end symbols 197
getting around 43
go to parent 214
gradient fill 83, 168
graphic from clipboard 73
graphic from file 73
graphics

importing from files 215, 216
pasting from clipboard 32

grid 23, 215, 241
grid lines 241
groups 203, 243

aligning 205
breaking apart 204
centering on page 205
changing properties of members 205
connecting 206
creating 203
editing text 206
following hyperlinks 206
order of members 203
re-establishing 204
regroup 204
resizing 206
scaling 206
spacing evenly 205
ungrouping 204
ungrouping all 204

guided orthogonal connectors 104

H
handles 27
hard carriage returns 151
height (figure property) 72, 120
height and width to grid when snap 80, 125, 164, 165, 185
home 147, 150
hook-ups (for figure labels) 137
HTML

saving as,exporting 264, 269
HTML template 265, 266
hyperlinks 211, 214
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back 214
following 213
forward 214
open 213
opening 213
removing 212
removing parent hyperlinks 214
returning to parent 214
setting for figure 212
setting parent hyperlink 214
setting to URL 212
to web page 212

I
importing

metafiles 216
importing graphics 215, 216
inches 235
incremental zooming 46, 47, 48
inline connector labels 132
Insert Graphic 217
insert key 147, 150
Insert Symbol 54
inserting a figure 54
inserting field text 150
inserting time and date 150
introduction 11, 13
invalid characters 147, 150

J
jogs 103, 112, 198
joins 108
jumps (see jogs) 103
junctions 95

definition 17
deleting 29, 100
illustration 17

K
keep height (arcs) 246, 247, 248, 249
keep length (arcs) 246, 247, 248, 249
keep shape (arcs) 246, 247, 248, 249
keep sized to text 58
WizFlow Flowcharter User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 288 of 298

Last Modified April 27, 2012 7:44 pm

Filename: \\tsclient\S\WIZFLOW\DOC\wizflow.ix



289
keyboard 147
keys 9

L
label styles 18, 177
labels

adding text 144
copying 31
creating 113
cutting 30
definition 17, 113
deleting 29
detaching 132
dragging 35
editing text 145
illustration 17
moving 35
pasting 32, 33
rotating 144
selecting text 145
specialty labels 128
text 143

landscape 274
lasso cursor 13
lasso select 27
lateral connector labels 133
layers 207
left (figure property) 71, 107, 120
left and right edges snap to grid 80, 125, 165, 185
left mouse button 13
line spacing 260
line too long 79, 124, 163, 184
linear gradient 83, 168
link to file 278
linking diagrams 211
linking to diagrams (OLE) 278
linking to documents 211

M
macros (HTML) 267
magnification 45
make same size 57
manual orthogonal connectors 104
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margins 264, 274
MDI 255
measurements 14, 235
memo 88, 128
memotips 88, 128
menu bar 19
menus 9
metafiles

importing 216
metrics 235
Microsoft Word 276
mitered 108
model figure 57
modes 20

connect mode 25, 92
figure create mode 25
select mode 23
seltext mode 24
text mode 24
zoom mode 24, 44, 45

mouse
buttons 13
clicking 13
dragging 13
requirement 13
right button 13

mouse cursor 13
move cursor 13
moving 35

connector label 134
moving a figure 56
moving connector labels 134
moving precise 35
moving the end of a connector 101
moving to the front or back 28
multiple document interface 255
multiple sheets 46, 47
multi-segment connector 95

N
naming a page 48
naming a sheet 48
new 256
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new diagram wizard 257
new figure style dialog box 154, 178, 190
new style 154, 178, 190
nodes

pasting 33
notes (notation) 9

O
object linking and embedding 276
object styles 17
objects 16
OLE 276

cut 277
embedding diagrams 277
full server 277
linking to diagrams 278
mini-server 277
paste 277
server 277

OLE container 276
open 262
open hyperlink 213
opening an existing diagram 262
orthogonal 107
orthogonal connectors 103

guided 104
manual 104

P
page boundaries 264
page layout 272
page orientation 272
page setup 272
page width (zoom) 44
pages

adding 47
changing 48
deleting 48
naming 48

palette 253
paper 264
paper size 272
paragraph styles 17
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parent 214
paste 277
paste as 33
paste properties, properties

copying 33
pasting 30, 32, 33
pasting graphics 32
pasting text 33, 148
paths

pasting 33
percentage zoom 45
pivot cursor 13
point measurements 14
points 236
portrait 274
poster 273
precise moving 35, 56
preserve aspect ratio 82, 125, 166
primary position 225, 246
Print All 276
printing 276
properties

copying 247, 248, 249
overview 18
pasting 33

property bar 21, 54, 94, 117
illustration 19

Q
quality

JPG images 221
quality of JPG 265, 270
quick copy 32
quit editing text 147, 150
quitting 276, 278

R
Reapplying a connector style 201
Reapplying a figure style 175
Reapplying a label style 188
recover 233
remove hyperlink 212, 214
rename styles 155, 178, 190
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replace 36, 37
replace dialog box 37
replace text 36
re-positioning figure labels 139
reshape 62
resize cursor 13
resizing figures 55
restore 233
revert 233, 263
right mouse button 13
rotating text 144
rounded 108
rounded connectors 97, 225
rulers

illustration 19

S
same size 57
Save All 263
save template 261
saving HTML web page 264, 269
screen size 251
scroll bars 43

illustration 19
search 36
segments 95, 102
select all 28
select cursor 13
select mode 23
selected objects (zoom) 44
selecting 27

click 28
lasso 27
select all 28

selecting more 28
selecting text 145
selection

extending 28
seltext mode 24
set parent hyperlink 214
shading 83, 168
shadows 227
sheet bar 19
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sheets 46, 47
adding 47
deleting 48
naming 48

shift key 57, 90
short and long time formats 250
show grid 215
size of figure 55
size to text 58
sizing figures 57
sizing figures to text 58
slots 130

connector labels 132, 133
figure labels 136
flow labels 140

smoothed connectors 97
snap 215
snap figures into flows option 243
snap gravity 90
snap grid 23
snap labels to connector label slots option 131, 134
snap labels to figure label slots option 131, 138
snap labels to flow label slots option 131, 141
snipping connectors 102
soft carriage returns 151
space evenly 58
specialty labels 113, 128

attaching 131
connector labels 132
creating 129
default text 131
detaching 132
figure labels 136
flow labels 140
freeform 131
slots 130

split cursor 13
splitting connectors 102
stamp (connectors) 200
standard sizes 15
stetch method 246, 247, 248, 249
style bar 20

customize 228
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illustration 19
style bar buttons 21, 51, 158, 181
style combo box 20
style drop menu 20
style properties

common 154, 156
styles

connector 189
copying from a diagram 215
creating new 154, 178, 190
definition 17
deleting 155, 179, 190
descriptions 156, 180, 192
figure 153
labels 177

substitution macros (HTML) 267
symbols 172

T
tab 147, 150
tabs 86, 126, 171, 186
template 261

saving 261
template - HTML, custom HTML 265, 266
template overrides 259
template variants 257
text 143

adding to figures 144
adding to labels 144
copying 148
cutting 148
deleting 148
editing 145
keyboard usage 147
pasting 148
rotating 144
selecting 145

text balloons 240
text color 72, 120, 157, 181
text cursor 13, 117
text fields 150, 250
text mode 24
three dimensional figures 72, 157
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time and date 150
time and date format 250
tinting 41, 219
title bar 19
too many lines 79, 124, 164, 184
tool bar 21

illustration 19
toolbar

customize 228
tooltip 21
tooltips 88, 128, 240
top (figure property) 72, 120
top and bottom edges snap to grid 81, 125, 165, 185
transparent symbols 40

U
unattached connectors 95
undo 33, 34

navigation 243
Ungroup All 204
URL (hyperlinks) 212
use connection points option 90

V
valid characters 147, 150
variants 257
vertical text 144
visible grid 23

W
web page 264, 269
web page (hyperlinks) 212
width (figure property) 72, 120
Windows

clipboard 30, 32, 33, 34
metafiles 31

Windows metafiles 31, 216
wizard 257
WMF 216
workspace

illustration 19
menu bar 19
property bar 19
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rulers 19
scroll bars 19
style bar 19
title bar 19
tool bar 19

wrap 260

Z
zoom 44

all objects 44
directly to area 46, 47, 48, 49
entire page 44
incremental 46, 47, 48
intervals 45
page 46, 47, 48, 49
page width 44
rectangle 46, 47, 48, 49
selected objects 44

zoom cursor 13
zoom mode 24, 44, 45
zoom-in 44
zoom-out 44
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